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คำนำ 
 

 แผนการเรียนรู้วิชาการผลิตส่ือดิจิทัล รหัสวิชา 21910–2008 เล่มนี้ มีวัตถุประสงค์เพื่อเสริมสร้างความรู้
และทักษะในการผลิตสื่อดิจิทัลให้กับนักเรียน โดยเน้นการเรียนรู้ที่มุ่งพัฒนาความคิดสร้างสรรค์ การใช้เครื่องมือ
และเทคโนโลยีในการผลิตส่ือ รวมถึงการประยุกต์ใช้ในงานต่างๆ ท่ีเกี่ยวข้องกับการส่ือสารในยุคดิจิทัล นักเรียนจะ
ได้เรียนรู้เกี่ยวกับข้ันตอนการผลิตส่ือ ต้ังแต่การวางแผน การออกแบบ การถ่ายทำ การตัดต่อ ไปจนถึงการเผยแพร่
ส่ือดิจิทัลผ่านช่องทางต่างๆ 

ในแผนการเรียนรู้นี ้ จะมีการฝึกปฏิบัติจริง เพื่อให้นักเรียนสามารถนำทักษะที่ได้เร ียนรู้ไปใช้ในการ
สร้างสรรค์สื่อดิจิทัลอย่างมีประสิทธิภาพ และมีความเข้าใจในกระบวนการทำงานที่เกี่ยวข้องกับการผลิตสื่อใน
สภาพแวดล้อมที่เปลี่ยนแปลงอย่างรวดเร็ว รวมทั้งสามารถนำไปใช้ในงานวิชาชีพในอนาคตได้อย่างเหมาะสมจึง
เป็นการตั้งใจให้แผนการเรียนรู้วิชานี้เป็นเครื่องมือที่จะช่วยให้นักเรียนได้เรียนรู้และพัฒนาทักษะในการผลิตส่ือ
ดิจิทัลอย่างเต็มที่ พร้อมทั้งสามารถใช้ในการสื่อสารและเผยแพร่ข้อมูลในยุคสมัยที่เต็มไปด้วยเทคโนโลยีและการ
เปล่ียนแปลงทางดิจิทัลอย่างรวดเร็ว. 

 
    

(นางสาวปวรวรรณ ทองถึก) 
      สาขาวิชาเทคโนโลยีธุรกิจดิจิทัล                           
       วิทยาลัยเทคนิคบางสะพาน 
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หลักสูตรประกาศนียบัตรวิชาชีพ พุทธศักราช 2567 
ประเภทวิชาอุตสาหกรรมดิจิทัลและเทคโนโลยีสารสนเทศ  

กลุ่มอาชีพธุรกิจดิจิทัลและพาณิชอิเล็กทรอนิกส ์
สาขาวิชาเทคโนโลยีธุรกิจดิจิทัล  

รหัสวิชา 21910–2008 วิชาการผลิตสื่อดิจิทัล 
ทฤษฎี 2 ชั่วโมง/สัปดาห์  ปฏิบัติ 2 ชั่วโมง/สัปดาห์  รวม  72  ชั่วโมง  จำนวน 3 หน่วยกิต 

 
อ้างอิงมาตรฐาน  

-  
ผลลัพธ์การเรียนรู้ระดับรายวิชา  

ผลิตส่ือดิจิทัลให้เหมาะสมกับงานธุรกิจดิจิทัล ด้วยความละเอียด รอบคอบ 
 
จุดประสงค์รายวิชา  เพื่อให ้
 1. รู้และเข้าใจเกี่ยวกับหลักการผลิตส่ือดิจิทัล  

2. มีทักษะในการผลิตส่ือดิจิทัลด้วยโปรแกรมสำเร็จรูป  
3. มีความสามารถประยุกต์ใช้โปรแกรมสำเร็จรูปในผลิตส่ือดิจิทัลให้เหมาะสมกับงานธุรกิจดิจิทัล  
4. มีเจตคติและกิจนิสัยท่ีดีในการปฏิบัติงานด้วยความละเอียด รอบคอบ 

สมรรถนะรายวิชา 
1. แสดงความรู้เกี่ยวกับการผลิตส่ือดิจิทัลตามหลักการและกระบวนการ  
2. ผลิตส่ือดิจิทัลด้วยโปรแกรมสำเร็จรูปตามหลักการและกระบวนการ  
3. ประยุกต์ใช้โปรแกรมสำเร็จรูปในการผลิตส่ือดิจิทัลให้เหมาะสมกับงานธุรกิจดิจิทัล 

 
คำอธิบายรายวิชา 
            ศึกษาและปฏิบัติเกี่ยวกับหลักการผลิตส่ือดิจิทัล กระบวนการจัดทำส่ือดิจิทัล การออกแบบ การผลิต  
ส่ือดิจิทัลด้วยโปรแกรมสำเร็จรูป การใช้เครื่องมือในโปรแกรมสำเร็จรูป การตัดต่อรูปภาพ การใส่เทคนิคพิเศษ  
ในส่ือดิจิทัล การบันทึกส่ือดิจิทัลและประยุกต์ใช้โปรแกรมสำเร็จรูปในการผลิตส่ือดิจิทัลให้เหมาะสมกับงาน  
ธุรกิจดิจิทัล 
 
 
 
 
 
 
 
 
 
 



 

 
 

ตารางวิเคราะห์พฤติกรรมการเรียนรู้ 
รหัส  21910-2008       วิชา  การผลิตสื่อดิจิทัล 

ทฤษฎี  2  ชั่วโมง/สัปดาห์    ปฏิบัติ   2   ชั่วโมง/สัปดาห์    จำนวน  3  หน่วยกิต 

หน่วยการเรียนรู้ 

ความสามารถที่คาดหวัง 

รวม 
จำนวน
ชั่วโมง 
ท/ป 

พุทธิพิสัย 
ทักษะ 
พิสัย 

จิต 
พิสัย 

ประยุกต์ 
ใช ้

  ค
วา

มรู้
 

  ค
วา

มข้
าใ

จ 

  ก
าร

นำ
ไป

ใช
 ้

  ก
าร

วิเ
คร

าะ
ห ์

  ก
าร

ปร
ะเ

มิน
ค่า

 

  ก
าร

สร
้าง

สร
รค

 ์

ความรู้เกี่ยวกับส่ือส่ิงพิมพ์ 2 1 1 - - - 5 3 2 14 2/2 
การออกแบบและกระบวนการผลิต
ส่ือส่ิงพิมพ์ 1 1 2 - - - 19 4 2 29 

2/6 

เริ่มต้นใช้งานโปรแกรมผลิตส่ือ
ส่ิงพิมพ์ 1 1 1 - - - 8 4 2 17 

2/6 

การสร้างข้อความเพื่อผลิตส่ือ
ส่ิงพิมพ์ 1 1 1 - - - 3 4 2 12 2/6 

ภาพประกอบส่ือส่ิงพิมพ์ 1 1 1 - - - 6 4 3 16 2/6 

สีในส่ือส่ิงพิมพ์ 1 1 1 - - - 9 4 3 19 2/6 

การทำงานกับวัตถุ 1 1 1 - - - 3 4 2 12 2/6 

การใช้งานเลเยอร์ 1 1 1 - - - 3 4 2 12 4/12 

หน้ามาสเตอร์ 1 1     6 1  9 2/2 
            
            
            
            
            

รวม 10 9 9    62 32 18  72 

   ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา (เมื่อเรียนรายวิชาน้ีสำเร็จแล้วทำอะไรได้) (ร้อยละ)    

ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา (เม่ือเรียนรายวิชาน้ีสำเร็จแล้วทำอะไรได้)   
รวมทั้งรายวิชา 100 72 

 
 
 
 
 



 

 
 

หน่วยการเรยีนรู้ 
รหัส           221910-2008            ชื่อวิชา  การผลิตสื่อดิจิทัล . 

ทฤษฎี      2        ชั่วโมง/สัปดาห์  ปฏิบัติ       2       ชั่วโมง/สัปดาห์  จำนวน      3       หน่วยกิต 
 

หน่วย 
ท่ี 

หน่วยการเรียนรู้ 
เวลาเรียน (ชม.) 

ทฤษฎี ปฏิบัติ รวม 

1 ความรู้เกี่ยวกับส่ือส่ิงพิมพ์ 2 2 4 

2 การออกแบบและกระบวนการผลิตส่ือส่ิงพิมพ์ 2 6 8 

3 เริ่มต้นใช้งานโปรแกรมผลิตส่ือส่ิงพิมพ์ 2 6 8 

4 การสร้างข้อความเพื่อผลิตส่ือส่ิงพิมพ์ 2 6 8 

5 ภาพประกอบส่ือส่ิงพิมพ์ 2 6 8 

6 สีในส่ือส่ิงพิมพ์ 2 6 8 

7 การทำงานกับวัตถุ 2 6 8 

8 การใช้งานเลเยอร์ 4 12 16 

9 หน้ามาสเตอร์ 2 2 4 

     

     

     
 
 

ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา 1 2 3 

รวม 20 52 72 

 
1. การวัดผลรายวิชา 
  ด้านความรู้ 1. แบบฝึกหัด/กิจกรรมนำเสนอ      10 % 
   2. แบบทดสอบหลังเรียน   10 % 

 ด้านทักษะ 1. แบบฝึกหัด (การคิดและแก้ปัญหา) 10 % 
 ด้านคุณลักษณะท่ีพึงประสงค์  20 % 
 ด้านการประยุกต์ใช้และรับผิดชอบ (แบบฝึกประยุกต์ในงานอาชีพ) 10 % 
 
 
 
 
 
 
 
 



 

 
 

 คะแนนระหว่างภาค/ปลายภาค (ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา) 
สัดส่วน 60 : 40 

  ระหว่างภาค 1. แบบฝึกหัด/กิจกรรมนำเสนอ  
    (ด้านความรู้ ทักษะ และประยุกต์ใช้ฯ) 20 % 

   2. แบบทดสอบหลังเรียน 
    (ด้านความรู้ ทักษะ และประยุกต์ใช้ฯ) 20 % 
   3. คุณลักษณะท่ีพึงประสงค์  20 % 
     รวม 60 % 
  ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา 40 %  
     รวมทั้งหมด   100 % 

 2. การประเมินผลรายวิชา 
 80 – 100 คะแนน ได้ผลการเรียน  4.0 หมายถึง ผลการเรียนอยู่ในเกณฑ์ดีเยี่ยม 
 75 – 79  คะแนน ได้ผลการเรียน  3.5 หมายถึง ผลการเรียนอยู่ในเกณฑ์ดีมาก 
 70 – 74  คะแนน ได้ผลการเรียน  3.0 หมายถึง ผลการเรียนอยู่ในเกณฑ์ดี 
 65 – 69  คะแนน ได้ผลการเรียน  2.5 หมายถึง ผลการเรียนอยู่ในเกณฑ์ดีพอใช้ 
 60 – 64  คะแนน ได้ผลการเรียน  2.0 หมายถึง ผลการเรียนอยู่ในเกณฑ์พอใช้ 
 55 – 59  คะแนน ได้ผลการเรียน  1.5 หมายถึง ผลการเรียนอยู่ในเกณฑ์อ่อน 

 50 – 54  คะแนน ได้ผลการเรียน  1.0 หมายถึง ผลการเรียนอยู่ในเกณฑ์อ่อนมาก 
  50 คะแนน ได้ผลการเรียน  0 หมายถึง ผลการเรียนต่ำกว่าเกณฑ์ขั้นต่ำ 
 
 
 



 

 
 

 

 
 
 

แผนการจัดการเรียนรู้ หน่วยที่   1 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 1 
 

ชื่อหน่วย   ความรู้เบื้องต้นเก่ียวกับสื่อสิ่งพิมพ์ 
  ทฤษฎี  2  ชม.  

ปฏิบัติ  2 ชม. 
ชื่อเร่ือง   ความรู้เบื้องต้นเก่ียวกับสื่อสิ่งพิมพ์  

 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
“สื่อสิ่งพิมพ์”  เป็นคำที่ใช้กันมานาน และรู้จักกันดีในกลุ่มคนทุกระดับชั้น เป็นสื่อชนิดหนึ่งที่ได้รับความ

นิยมยกย่องแพร่หลาย ต้ังแต่สมัยอดีตจนถึงปัจจุบัน ถึงแม้ว่าปัจจุบันจะมีส่ือในรูปแบบอื่น ๆ เข้ามามากมายหลาย
รูปแบบ แต่ส่ือส่ิงพิมพ์ยังคงได้รับความนิยมและปรับเปล่ียนรูปแบบให้เหมาะสมกับยุคสมัย 
 สื่อสิ่งพิมพ์ เป็นอีกทางเลือกหนึ่งสำหรับผู้ที่รักการอ่าน เพราะนอกจากราคาไม่แพง มีความหลากหลาย
ดึงดูดใจนักอ่าน ไม่ว่าจะเป็นการอ่านเพื่อรับรู้ข่าวสาร ความรู้ ความบันเทิง อาทิเช่น หนังสือพิมพ์ หนังสือเรียน 
ตำรา เป็นต้น 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 

- 
3. สมรรถนะประจำหน่วย  

1.  แสดงความรู้เกี่ยวกับความหมายของส่ือส่ิงพิมพ์ตามพจนานุกรมฉบับราชบัณฑิตยสถาน 
 2.  จำแนกประเภทของส่ือส่ิงพิมพ์ตามลักษณะการใช้งาน 
 3.  ออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสารส่ิงพิมพ์ 
 4.  วางแผนการผลิตส่ือส่ิงพิมพ์ตามข้ันตอนในการผลิตส่ือส่ิงพิมพ์ 

5.  จำแนกข้อดีและข้อจำกัดของส่ือส่ิงพิมพ์ 
6.  เตรียมวัสดุอุปกรณ์เหมาะสมกับการปฏิบัติงาน 
7.  ออกแบบส่ือส่ิงพิมพ์ตามข้ันตอนท่ีกำหนด 

 8.  แสดงพฤติกรรมความสนใจใฝ่รู้ ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็นประชาธิปไตยและ
ห่างไกลยาเสพติด 

4. จุดประสงค์เชิงพฤติกรรม 
3.1 ด้านความรู้ 

3.1.1 เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับความหมายของส่ือส่ิงพิมพ์ตามพจนานุกรม 
ฉบับราชบัณฑิตยสถาน 

3.1.2 เพื่อให้เข้าใจประเภทของส่ือส่ิงพิมพ์ตามลักษณะการใช้งาน 
3.1.3 เพื่อให้เข้าใจหลักการออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสาร 



 

 
 

ส่ิงพิมพ์เพื่อให้เข้าใจข้อดีและข้อจำกัดของส่ือส่ิงพิมพ์ 
3.1.4 เพื่อให้เข้าใจข้อดีและข้อจำกัดของส่ือส่ิงพิมพ์ 
3.1.5 เพื่อให้มีทักษะในการวางแผนการผลิตส่ือส่ิงพิมพ์ตามข้ันตอนในการผลิตส่ือส่ิงพิมพ์ 
3.1.6 เพื่อให้มีทักษะในการออกแบบส่ือส่ิงพิมพ์ตามข้ันตอนท่ีกำหนด 

 

3.2 ด้านทักษะ 
3.2.1 อธิบายความหมายของส่ือส่ิงพิมพ์ตามพจนานุกรมฉบับราชบัณฑิตยสถานได้ 
3.2.2 จำแนกประเภทของส่ือส่ิงพิมพ์ตามลักษณะการใช้งานได้ 
3.2.3 ออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสารส่ิงพิมพ์ได้ 
3.2.4 จำแนกข้อดีและข้อจำกัดของส่ือส่ิงพิมพ์ได้ 
3.2.5 วางแผนการผลิตส่ือส่ิงพิมพ์ตามข้ันตอนในการผลิตส่ือส่ิงพิมพ์ได้ 
3.2.6 ออกแบบส่ือส่ิงพิมพ์ตามข้ันตอนท่ีกำหนดได้ 

 

3.3 คุณลักษณะที่พึงประสงค์ 
3.3.1 ความสนใจใฝ่รู้  
3.3.2 มีความซื่อสัตย์ในการปฏิบัติงาน 
3.3.3 มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
3.3.4 ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

5. สาระการเรียนรู้ 
5.1  ความรู้เบ้ืองต้นเกี่ยวกับส่ือส่ิงพิมพ์ 

6. กิจกรรมการเรียนรู้ 
6.1 การนำเข้าสู่บทเรียน 

1.ผู้สอนกล่าวทักทายผู้เรียน เนื่องจากเป็นการสอนครั้งแรก   
2.ผู้สอนตรวจสอบรายช่ือผู้เรียน 
3.ผู้สอนบอกจุดประสงค์รายวิชา มาตรฐานรายวิชา และคำอธิบายรายวิชา 
4.ผู้สอนแจกแบบทดสอบก่อนเรียนเพื่อทดสอบผู้เรียน 

7. สื่อและแหล่งเรียนรู้ 
7.1 หนังสือการผลิตส่ือสิงพิมพ์. ประภาวรรณ เกษวิริยะการณ์. สำนักพิมพ์เมืองไทย 
7.2 ส่ือประกอบการเรียน เช่น VDO,  PowerPoint,  YouTube และอุปกรณ์จริง 

8. หลักฐานการเรียนรู้ 
8.1 หลักฐานความรู้           

   คะแนนจากการตอบคำถามท้ายบทเรียน และแบบทดสอบ ในหนังสือประกอบการเรียน  
8.2 หลักฐานการปฏิบัติงาน 

   คะแนนการทำกิจกรรมการเรียนรู้  และภาพถ่ายการทำกิจกรรมของผู้เรียน  



 

 
 

     9. การวัดและการประเมินผล 

9.1 วิธีวัดและการประเมินผล 
1) ทดสอบก่อนเรียนและหลังเรียน 
2) ตรวจใบงาน 
3) ประเมินการนำเสนอผลงาน 
4) สังเกตพฤติกรรม 

9.2 เคร่ืองมือวัดและการประเมินผล 
1) แบบทดสอบก่อนเรียนและหลังเรียน 
2) ใบงาน 
3) แบบประเมินการนำเสนอผลงาน 
4) แบบสังเกตพฤติกรรม 

9.3 เกณฑ์วัดและการประเมินผล 
1) เกณฑ์การทดสอบก่อนเรียนและหลังเรียน คะแนนผ่านไม่ต่ำกว่า 80% 
2) เกณฑ์การประเมินใบงาน คะแนนผ่านไม่ต่ำกว่า 80% 
3) เกณฑ์การประเมินผลการนำเสนอผลงาน คะแนนผ่านไม่ต่ำกว่า 80% 
4) เกณฑ์การสังเกตพฤติกรรม คะแนนผ่านไม่ต่ำกว่า 80% 

 
10.  บันทึกผลหลังการจัดการเรียนรู้ 

 
10.1 ผลการจัดการเรียนรู้ท่ีเกิดขึ้นกับผู้เรียน 

               
               
               

10.2 ปัญหา อุปสรรคท่ีพบ 
               
               
               

10.3 การแก้ไขปัญหา 
1) ผลการแก้ไขปัญหาทีส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
 

 
 

 
 



 

 
 

 

ใบความรู้ที่ 1 หน่วยที่   1 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 1 
 

ชื่อหน่วย   ความรู้เบื้องต้นเก่ียวกับสื่อสิ่งพิมพ์ 
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

ชื่อหน่วย ความรู้เบื้องต้นเก่ียวกับสื่อสิ่งพิมพ์  
 
1.  ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

1 ความรู้เบื้องตน้เก่ียวกบัส่ือส่ิงพิมพ ์
2. อ้างอิงมาตรฐาน / เชื่อมโยงกลุ่มอาชีพ (ถ้ามี) 

 -  
9. สมรรถนะประจำหน่วย  

1.  แสดงความรู้เกี่ยวกับความหมายของส่ือส่ิงพิมพ์ตามพจนานุกรมฉบับราชบัณฑิตยสถาน 
 2.  จำแนกประเภทของส่ือส่ิงพิมพ์ตามลักษณะการใช้งาน 
 3.  ออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสารส่ิงพิมพ์ 
 4.  วางแผนการผลิตส่ือส่ิงพิมพ์ตามข้ันตอนในการผลิตส่ือส่ิงพิมพ์ 

5.  จำแนกข้อดีและข้อจำกัดของส่ือส่ิงพิมพ์ 
6.  เตรียมวัสดุอุปกรณ์เหมาะสมกับการปฏิบัติงาน 
7.  ออกแบบส่ือส่ิงพิมพ์ตามข้ันตอนท่ีกำหนด 

 8.  แสดงพฤติกรรมความสนใจใฝ่รู้ ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็นประชาธิปไตยและ
ห่างไกลยาเสพติด 

10. จุดประสงค์เชิงพฤติกรรม 
3.4 ด้านความรู้ 

3.4.1 เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับความหมายของส่ือส่ิงพิมพ์ตามพจนานุกรม 
ฉบับราชบัณฑิตยสถาน 

3.4.2 เพื่อให้เข้าใจประเภทของส่ือส่ิงพิมพ์ตามลักษณะการใช้งาน 
3.4.3 เพื่อให้เข้าใจหลักการออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสาร 

ส่ิงพิมพ์เพื่อให้เข้าใจข้อดีและข้อจำกัดของส่ือส่ิงพิมพ์ 
3.4.4 เพื่อให้เข้าใจข้อดีและข้อจำกัดของส่ือส่ิงพิมพ์ 
3.4.5 เพื่อให้มีทักษะในการวางแผนการผลิตส่ือส่ิงพิมพ์ตามข้ันตอนในการผลิตส่ือส่ิงพิมพ์ 
3.4.6 เพื่อให้มีทักษะในการออกแบบส่ือส่ิงพิมพ์ตามข้ันตอนท่ีกำหนด 

 

3.5 ด้านทักษะ 
3.5.1 อธิบายความหมายของส่ือส่ิงพิมพ์ตามพจนานุกรมฉบับราชบัณฑิตยสถานได้ 



 

 
 

3.5.2 จำแนกประเภทของส่ือส่ิงพิมพ์ตามลักษณะการใช้งานได้ 
3.5.3 ออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสารส่ิงพิมพ์ได้ 
3.5.4 จำแนกข้อดีและข้อจำกัดของส่ือส่ิงพิมพ์ได้ 
3.5.5 วางแผนการผลิตส่ือส่ิงพิมพ์ตามข้ันตอนในการผลิตส่ือส่ิงพิมพ์ได้ 
3.5.6 ออกแบบส่ือส่ิงพิมพ์ตามข้ันตอนท่ีกำหนดได้ 

 

3.6 คุณลักษณะที่พึงประสงค์ 
3.6.1 ความสนใจใฝ่รู้  
3.6.2 มีความซื่อสัตย์ในการปฏิบัติงาน 
3.6.3 มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
3.6.4 ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

5. เนือ้หาสาระ 
1.  ความหมายของสื่อสิ่งพิมพ์ 
         ส่ือ  หมายถึง ก. (กริยา) ทำการติดต่อให้ถึงกัน เช่น ส่ือความหมาย  ชักนำให้รู้จักกัน เป็นต้น  
     ส่ือ  หมายถึง  น. (นาม) ผู้หรือส่ิงท่ีทำการติดต่อให้ถึงกัน  หรือชักนำให้รู้จักกัน  เช่น เขาใช้จดหมาย
เป็นส่ือติดต่อกัน กุหลาบแดงเป็นส่ือของความรัก เป็นต้น เรียกผู้ท่ีทำหน้าท่ีชักนำเพื่อให้ชายหญิงได้แต่งงานกันว่า 
พ่อสื่อ หรือ แม่สื่อ; (ศิลปะ) วัสดุต่าง ๆ ที่นำมาสร้างสรรค์งานศิลปกรรม ให้มีความหมายตามแนวคิด ซึ่งศิลปิน
ประสงค์แสดงออกเช่นนั้น เช่น ส่ือผสม เป็นต้น 
พิมพ์ หมายถึง ก. (กริยา) ถ่ายแบบ  ใช้เครื่องจักรกดตัวหนังสือหรือภาพให้ติดบนวัตถุ เช่น แผ่นกระดาษ ผ้า  เป็น
ต้น ทำให้เป็นตัวหนังสือหรือรูปรอยอย่างใด ๆ โดยการกดหรือการใช้พิมพ์หิน เครื่องกล วิธีเคมี หรือวิธีอื่นใด อัน
อาจให้เกิดเป็นส่ิงพิมพ์ขึ้นหลายสำเนา   
 พิมพ์ หมายถึง น. (นาม) รูป  รูปร่าง  แบบ เช่น หยอดวุ้นลงในพิมพ์ หน้าตาเป็นพิมพ์เดียวกัน การ
พิมพ์ผ้า พิมพ์ขนมเป็นรูปต่าง ๆ เป็นต้น 

 ส่ิงพิมพ์  หมายถึง  สมุด แผ่นกระดาษ หรือวัตถุใด ๆ ท่ีพิมพ์ขึ้น รวมตลอดท้ังบทเพลง แผนท่ี แผนผัง 
แผนภาพ ภาพวาด ภาพระบายสี  ใบประกาศ แผ่นเสียง หรือส่ิงอื่นใดอันมีลักษณะเช่นเดียวกัน 

 ส่ือส่ิงพิมพ์ หมายถึง ส่ิงพิมพ์ท่ีเกิดจากกรรมวิธีการพิมพ์ต่าง ๆ ลงบนวัตถุหลากหลายชนิดไม่ว่าจะเป็น
กระดาษ ผ้า แก้ว แผ่นพลาสติกหรือวัตถุใด ๆ เพื่อนำไปใช้ในการติดต่อส่ือสารกัน   ท้ังทางตรงและทางอ้อม 
 

2.  ความเป็นมาของสื่อสิ่งพิมพ์ 
 2.1  ประวัติการพิมพ์ของโลก   

   จากหลักฐานทางประวัติศาสตร์ ศิลปะของมนุษย์สมัยก่อนประวัติศาสตร์ ในช่วง ประมาณ 12,000 - 
17,000 ปีที่ผ่านมา ได้ปรากฏหลักฐานอยู่บนผนังถ้ำลาสควักซ์ (Lascaux) ในประเทศฝรั่งเศสและถ้ำอัลตามิรา 
(Altamira) ในประเทศสเปน ปรากฏผลงานด้านจิตรกรรมที่มีคุณค่าด้านความงามของมนุษยชาติผลงานแกะสลัก



 

 
 

หิน แกะสลักผนังถ้ำเป็นรูปสัตว์ลายเส้นการแกะสลักภาพลายเส้นบนผนังถ้ำนั้น อาจนับได้ว่าเป็นพยานหลักฐานใน
การแกะแบบพิมพ์ของมนุษย์เป็นครั้งแรกก็ได้ 
 2.2  การพิมพ์ของประเทศทางตะวันออก   

 ในภูมิภาคแถบเอเชียตอนกลางและชาวจีน รู้จักการแกะสลักดวงตราบนแผ่นหิน กระดูกสัตว์
และงาช้าง เพื่อใช้ประทับลงบนดินเหนียวหรือบนขี้ผ้ึง  ซึ่งอาจกล่าวได้ว่าเป็นต้นกำเนิดของแม่พิมพ์แบบแลตเตอร์
เพรส (Letter Press) จะเห็นได้จากพงศาวดารจีนโบราณองค์จักรพรรดิ จะมีตราหยกเป็นตราประจำแผ่นดิน 

 2.3  การพิมพ์ของประเทศทางตะวันตก   
ผู้ท่ีคิดค้นวิธีการพิมพ์อย่างเป็นระบบเป็นคนแรกจนได้รับการยกย่องว่าเป็นบิดาของการพิมพ์คือ 

โจฮัน กูเต็นเบิร์ก (Johann Gutenberg) เขาได้ประดิษฐ์แท่นพิมพ์ท่ีพัฒนาแม่แบบสำหรับหล่อตัวพิมพ์ 
โลหะเป็นตัว ๆ สามารถท่ีจะเรียงเป็นคำ เป็นประโยคและเมื่อใช้พิมพ์ไปแล้วก็สามารถนำกลับมาเรียงใหม่ เพื่อใช้
หมุนเวียนได้อีกซึ่งเรียกว่าเป็นวิธีมูวาเบิล (Movable) ตลอดจนการคิดวิธีการทำหมึกท่ีได้ผลดีสำหรับใช้กับตัวเรียง
โลหะ ผลงานท่ีมีช่ือเสียงของโจฮัน กูเต็นเบิร์ก คือคัมภีร์ 42 บรรทัด (42-Lines Bible) เมื่อปี พ.ศ. 1998 

 2.4  การพิมพ์ในประเทศไทย   
  การพิมพ์ของประเทศไทยตามหลักฐานที่พบน่าจะเกิดขึ้นปลายสมัยกรุงศรีอยุธยา ในช่วง  รัช

สมัยสมเด็จพระนารายณ์มหาราช  ประเทศไทยได้รับอิทธิพลของการพิมพ์จากชาวยุโรป  โดยเฉพาะอย่างยิ่งคณะ
มิชชันนารีที่เข้ามาเผยแพร่คริสต์ศาสนาในประเทศไทย บุคคลที่มีบทบาทสำคัญในประวัติการพิมพ์ของประเทศ
ไทย คือ หมอแดน บีช บรัดเลย์  (Dr.Dan Beach Bradley M.D.) ซึ่งคนไทยเรียกว่า หมอบรัดเลย์  
   คนไทยคนแรกที่ริเริ่มกิจการการพิมพ์ คือพระบาทสมเด็จพระจอมเกล้าเจ้าอยู่หัว ในขณะที่ยังดำรง
พระยศเป็นสมเด็จฯ เจ้าฟ้ามงกุฎ และยังทรงผนวชอยู่ท่ีวัดบวรนิเวศวิหาร ทรงเห็นประโยชน์ของหนังสือ เมื่อคณะ
มิชชันนารีพิมพ์หนังสือเผยแผ่ศาสนาคริสต์ พระองค์ทรงดำริให้ใช้การพิมพ์เพื่อเผยแผ่ศาสนาพุทธ จึงโปรดฯให้ส่ัง
เครื ่องพิมพ์มาตั้งที ่วัดบวรนิเวศวิหาร ต่อมาเมื่อทรงขึ้นครองราชย์สมบัติเป็นพระบาทสมเด็จพระจอมเกล้า
เจ้าอยู่หัว ได้โปรดเกล้าฯให้สร้างโรงพิมพ์ขึ้นอีกแห่งหนึ่งในบริเวณพระราชวังช้ันกลาง พระราชทานช่ือว่า โรงพิมพ์
อักษรพิมพการ ซึ่งเป็นโรงพิมพ์หลวง ทำหน้าท่ีเป็นโรงพิมพ์แห่งชาติ ได้จัดพิมพ์หนังสือราชกิจจานุเบกษาอันเป็น
หนังสือพิมพ์ของราชการฉบับแรก สำหรับบอกข่าวคราวในราชสำนัก และเก็บความจากประกาศของราชการตา่ง 
ๆ พิมพ์ออกเผยแพร่  และทรงไปศึกษาดูงานเรื่องการพิมพ์ในต่างประเทศ เพื่อจะได้นำความรู้ทางการพิมพ์เข้ามา
ปรับปรุงกิจการพิมพ์ของโรงพิมพ์หลวงให้ดีขึ้น 
 

3.  ประเภทของสื่อสิ่งพิมพ์ 
 การแบ่งประเภทของส่ือส่ิงพิมพ์ตามลักษณะการใช้งานแบ่งได้เป็น 6  ประเภท  
 3.1  สื่อสิ่งพิมพ์ประเภทหนังสือ 
       3.1.1 หนังสือสารคดี ตำรา แบบเรียน (Textbook)  เป็นส่ือส่ิงพิมพ์ท่ีแสดง เนื้อหาวิชาการในศาสตร์
ความรู้ต่าง ๆ ประกอบด้วยเนื้อหาการเรียนการสอน หนังสือตำรานี้อาจใช้เป็นสื่อการเรียนการสอนในวิชานั้น
โดยตรง 



 

 
 

  3.1.2 หนังสือบันเทิงคดี (Fiction Book) เป็นส่ือส่ิงพิมพ์ท่ีผลิตขึ้นโดยใช้เรื่องราวสมมติจาก
จินตนาการของผู้เขียน เพื่อให้ผู้อ่านได้รับความเพลิดเพลิน สนุกสนาน อาจจะสอดแทรกความรู้และความคิดต่าง ๆ 

มักมีขนาดเล็ก เช่น นวนิยาย เรื่องสั้น หนังสือฉบับกระเป๋า (Pocket Book)  หนังสือสำหรับเด็กและเยาวชน เป็น
ต้น 

3.2 สื่อสิ่งพิมพ์เพื่อเผยแพร่ข่าวสาร 
3.2.1 หนังสือพิมพ์ (Newspaper) เป็นส่ือส่ิงพิมพ์ท่ีผลิตขึ้นโดยนำเสนอเรื่องราว 

ข่าวสาร ภาพ และความคิดเห็น ในลักษณะของสื่อสิ่งพิมพ์แผ่นใหญ่ที่ใช้วิธีการพับรวมกัน สื่อสิ่งพิมพ์ชนิดนี้  ได้
พิมพ์ออกเผยแพร่ท้ังลักษณะหนังสือพิมพ์รายวัน รายสัปดาห์ และรายเดือน 
                   3.2.2 วารสาร/นิตยสาร (Journal/Periodical) เป็นสื่อสิ ่งพิมพ์ที่ผลิตขึ้นโดยนำเสนอสาระ 
ความบันเทิง ท่ีมีรูปแบบการนำเสนอท่ีโดดเด่น สะดุดตา และสร้างความสนใจให้กับผู้อ่าน มีการกำหนดระยะเวลา
การออกเผยแพร่ท่ีแน่นอน ท้ังรายปักษ์ (15 วัน) และรายเดือน 
   3.2.3  จุลสาร  (Pamphlet) เป็นสื่อสิ่งพิมพ์ขนาดเล็กที่มีเนื้อหากล่าวถึงเรื่องใดเรื่องหนึ่ง เพียง
เรื่องเดียวและจบบริบูรณ์ภายในเล่ม ความยาวไม่มากนัก เขียนอย่างง่าย ๆส่วนมากแล้วเนื้อหาจะเป็นเรื่องท่ี
น่าสนใจในช่วงระยะเวลาหนึ่ง 
 3.2.4  สิ่งพิมพ์โฆษณา สิ่งพิมพ์โฆษณาเป็นสื ่อสิ ่งพิมพ์ที ่ผลิตขึ้นเพื่อ เผยแพร่โฆษณาหรือ
ประชาสัมพันธ์สินค้าและบริการต่าง ๆ  ส่ิงพิมพ์โฆษณามีหลายประเภท แต่ละประเภทมีบทบาทและการใช้งานใน
ด้านการโฆษณาประชาสัมพันธ์ที่ต่างกัน 
 

 3.3  สิ่งพิมพ์เพื่อการบรรจุภัณฑ์ เป็นส่ือส่ิงพิมพ์ท่ีใช้ในการห่อหุ้มผลิตภัณฑ์ทางการค้า  แบ่งได้เป็น
สื่อสิ่งพิมพ์หลัก ได้แก่ สิ่งพิมพ์ที่ใช้ปิดรอบขวด หรือ กระป๋องผลิตภัณฑ์การค้า สิ่งพิมพ์รอง ได้แก่ สิ่งพิมพ์ที่เป็น
กล่องบรรจุ หรือลัง 
   3.4  สิ่งพิมพ์มีค่า  เป็นสื่อสิ่งพิมพ์ที่เน้นการนำไปใช้เป็นหลักฐานสำคัญต่าง ๆ ซึ่งเป็นกำหนดตาม 
กฎหมาย เช่น ธนาณัติ  บัตรเครดิต  เช็คธนาคาร  ต๋ัวแลกเงิน  หนังสือเดินทาง โฉนด เป็นต้น 
              3.5  สิ่งพิมพ์ลักษณะพิเศษ  เป็นสื่อสิ ่งพิมพ์ที ่ผลิตขึ้นตามลักษณะพิเศษแล้วแต่การใช้งาน  เช่น 
นามบัตร ปฏิทิน บัตรเชิญ บัตรอวยพร ใบส่งของ ใบเสร็จรับเงิน ส่ิงพิมพ์บนแก้ว ส่ิงพิมพ์บนผ้า เป็นต้น 

3.6 สิ่งพิมพ์อิเล็กทรอนิกส์ เป็นส่ือส่ิงพิมพ์ท่ีผลิตขึ้นเพื่อใช้งานในคอมพิวเตอร์หรือบนระบบ 
เครือข่าย อินเตอร์เน็ต เช่น หนังสืออิเล็กทรอนิกส์  เอกสารอิเล็กทรอนิกส์ เป็นต้น 
 

4. ข้อดีและข้อจำกัดของสื่อสิ่งพิมพ์ 
 4.1  ข้อดีของสื่อสิ่งพิมพ์ 

 4.1.1 กระบวนการในการผลิตสื่อสิ ่งพิมพ์สามารถจะทำได้หลายแบบ เปิดโอกาสให้เลือกรูปแบบท่ี
เหมาะสมกับสถานการณ์นั้น ๆ เช่น การพิมพ์เป็นเอกสารโรเนียว เป็นต้น หากต้องการให้มีคุณภาพดียิ่งขึ้นก็ใช้
การพิมพ์ด้วยเครื่องพิมพ์ ซึ่งสามารถเลือกพิมพ์เป็นขาวดำหรือสีได้  



 

 
 

4.1.2  สามารถจัดพิมพ์ได้หลายรูปแบบตามวัตถุประสงค์ท่ีจะนำไปใช้ เช่น ใบปิด จดหมายเวียน 
หรือเอกสารเผยแพร่ เป็นต้น 

4.1.3. สามารถเลือกจัดพิมพ์ให้มีระยะเวลาการใช้งานต่าง ๆ กัน เช่น พิมพ์เพื่อใช้งานระยะส้ัน 
อ่านแล้วทิ้งไป หรือพิมพ์เพื่อเก็บไว้ใช้อย่างถาวร เป็นต้น สามารถออกแบบให้ใช้เฉพาะบุคคล ใช้เป็นกลุ่มหรือเป็น
มวลชนได้ 

4.1.5  ส่ิงพิมพ์สามารถผลิตเพื่อใช้ให้เหมาะกับกลุ่มเป้าหมายเฉพาะด้านได้ 
 4.1.6  ส่ิงพิมพ์เข้าถึงกลุ่มเป้าหมายได้อย่างกว้างขวาง ในทุกระดับของสังคม 
 4.1.7  การใช้สื่อสิ่งพิมพ์เป็นไปอย่างอิสระ ในการศึกษาสิ่งพิมพ์ไม่จำเป็นต้องใช้วิธีพิเศษหรือ

เครื่องอำนวยความสะดวกอย่างอื่นเข้ามาช่วยแต่อย่างใด 
4.1.8  ผู้อ่านสามารถใช้ส่ือส่ิงพิมพ์ในการเรียนรู้และอ่านซ้ำ ๆ กันได้หลาย ๆ ครั้ง 
4.1.9  ส่ือส่ิงพิมพ์มีราคาถูก หาซื้อได้ง่าย 
4.1.10  ส่ือส่ิงพิมพ์มีอายุยาวนาน มีความคงทนถาวรสามารถเก็บรักษาไว้ได้นาน 
 

4.2  ข้อจำกัดของสื่อสิ่งพิมพ์ 
4.2.1  ไม่สามารถเข้าถึงผู้อ่านที่อ่านหนังสือไม่ออก และผู้ที่มีปัญหาทางด้านสายตา เช่น คนตา

บอด หรือผู้สูงอายุท่ีสายตาไม่ดี เป็นต้น 
4.2.2  วัสดุท่ีใช้ผลิตมีความบอบบางและฉีกขาดได้ง่าย 
4.2.3  เก็บรักษายากเนื่องจากมีลักษณะ รูปทรง และขนาดแตกต่างกันมาก 

   4.2.4  การพิมพ์ในระบบท่ีมีคุณภาพต้องใช้การลงทุนสูงมาก โดยเฉพาะการพิมพ์ในระบบส่ีสี 

  4.2.5  ปัญหาในการเผยแพร่แจกจ่าย เนื่องจากต้องมีการขนส่งถ้าหากการขนส่งไม่สามารถส่ง
ถึงกลุ่มเป้าหมายได้ การรับรู้ข่าวสารต่าง ๆ ก็จะขาดตอนลง 
6. แบบทดสอบ/แบบฝึกหัด 
จากโจทย์คำถาม จงเลือกคำตอบที่ถูกต้องที่สุด 

แบบฝึกหัดหน่วยที่ 1 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. ส่ือส่ิงพิมพ์มีความหมายตรงกับข้อใดมากท่ีสุด 
 ก. การสร้างและบันทึกข้อมูลภาพและเสียงให้อยู่ในรูปแบบของระบบคอมพิวเตอร์ 
 ข. การสร้างช้ินงานจากการพิมพ์ด้วยวิธีต่าง ๆ ลงบนวัตถุท่ีหลากหลาย เพื่อใช้ติดต่อกัน 
 ค. การสร้างช้ินงานจากการพิมพ์ด้วยเครื่องคอมพิวเตอร์ในรูปแบบของภาพ เพื่อใช้เผยแพร่ถึงกัน 
 ง. การสร้างภาพหรือส่ิงท่ีเกี่ยวข้องกับการแสดงภาพด้วยเครื่องคอมพิวเตอร์ท้ังทางตรงและทางอ้อม 
2. ผู้ท่ีได้รับยกย่องให้เป็นบิดาแห่งการพิมพ์คือใคร 
 ก. โจฮัน กูเต็นเบิร์ก (Johann Gutenberg) 
 ข. แซมมวล ไดเออร์ (Samuel Dyer) 
 ค. โรเบิร์ต ดี. ดาเวนพอร์ต (Robert D. Davenport) 
 ง. หมอแดน บีช บรัดเลย์ (Dr. Dan Beach Bradley M.D.) 
3. คนไทยคนแรกที่ได้ริเริ่มกิจการการพิมพ์คือใคร 



 

 
 

 ก.  พระบาทสมเด็จพระนั่งเกล้าเจ้าอยู่หัว 
 ข.  พระบาทสมเด็จพระมงกุฎเกล้าเจ้าอยู่หัว 
 ค.  พระบาทสมเด็จพระจอมเกล้าเจ้าอยู่หัว 
 ง.  พระบาทสมเด็จพระจุลจอมเกล้าเจ้าอยู่หัว 
4. ส่ือส่ิงพิมพ์ E–Book แตกต่างจากส่ือส่ิงพิมพ์ประเภทอื่นอย่างไร 
 ก. E–Book จะใช้งานยากกว่าส่ือส่ิงพิมพ์อื่น ๆ 
 ข. E–Book ได้รับความนิยมมากกว่าส่ือส่ิงพิมพ์อื่น ๆ 
 ค. E–Book เป็นส่ือส่ิงพิมพ์มีค่ามากกว่าส่ือส่ิงพิมพ์อื่น ๆ  
 ง. E–Book จำเป็นต้องใช้เครื่องมืออิเล็กทรอนิกส์ประกอบการใช้งาน 
5.  ส่ิงพิมพ์ต่อไปนี้ข้อใดจัดอยู่ในประเภทของส่ิงพิมพ์ลักษณะพิเศษ 
 ก.  ธนาณัติ ปฏิทิน โฉนด ข.  โฉนด หนังสือนิยาย ธนบัตร 
 ค.  บัตรอวยพร นามบัตร ปฏิทิน ง.  โฉนด ฉลากสินค้า บัตรเครดิต 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

7.  เอกสารอ้างอิง (ขึ้นหน้าใหม่) 
วิชาการผลิตสื่อดิจิทัล 
8.ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ) 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. ส่ือส่ิงพิมพ์มีความหมายตรงกับข้อใดมากท่ีสุด 
 ก. การสร้างและบันทึกข้อมูลภาพและเสียงให้อยู่ในรูปแบบของระบบคอมพิวเตอร์ 
 ข. การสร้างช้ินงานจากการพิมพ์ด้วยวิธีต่าง ๆ ลงบนวัตถุท่ีหลากหลาย เพื่อใช้ติดต่อกัน 
 ค. การสร้างช้ินงานจากการพิมพ์ด้วยเครื่องคอมพิวเตอร์ในรูปแบบของภาพ เพื่อใช้เผยแพร่ถึงกัน 
 ง. การสร้างภาพหรือส่ิงท่ีเกี่ยวข้องกับการแสดงภาพด้วยเครื่องคอมพิวเตอร์ท้ังทางตรงและทางอ้อม 
2. ผู้ท่ีได้รับยกย่องให้เป็นบิดาแห่งการพิมพ์คือใคร 
 ก. โจฮัน กูเต็นเบิร์ก (Johann Gutenberg) 
 ข. แซมมวล ไดเออร์ (Samuel Dyer) 
 ค. โรเบิร์ต ดี. ดาเวนพอร์ต (Robert D. Davenport) 
 ง. หมอแดน บีช บรัดเลย์ (Dr. Dan Beach Bradley M.D.) 
3. คนไทยคนแรกที่ได้ริเริ่มกิจการการพิมพ์คือใคร 
 ก.  พระบาทสมเด็จพระนั่งเกล้าเจ้าอยู่หัว 
 ข.  พระบาทสมเด็จพระมงกุฎเกล้าเจ้าอยู่หัว 
 ค.  พระบาทสมเด็จพระจอมเกล้าเจ้าอยู่หัว 
 ง.  พระบาทสมเด็จพระจุลจอมเกล้าเจ้าอยู่หัว 
4. ส่ือส่ิงพิมพ์ E–Book แตกต่างจากส่ือส่ิงพิมพ์ประเภทอื่นอย่างไร 
 ก. E–Book จะใช้งานยากกว่าส่ือส่ิงพิมพ์อื่น ๆ 
 ข. E–Book ได้รับความนิยมมากกว่าส่ือส่ิงพิมพ์อื่น ๆ 
 ค. E–Book เป็นส่ือส่ิงพิมพ์มีค่ามากกว่าส่ือส่ิงพิมพ์อื่น ๆ  
 ง. E–Book จำเป็นต้องใช้เครื่องมืออิเล็กทรอนิกส์ประกอบการใช้งาน 
5.  ส่ิงพิมพ์ต่อไปนี้ข้อใดจัดอยู่ในประเภทของส่ิงพิมพ์ลักษณะพิเศษ 
 ก.  ธนาณัติ ปฏิทิน โฉนด ข.  โฉนด หนังสือนิยาย ธนบัตร 
 ค.  บัตรอวยพร นามบัตร ปฏิทิน ง.  โฉนด ฉลากสินค้า บัตรเครดิต 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

ใบงานที่ 1 หน่วยที่   1 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 1 
 

ชื่อหน่วย   ความรู้เบื้องต้นเก่ียวกับสื่อสิ่งพิมพ์ 
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

ชื่อหน่วย ความรู้เบื้องต้นเก่ียวกับสื่อสิ่งพิมพ์  
 

ใบงานที่  1 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. ส่ือส่ิงพิมพ์มีความหมายตรงกับข้อใดมากท่ีสุด 
 ก. การสร้างและบันทึกข้อมูลภาพและเสียงให้อยู่ในรูปแบบของระบบคอมพิวเตอร์ 
 ข. การสร้างช้ินงานจากการพิมพ์ด้วยวิธีต่าง ๆ ลงบนวัตถุท่ีหลากหลาย เพื่อใช้ติดต่อกัน 
 ค. การสร้างช้ินงานจากการพิมพ์ด้วยเครื่องคอมพิวเตอร์ในรูปแบบของภาพ เพื่อใช้เผยแพร่ถึงกัน 
 ง. การสร้างภาพหรือส่ิงท่ีเกี่ยวข้องกับการแสดงภาพด้วยเครื่องคอมพิวเตอร์ท้ังทางตรงและทางอ้อม 
2. ผู้ท่ีได้รับยกย่องให้เป็นบิดาแห่งการพิมพ์คือใคร 
 ก. โจฮัน กูเต็นเบิร์ก (Johann Gutenberg) 
 ข. แซมมวล ไดเออร์ (Samuel Dyer) 
 ค. โรเบิร์ต ดี. ดาเวนพอร์ต (Robert D. Davenport) 
 ง. หมอแดน บีช บรัดเลย์ (Dr. Dan Beach Bradley M.D.) 
3. คนไทยคนแรกที่ได้ริเริ่มกิจการการพิมพ์คือใคร 
 ก.  พระบาทสมเด็จพระนั่งเกล้าเจ้าอยู่หัว 
 ข.  พระบาทสมเด็จพระมงกุฎเกล้าเจ้าอยู่หัว 
 ค.  พระบาทสมเด็จพระจอมเกล้าเจ้าอยู่หัว 
 ง.  พระบาทสมเด็จพระจุลจอมเกล้าเจ้าอยู่หัว 
4. ส่ือส่ิงพิมพ์ E–Book แตกต่างจากส่ือส่ิงพิมพ์ประเภทอื่นอย่างไร 
 ก. E–Book จะใช้งานยากกว่าส่ือส่ิงพิมพ์อื่น ๆ 
 ข. E–Book ได้รับความนิยมมากกว่าส่ือส่ิงพิมพ์อื่น ๆ 
 ค. E–Book เป็นส่ือส่ิงพิมพ์มีค่ามากกว่าส่ือส่ิงพิมพ์อื่น ๆ  
 ง. E–Book จำเป็นต้องใช้เครื่องมืออิเล็กทรอนิกส์ประกอบการใช้งาน 
5.  ส่ิงพิมพ์ต่อไปนี้ข้อใดจัดอยู่ในประเภทของส่ิงพิมพ์ลักษณะพิเศษ 
 ก.  ธนาณัติ ปฏิทิน โฉนด ข.  โฉนด หนังสือนิยาย ธนบัตร 
 ค.  บัตรอวยพร นามบัตร ปฏิทิน ง.  โฉนด ฉลากสินค้า บัตรเครดิต 

 
 
 
 
 
 
 



 

 
 

 
บันทึกผลหลังการจัดการเรียนรู้ 

 
 ผลการจัดการเรียนรู้ตามแผนการสอน 
  1) วัน เดือน ปี ...............สอนครั้งท่ี .../.... สาขา/ช้ันปี  .....................จำนวนผู้เรียน..........คน    
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน 

2) หัวข้อเรื่อง/เนื้อหาสาระ :  ........................................................................................................... 
  ❑ สอนครบตามหัวข้อเรื่องในแผนฯ  ❑ สอนไม่ครบเนื่องจาก........................................ 
  3) กิจกรรม/วิธีการสอน 
   ❑ ครูแนะนำและบอกจุดประสงค์     ❑ ครูอธิบาย/ถาม-ตอบ/สาธิต/ 
   ❑ ทำแบบทดสอบก่อนเรียน      ❑ ทำแบบทดสอบหลังเรียน 
   ❑ ทำแบบฝึกหัด/โจทย์ปัญหา      ❑ ทำใบกิจกรรม/ใบงาน 
   ❑ อื่น ๆ (ระบ)ุ................................................................................................................... 
  4) ส่ือการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………………….......... 
  ....................................................................................................................................................... 
 11.2 ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาที่พบ 
  1) การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ………………………………………………..…….. 
       ........................................................................................................................................................ 
  2) สมรรถนะท่ีผู้เรียนได้รับ : .......................................................................................................... 
      .......................................................................................................................................................... 
  3) สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..…………………………………………………………..…..... 
      ……………....................................................................................................................................... 
  4) ผลการสอนของครู : ..……………………………………………………………………………………..…….……. 
      ……………........................................................................................................................................... 
  5) ปัญหาท่ีนำไปสู่การวิจัย : ..………………………………………………………………………………..….……... 
 11.3 แนวทางการพัฒนาคุณภาพการสอน/แก้ปัญหา 
  1) ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : .…………………………………………………………………... 
   
  2) แนวทางพัฒนาคุณภาพวิธีสอน/ส่ือ/การวัดผล/เอกสารช่วยสอน   
       …………….......................................................................................................................................... 
  

                                                      ลงช่ือ 
 

                      (.........................................) 
                                   ครูผู้สอน 
          ………./…………/………… 



 

 
 

 

 
 
 

แผนการจัดการเรียนรู้ หน่วยที่   2 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 2-4 
 

ชื่อหน่วย   การออกแบบและกระบวนการผลิตสื่อสิ่งพิมพ์

  ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

ชื่อเร่ือง  การออกแบบและกระบวนการผลิตสื่อสิ่งพิมพ์ 
 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 หนึ่งที่สำคัญของกระบวนการผลิตสื่อสิ่งพิมพ์ให้ประสบผลสำเร็จ การออกแบบในลักษณะใดก็ตาม
ต้องอาศัยส่วนประกอบของงานศิลป์อันได้แก่ เส้น รูปร่าง รูปทรง สี ลักษณะผิว เพื่อนำมาประกอบกันเป็นผลงาน
ท่ีมีความสวยงาม เหมาะสมกับวัตถุประสงค์ จนทำให้เกิดเป็นผลงานท่ีมีรูปแบบท่ีดี  
 ส่ือส่ิงพิมพ์ท่ีจะสำเร็จบรรลุจุดมุ่งหมายได้นั้น นอกจากการออกแบบท่ีมีประสิทธิภาพแล้ว กระบวนการผลิต
สื่อสิ่งพิมพ์ก็มีความสำคัญอย่างยิ่ง ทั้งในด้านการวางแผน การเตรียมการ ก่อนพิมพ์ การทำต้นฉบับ การเลือก
ประเภทของการพิมพ์เพื่อให้เหมาะสมกับส่ือส่ิงพิมพ์ และส่งผลให้การผลิตส่ือส่ิงพิมพ์สำเร็จบรรลุจุดมุ่งหมาย 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 

- 
3. สมรรถนะประจำหน่วย  

1.  แสดงความรู ้เกี ่ยวกับการออกแบบสื ่อสิ ่งพิมพ์กระบวนการพิมพ์ และการผลิตสื ่อสิ ่งพิมพ์ด้วย
คอมพิวเตอร์แบบต้ังโต๊ะ 

2.  จำแนกขั้นตอนกระบวนการผลิตส่ือส่ิงพิมพ์ 
 3.  ออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสารส่ิงพิมพ์ 
 4.  วางแผนการผลิตส่ือส่ิงพิมพ์ตามข้ันตอนในการผลิตส่ือส่ิงพิมพ์ 

5.  เตรียมวัสดุอุปกรณ์เหมาะสมกับการปฏิบัติงาน 
6.  ออกแบบส่ือส่ิงพิมพ์ตามข้ันตอนท่ีกำหนด 

 7.  แสดงพฤติกรรมความสนใจใฝ่รู้ ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็นประชาธิปไตยและ
ห่างไกลยาเสพติด 

4. จุดประสงค์เชิงพฤติกรรม 
3.1 ด้านความรู้ 

3.1.1 เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับการออกแบบส่ือส่ิงพิมพ์  กระบวนการพิมพ์  
        และการผลิตส่ือส่ิงพิมพ์ด้วยคอมพิวเตอร์แบบต้ังโต๊ะ 
3.1.2 เพื่อให้เข้าใจขั้นตอนกระบวนการผลิตส่ือส่ิงพิมพ์ 
3.1.3 เพื่อให้เข้าใจหลักการออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสารส่ิงพิมพ์ 



 

 
 

3.2 ด้านทักษะ 
3.1.4 อธิบายการออกแบบส่ือส่ิงพิมพ์ได้ 
3.1.5 อธิบายกระบวนการผลิตส่ือส่ิงพิมพ์ได้ 
3.1.6 จำแนกขั้นตอนกระบวนการผลิตส่ือส่ิงพิมพ์ได้ 
3.1.7 ออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสารส่ิงพิมพ์ได้ 
3.1.8 อธิบายการผลิตส่ือส่ิงพิมพ์ด้วยคอมพิวเตอร์แบบต้ังโต๊ะได้ 

 

3.2 คุณลักษณะที่พึงประสงค์ 
3.2.2 ความสนใจใฝ่รู้  
3.2.3 มีความซื่อสัตย์ในการปฏิบัติงาน 
3.2.4 มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
3.2.5 ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

5. สาระการเรียนรู้ 
5.1  การออกแบบและกระบวนการผลิตสื่อสิ่งพิมพ์ 

6. กิจกรรมการเรียนรู้ 
6.1 การนำเข้าสู่บทเรียน 

1.ผู้สอนกล่าวทักทายผู้เรียน เนื่องจากเป็นการสอนครั้งแรก   
2.ผู้สอนตรวจสอบรายช่ือผู้เรียน 
3.ผู้สอนบอกจุดประสงค์รายวิชา มาตรฐานรายวิชา และคำอธิบายรายวิชา 
4.ผู้สอนแจกแบบทดสอบก่อนเรียนเพื่อทดสอบผู้เรียน 

7. สื่อและแหล่งเรียนรู้ 
7.1 หนังสือการผลิตส่ือสิงพิมพ์. ประภาวรรณ เกษวิริยะการณ์. สำนักพิมพ์เมืองไทย 
7.2 ส่ือประกอบการเรียน เช่น VDO,  PowerPoint,  YouTube และอุปกรณ์จริง 

8. หลักฐานการเรียนรู้ 
8.1 หลักฐานความรู้           

   คะแนนจากการตอบคำถามท้ายบทเรียน และแบบทดสอบ ในหนังสือประกอบการเรียน  
8.2 หลักฐานการปฏิบัติงาน 

   คะแนนการทำกิจกรรมการเรียนรู้  และภาพถ่ายการทำกิจกรรมของผู้เรียน  
     9. การวัดและการประเมินผล 

9.1 วิธีวัดและการประเมินผล 
1) ทดสอบก่อนเรียนและหลังเรียน 
2) ตรวจใบงาน 
3) ประเมินการนำเสนอผลงาน 
4) สังเกตพฤติกรรม 



 

 
 

9.2 เคร่ืองมือวัดและการประเมินผล 
1) แบบทดสอบก่อนเรียนและหลังเรียน 
2) ใบงาน 
3) แบบประเมินการนำเสนอผลงาน 
4) แบบสังเกตพฤติกรรม 

9.3 เกณฑ์วัดและการประเมินผล 
1) เกณฑ์การทดสอบก่อนเรียนและหลังเรียน คะแนนผ่านไม่ต่ำกว่า 80% 
2) เกณฑ์การประเมินใบงาน คะแนนผ่านไม่ต่ำกว่า 80% 
3) เกณฑ์การประเมินผลการนำเสนอผลงาน คะแนนผ่านไม่ต่ำกว่า 80% 
4) เกณฑ์การสังเกตพฤติกรรม คะแนนผ่านไม่ต่ำกว่า 80% 

 
10.  บันทึกผลหลังการจัดการเรียนรู้ 

 
10.1 ผลการจัดการเรียนรู้ท่ีเกิดขึ้นกับผู้เรียน 

               
               
               

10.2 ปัญหา อุปสรรคท่ีพบ 
               
               
               

10.3 การแก้ไขปัญหา 
1) ผลการแก้ไขปัญหาทีส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
 
 
 
 
 
 
 
 
 
 

 



 

 
 

 

 

ใบความรู้ที่ 2 หน่วยที่   2 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 2-4 
 

ชื่อหน่วย   การออกแบบและกระบวนการผลิตสื่อสิ่งพิมพ์

  ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

ชื่อหน่วยการออกแบบและกระบวนการผลิตสื่อสิ่งพิมพ์ 
 
1.  ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

1 การออกแบบและกระบวนการผลิตส่ือส่ิงพิมพ ์
2. อ้างอิงมาตรฐาน / เชื่อมโยงกลุ่มอาชีพ (ถ้ามี) 

 -  
3สมรรถนะประจำหน่วย  

1.  แสดงความรู ้เกี ่ยวกับการออกแบบสื ่อสิ ่งพิมพ์กระบวนการพิมพ์ และการผลิตสื ่อสิ ่งพิมพ์ด้วย
คอมพิวเตอร์แบบต้ังโต๊ะ 

2.  จำแนกขั้นตอนกระบวนการผลิตส่ือส่ิงพิมพ์ 
 3.  ออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสารส่ิงพิมพ์ 
 4.  วางแผนการผลิตส่ือส่ิงพิมพ์ตามข้ันตอนในการผลิตส่ือส่ิงพิมพ์ 

5.  เตรียมวัสดุอุปกรณ์เหมาะสมกับการปฏิบัติงาน 
6.  ออกแบบส่ือส่ิงพิมพ์ตามข้ันตอนท่ีกำหนด 

 7.  แสดงพฤติกรรมความสนใจใฝ่รู้ ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็นประชาธิปไตยและ
ห่างไกลยาเสพติด 

4.จุดประสงค์เชิงพฤติกรรม 
3.3 ด้านความรู้ 

3.1.1 เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับการออกแบบส่ือส่ิงพิมพ์  กระบวนการพิมพ์  
        และการผลิตส่ือส่ิงพิมพ์ด้วยคอมพิวเตอร์แบบต้ังโต๊ะ 
3.2.6 เพื่อให้เข้าใจขั้นตอนกระบวนการผลิตส่ือส่ิงพิมพ์ 
3.2.7 เพื่อให้เข้าใจหลักการออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสาร 
        ส่ิงพิมพ์ 

3.4 ด้านทักษะ 
3.2.8 อธิบายการออกแบบส่ือส่ิงพิมพ์ได้ 
3.2.9 อธิบายกระบวนการผลิตส่ือส่ิงพิมพ์ได้ 
3.2.10 จำแนกขั้นตอนกระบวนการผลิตส่ือส่ิงพิมพ์ได้ 
3.2.11 ออกแบบและจัดหน้าส่ือส่ิงพิมพ์ตามหลักการสร้างเอกสารส่ิงพิมพ์ได้ 



 

 
 

3.2.12 อธิบายการผลิตส่ือส่ิงพิมพ์ด้วยคอมพิวเตอร์แบบต้ังโต๊ะได้ 
 

3.3 คุณลักษณะที่พึงประสงค์ 
3.3.2 ความสนใจใฝ่รู้  
3.3.3 มีความซื่อสัตย์ในการปฏิบัติงาน 
3.3.4 มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
3.3.5 ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

5. เนือ้หาสาระ 
1.  การออกแบบสื่อสิ่งพิมพ์ 
          การออกแบบเป็นการนำองค์ประกอบมูลฐานมาจัด หรือรวบรวมเข้าไว้ด้วยกันอย่างมีระบบ ในงาน 
ออกแบบไม่ว่าจะเป็นตัวอักษร ภาพ หรือพื้นท่ีว่างก็เพื่อให้การออกแบบส่ือส่ิงพิมพ์เป็นไปตามวัตถุประสงค์ 
ท่ีต้องการ 
 1.1  วัตถุประสงค์ของการออกแบบส่ือส่ิงพิมพ์ 
 1.2  หลักการออกแบบส่ือส่ิงพิมพ์ 
 1..3  หลักการพิจารณาเพื่อออกแบบส่ือส่ิงพิมพ์ 
 1.4  องค์ประกอบในการออกแบบส่ือส่ิงพิมพ์ 
 1.5  การจัดองค์ประกอบศิลป์ในส่ือส่ิงพิมพ์   
 

2. กระบวนการพิมพ์ 
 กระบวนการพิมพ์ คือ ขั้นตอนวิธีการในการผลิตส่ิงพิมพ์ต่าง ๆ  เช่น หนังสือ จุลสาร แผ่นพับ ฉลากสินค้า 
โปสเตอร์โฆษณา เป็นต้น โดยในการผลิตต้องกำหนดรูปแบบและจำนวนท่ีต้องการ กระบวนการพิมพ์ 
เริ่มต้นจากการรับต้นฉบับที่เป็นอาร์ตเวิร์ก (ต้นฉบับสำหรับส่งไปพิมพ์จริง) และสิ้นสุดเป็นชิ้นงาน  กระบวนการ
พิมพ์มีข้ันตอนดังนี้ 
 2.2.1  กระบวนการก่อนการพิมพ์ (Prepress Process)  
  กระบวนการนี้ได้ถูกพัฒนาอย่างต่อเนื่อง ตั้งแต่มีการนำเครื่องคอมพิวเตอร์มาใช้ในการออกแบบ 
และควบคุมขบวนการทำแม่พิมพ์ในปัจจุบันต้นฉบับ/อาร์ตเวิร์กมักเป็นรูปแบบของไฟล์ดิจิตอล กระบวนการก่อน
การพิมพ์ท่ีกล่าวในท่ีนี้จะอิงระบบดิจิตอลในการทำงาน ประกอบด้วย 
 2.2.2  กระบวนการการพิมพ์ (Press/Printing Process)  
  เมื่อได้แม่พิมพ์ท่ีสมบูรณ์ ก็เริ่มเข้าสู่กระบวนการพิมพ์ กระบวนการพิมพ์มีความสำคัญมาก ช้ินงาน
จะออกมาดีหรือไม่ข้ึนอยู่กับการพิมพ์เป็นหลักใหญ่ และจะพบว่าปัญหาส่วนใหญ่ท่ีเกิดระหว่างลูกค้ากับโรงพิมพ์มัก
มาจากการพิมพ์ เช่น สีไม่เหมือน พิมพ์เหลื่อม ข้อความไม่ชัด เป็นต้น ดังนั้น การควบคุมการพิมพ์จึงเป็นเรื่อง
สำคัญ 
 2.2.3  กระบวนการหลังการพิมพ์ (After Press Process)  



 

 
 

    งานพิมพ์ที ่พิมพ์เสร็จสิ ้นแล้วโดยทั่วไปยังไม่สมบูรณ์เป็นชิ้นงานตามที ่ต้องการ จึงต้องผ่าน
กระบวนการต่าง ๆ ดังต่อไปนี้ 

1. การตกแต่งผิวชิ้นงาน 
2. การขึ้นรูป 
3. การทำรูปเล่ม 
4. การบรรจุหีบห่อ 

 
3  การผลิตสื่อสิ่งพิมพ์ด้วยคอมพิวเตอร์แบบต้ังโต๊ะ 
 การจัดพิมพ์สิ่งพิมพ์ประเภทต่าง ๆ ในยุคก่อนนั้นต้องผ่านกระบวนการต่าง ๆ มากมายหลายขั้นตอนท่ี
เรียกว่า การเรียงพิมพ์ โดยท่ีจะต้องมีผู้ตัดต่อรูปภาพ วาดกรอบของภาพหรือกรอบหัวเรื่อง เขียนข้อความ และนำ
ข้อความ ภาพ กรอบมาประกอบกันตามที่ออกแบบไว้ การทำงานที่ยุ่งยากเหล่านี้นี่เองที่ทำให้เอกสารเหล่านั้นมี
ราคาแพง แต่ในปัจจุบันนี้มีเพียงเครื่องคอมพิวเตอร์ เครื่องพรินเตอร์และโปรแกรมเท่านั้นก็สามารถท่ีจะออกแบบ
งานหรือเอกสารให้เป็นที่น่าสนใจได้ โดยโปรแกรมจะมีความสามารถด้านการจัดการเอกสาร ความสามารถด้าน
การเรียงพิมพ์ 

 3.1 ความหมายของการผลิตส ื ่อส ิ ่งพิมพ์ด ้วยคอมพิวเตอร ์แบบตั ้งโต ๊ะ  (Desktop 
Publishing) 
   Desktop Publishing ความหมายในหนังสือ ศัพท์คอมพิวเตอร์ฉบับราชบัณฑิตยสถาน พ.ศ. 
2538 บัญญัติไว้ว่า “การจัดพิมพ์ด้วยคอมพิวเตอร์แบบตั้งโต๊ะ” โดยใช้ตัวย่อ ดีทีพี (DTP) หมายถึง การนำภาพ
และข้อความมาจัดวางไว้ด้วยกันบนจอภาพในตำแหน่งท่ีสวยงาม ดูแล้วสบายตา มักใช้เป็นต้นแบบของเอกสารส่ือ
สิ่งพิมพ์ เป็นการจัดเตรียมต้นฉบับเอกสารสื่อสิ่งพิมพ์ กระบวนการจัดพิมพ์โดยใช้เครื่องคอมพิวเตอร์แบบตั้งโต๊ะ 
แทนท่ีจะเป็นการตัดปะอย่างสมัยก่อน มีระบบการผลิตส่ือส่ิงพิมพ์ท่ีมีต้นทุนไม่สูงมาก มีการนำโปรแกรมสำเร็จรูป
ช่วยในการเรียงข้อความ การทำภาพกราฟิก เช่น การใช้โปรแกรมอโดบี อินดีไซน์ (Adobe InDesign) โปรแกรม 
อโดบี เพจเมคเกอร์ (Adobe PageMaker) เป็นต้น เพื่อผลิตสิ่งพิมพ์หลากหลายประเภทได้อย่างประหยัด และ
สวยงาม เป็นท่ีนิยมใช้ในปัจจุบัน 
 3.2 องค์ประกอบของการจัดพิมพ์ด้วยคอมพิวเตอร์แบบต้ังโต๊ะ 
 การผลิตส่ือส่ิงพิมพ์ด้วยคอมพิวเตอร์แบบต้ังโต๊ะประกอบด้วย 
 1. เครื่องคอมพิวเตอร์ ด้วยเทคโนโลยีที่ทันสมัยทำให้ประสิทธิภาพการทำงานที่ดีขึ้นความนิยมใน
การใช้เครื่องคอมพิวเตอร์ก็เปลี่ยนแปลงไป ไม่ว่าจะเป็นโน้ตบุ๊ก เครื่องแมคฯ และมีการพัฒนาอย่างต่อเนื่อง จน
ปัจจุบันมีความก้าวหน้าและสามารถผลิตส่ือส่ิงพิมพ์ท่ีมีคุณภาพได้ทัดเทียมกับโรงพิมพ์ 
 2.  โปรแกรมสำเร็จรูปในการจัดหน้า ส่ือส่ิงพิมพ์ท่ีมีคุณภาพดีจะต้องอาศัยโปรแกรมสำเร็จรูป
หลายโปรแกรมประกอบกัน ซึ่งในปัจจุบันมีให้เลือกใช้มากมายหลายโปรแกรม แต่ละโปรแกรมจะมีคุณสมบัติท่ี
แตกต่างกันไป ได้แก่ โปรแกรมพิมพ์ข้อความและวาดภาพกราฟิกแบบง่าย โปรแกรมวาดภาพ โปรแกรมตกแต่ง



 

 
 

ภาพ และโปรแกรมสำหรับการจัดหน้า การเลือกใช้โปรแกรมได้เหมาะสมจะทำให้การผลิตส่ือส่ิงพิมพ์ทำได้สะดวก 
และง่ายดาย ผลงานท่ีออกมาก็จะมีคุณภาพท่ีดี 
 3.  เครื่องพิมพ์ เครื่องพิมพ์เป็นอุปกรณ์ต่อพ่วงกับเครื่องคอมพิวเตอร์ เพื่อใช้แสดงผลลัพธ์
ออกมาทางกระดาษ เครื่องพิมพ์ในปัจจุบันมีหลายชนิด แต่ที ่นิยมใช้มากในปัจจุบัน คือ เครื ่องพิมพ์แบบ  
พ่นหมึก (Inkjet) และเครื่องพิมพ์แบบเลเซอร์ (Laser) ในการผลิตสื่อสิ่งพิมพ์ผู้ผลิตสามารถเลือกใช้เครื่องพิมพ์
แบบใดก็ได้ ตามความถนัดและเหมาะสม 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

6. แบบทดสอบ/แบบฝึกหัด 
จากโจทย์คำถาม จงเลือกคำตอบที่ถูกต้องที่สุด 

แบบฝึกหัดหน่วยที่ 2 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว  
1. ข้อใดอธิบายหลักการออกแบบได้ถูกต้องท่ีสุด 
 ก.  มีจุดมุ่งหมายตามประโยชน์ใช้สอย 
 ข.  เป็นการออกแบบท่ีมีลักษณะซับซ้อน 
 ค. ใช้เวลาในการออกแบบมาก 
 ง.  มีสัดส่วนท่ีแตกต่างกัน 
2. ข้อใดไม่ใช่วัตถุประสงค์ในการออกแบบส่ือส่ิงพิมพ์ 
 ก. เป็นแนวทางในการผลิตส่ือส่ิงพิมพ์  
 ข. เพื่อปิดบังความด้อยต่อคุณภาพส่ิงพิมพ์     
 ค. เพื่อให้มีเนื้อหาและรูปภาพจำนวนมาก 
 ง. เพื่อดึงดูดความสนใจของผู้พบเห็นและผู้อ่าน 
3. ข้อใดอธิบายความสำคัญของ “จุดรวมสายตา” ได้ถูกต้อง 
 ก. เป็นจุดบนสุดในส่ือส่ิงพิมพ์ 
 ข. เป็นจุดกึ่งกลางในส่ือส่ิงพิมพ์ 
 ค. เป็นจุดท่ีน่าสนใจท่ีสุดในส่ือส่ิงพิมพ์ 
 ง. เป็นจุดต่อระหว่างหน้าในส่ือส่ิงพิมพ์ 
4. ข้อใดอธิบายการจัดองค์ประกอบศิลป์แบบสมดุลแบบรัศมีได้ถูกต้อง 
 ก. เป็นการจัดวางองค์ประกอบซ้ายขวาเท่ากันท้ัง 2 ด้าน 
 ข. เป็นการจัดวางองค์ประกอบแบบแผ่ไปทุกทิศจากศูนย์กลาง 
 ค. เป็นการจัดวางองค์ประกอบให้มีด้านซ้ายและขวาไม่เหมือนกัน   
 ง. เป็นการจัดวางองค์ประกอบให้มีความแตกต่างกันของขนาดและรูปร่าง 
5. ข้อใดกล่าวได้ถูกต้องเกี่ยวกับกระบวนการก่อนการพิมพ์ 
 ก. ขั้นตอนก่อนพิมพ์คือการเตรียมพิมพ ์
 ข. การจัดวางหน้าสำหรับแม่พิมพ์เป็นกระบวนการกอ่นพิมพ์ 
 ค. การขึ้นรูปเป็นขั้นตอนของแม่พิมพ์ในกระบวนการก่อนพิมพ์ 
 ง. การตกแต่งผิวชิ้นงานเป็นขั้นตอนสุดท้ายของกระบวนการก่อนพิมพ์ 

 
 
 
 
 
 
 
 

 
 



 

 
 

7.  เอกสารอ้างอิง (ขึ้นหน้าใหม่) 
วิชาการผลิตสื่อดิจิทัล 
8.ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ) 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว  
1. ข้อใดอธิบายหลักการออกแบบได้ถูกต้องท่ีสุด 
 ก.  มีจุดมุ่งหมายตามประโยชน์ใช้สอย 
 ข.  เป็นการออกแบบท่ีมีลักษณะซับซ้อน 
 ค. ใช้เวลาในการออกแบบมาก 
 ง.  มีสัดส่วนท่ีแตกต่างกัน 
2. ข้อใดไม่ใช่วัตถุประสงค์ในการออกแบบส่ือส่ิงพิมพ์ 
 ก. เป็นแนวทางในการผลิตส่ือส่ิงพิมพ์  
 ข. เพื่อปิดบังความด้อยต่อคุณภาพส่ิงพิมพ์     
 ค. เพื่อให้มีเนื้อหาและรูปภาพจำนวนมาก 
 ง. เพื่อดึงดูดความสนใจของผู้พบเห็นและผู้อ่าน 
3. ข้อใดอธิบายความสำคัญของ “จุดรวมสายตา” ได้ถูกต้อง 
 ก. เป็นจุดบนสุดในส่ือส่ิงพิมพ์ 
 ข. เป็นจุดกึ่งกลางในส่ือส่ิงพิมพ์ 
 ค. เป็นจุดท่ีน่าสนใจท่ีสุดในส่ือส่ิงพิมพ์ 
 ง. เป็นจุดต่อระหว่างหน้าในส่ือส่ิงพิมพ์ 
4. ข้อใดอธิบายการจัดองค์ประกอบศิลป์แบบสมดุลแบบรัศมีได้ถูกต้อง 
 ก. เป็นการจัดวางองค์ประกอบซ้ายขวาเท่ากันท้ัง 2 ด้าน 
 ข. เป็นการจัดวางองค์ประกอบแบบแผ่ไปทุกทิศจากศูนย์กลาง 
 ค. เป็นการจัดวางองค์ประกอบให้มีด้านซ้ายและขวาไม่เหมือนกัน   
 ง. เป็นการจัดวางองค์ประกอบให้มีความแตกต่างกันของขนาดและรูปร่าง 
5. ข้อใดกล่าวได้ถูกต้องเกี่ยวกับกระบวนการก่อนการพิมพ์ 
 ก. ขั้นตอนก่อนพิมพ์คือการเตรียมพิมพ ์
 ข. การจัดวางหน้าสำหรับแม่พิมพ์เป็นกระบวนการกอ่นพิมพ์ 
 ค. การขึ้นรูปเป็นขั้นตอนของแม่พิมพ์ในกระบวนการก่อนพิมพ์ 
 ง. การตกแต่งผิวชิ้นงานเป็นขั้นตอนสุดท้ายของกระบวนการก่อนพิมพ์ 

 
 
 
 
 
 
 
 
 
 



 

 
 

 

 

ใบงานที่ 1 หน่วยที่   1 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 1 
 

ชื่อหน่วย   ความรู้เบื้องต้นเก่ียวกับสื่อสิ่งพิมพ์ 
  ทฤษฎี  2  ชม.  

ปฏิบัติ  2 ชม. 
ชื่อหน่วย ความรู้เบื้องต้นเก่ียวกับสื่อสิ่งพิมพ์  

 
ใบงานที่  2 

คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว  
1. ข้อใดอธิบายหลักการออกแบบได้ถูกต้องท่ีสุด 
 ก.  มีจุดมุ่งหมายตามประโยชน์ใช้สอย 
 ข.  เป็นการออกแบบท่ีมีลักษณะซับซ้อน 
 ค. ใช้เวลาในการออกแบบมาก 
 ง.  มีสัดส่วนท่ีแตกต่างกัน 
2. ข้อใดไม่ใช่วัตถุประสงค์ในการออกแบบส่ือส่ิงพิมพ์ 
 ก. เป็นแนวทางในการผลิตส่ือส่ิงพิมพ์  
 ข. เพื่อปิดบังความด้อยต่อคุณภาพส่ิงพิมพ์     
 ค. เพื่อให้มีเนื้อหาและรูปภาพจำนวนมาก 
 ง. เพื่อดึงดูดความสนใจของผู้พบเห็นและผู้อ่าน 
3. ข้อใดอธิบายความสำคัญของ “จุดรวมสายตา” ได้ถูกต้อง 
 ก. เป็นจุดบนสุดในส่ือส่ิงพิมพ์ 
 ข. เป็นจุดกึ่งกลางในส่ือส่ิงพิมพ์ 
 ค. เป็นจุดท่ีน่าสนใจท่ีสุดในส่ือส่ิงพิมพ์ 
 ง. เป็นจุดต่อระหว่างหน้าในส่ือส่ิงพิมพ์ 
4. ข้อใดอธิบายการจัดองค์ประกอบศิลป์แบบสมดุลแบบรัศมีได้ถูกต้อง 
 ก. เป็นการจัดวางองค์ประกอบซ้ายขวาเท่ากันท้ัง 2 ด้าน 
 ข. เป็นการจัดวางองค์ประกอบแบบแผ่ไปทุกทิศจากศูนย์กลาง 
 ค. เป็นการจัดวางองค์ประกอบให้มีด้านซ้ายและขวาไม่เหมือนกัน   
 ง. เป็นการจัดวางองค์ประกอบให้มีความแตกต่างกันของขนาดและรูปร่าง 
5. ข้อใดกล่าวได้ถูกต้องเกี่ยวกับกระบวนการก่อนการพิมพ์ 
 ก. ขั้นตอนก่อนพิมพ์คือการเตรียมพิมพ ์
 ข. การจัดวางหน้าสำหรับแม่พิมพ์เป็นกระบวนการกอ่นพิมพ์ 
 ค. การขึ้นรูปเป็นขั้นตอนของแม่พิมพ์ในกระบวนการก่อนพิมพ์ 
 ง. การตกแต่งผิวชิ้นงานเป็นขั้นตอนสุดท้ายของกระบวนการก่อนพิมพ์ 

 
 
 
 



 

 
 

 
บันทึกผลหลังการจัดการเรียนรู้ 

 
 ผลการจัดการเรียนรู้ตามแผนการสอน 
  1) วัน เดือน ปี ...............สอนครั้งท่ี .../.... สาขา/ช้ันปี  .....................จำนวนผู้เรียน..........คน    
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน 

2) หัวข้อเรื่อง/เนื้อหาสาระ :  ........................................................................................................... 
  ❑ สอนครบตามหัวข้อเรื่องในแผนฯ  ❑ สอนไม่ครบเนื่องจาก........................................ 
  3) กิจกรรม/วิธีการสอน 
   ❑ ครูแนะนำและบอกจุดประสงค์     ❑ ครูอธิบาย/ถาม-ตอบ/สาธิต/ 
   ❑ ทำแบบทดสอบก่อนเรียน      ❑ ทำแบบทดสอบหลังเรียน 
   ❑ ทำแบบฝึกหัด/โจทย์ปัญหา      ❑ ทำใบกิจกรรม/ใบงาน 
   ❑ อื่น ๆ (ระบ)ุ................................................................................................................... 
  4) ส่ือการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………………….......... 
  ....................................................................................................................................................... 
 11.2 ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาที่พบ 
  1) การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ………………………………………………..…….. 
       ........................................................................................................................................................ 
  2) สมรรถนะท่ีผู้เรียนได้รับ : .......................................................................................................... 
      .......................................................................................................................................................... 
  3) สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..…………………………………………………………..…..... 
      ……………....................................................................................................................................... 
  4) ผลการสอนของครู : ..……………………………………………………………………………………..…….……. 
      ……………........................................................................................................................................... 
  5) ปัญหาท่ีนำไปสู่การวิจัย : ..………………………………………………………………………………..….……... 
 11.3 แนวทางการพัฒนาคุณภาพการสอน/แก้ปัญหา 
  1) ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : .…………………………………………………………………... 
   
  2) แนวทางพัฒนาคุณภาพวิธีสอน/ส่ือ/การวัดผล/เอกสารช่วยสอน   
       …………….......................................................................................................................................... 
  

                                                      ลงช่ือ 
 

                      (.........................................) 
                                   ครูผู้สอน 
          ………./…………/………… 



 

 
 

 

 
 
 

แผนการจัดการเรียนรู้ หน่วยที่   3 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 5-6 
 

ชื่อหน่วย   เร่ิมต้นใช้งานโปรแกรมผลิตสื่อสิ่งพิมพ์   
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
ในปัจจุบันงานเราจะเห็นงานด้านส่ือส่ิงพิมพ์ต่าง ๆ เช่น นิตยสาร วารสาร โบชัวร์หรือแผ่นพับ และหนังสือ

ประเภทต่าง ๆ  ซึ่งโปรแกรม Adobe Indesign  มีความสามารถในการออกแบบและสร้างสรรค์ผลงานสิ่งพิมพ์
เหล่านี้ได้อย่างรวดเร็วและมีประสิทธิภาพ 

 Adobe Indesign CS6  เป็นโปรแกรมที่ใช้ในการสร้างงานพิมพ์ และได้รับความนิยมมากในปัจจุบัน เรา
จะใช้ในการออกแบบงานด้านส่ือส่ิงพิมพ์ เช่น การจัดองค์ประกอบของงานพิมพ์  การตกแต่งรูปภาพกราฟิกต่าง ๆ 
ให้เกิดความสวยงามดึงดูดใจแก่ผู้ชม โดยจะเสนอในรูปแบบต่าง ๆ เช่น ใบปลิว การ์ด      แผ่นพับ แบนเนอร์สินค้า 
และหนังสือ เป็นต้น 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 

- 
3. สมรรถนะประจำหน่วย  

1.  แสดงความรู้เกี่ยวกับส่วนประกอบของหน้าจอแรกของโปรแกรม Adobe Indesign CS6 ทุก
ส่วนประกอบ 

2.  เลือกใช้แถบคำส่ังตามลักษณะความต้องการใช้งาน 
 3.  ต้ังค่าในหน้าต่างดอคอิวเมนท์ เซตอัพ ทุกค่าอย่างเหมาะสม 

 4.  สร้างไฟล์งานด้วยโปรแกรมอะโดบี อินดีไซน์  
 5.  บันทึก เปิด ปิดและพิมพ์งานทางเครื่องพิมพ์ ด้วยคำส่ังท่ีถูกต้อง 

6.  เตรียมวัสดุอุปกรณ์เหมาะสมกับการปฏิบัติงาน 
7.  เลือกใช้เครื่องมือต่าง ๆ ตามความเหมาะสมในสร้างช้ินงาน 

                8.  แสดงพฤติกรรมความสนใจใฝ่รู้ ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็นประชาธิปไตยและ
ไกลยาเสพติด 

4. จุดประสงค์เชิงพฤติกรรม 
3.1 ด้านความรู้ 

3.1.1 เพื่อให้ความรู้และความเข้าใจเกี่ยวกับส่วนประกอบของหน้าจอแรกของโปรแกรม  
Adobe Indesign CS6 ทุกส่วนประกอบ 

3.1.2 เพื่อให้มีทักษะในการเลือกใช้แถบคำส่ังตามลักษณะความต้องการใช้งาน 
3.1.3 เพื่อให้มีทักษะในการกำหนดค่าในหน้าต่างดอคอิวเมนท์ เซตอัพ 
3.1.4  เพื่อให้มีทักษะการสร้างไฟล์งานด้วยโปรแกรมอะโดบี อินดีไซน์ 
3.1.5 เพื่อให้มีทักษะในการบันทึก เปิด ปิดและพิมพ์งานทางเครื่องพิมพ์ 

3.2 ด้านทักษะ 



 

 
 

3.2.1 อธิบายเกี่ยวกับส่วนประกอบของหน้าจอแรกของโปรแกรม Adobe Indesign  
CS6 ทุกส่วนประกอบได้ 

3.2.2 เลือกใช้แถบคำส่ังตามลักษณะความต้องการใช้งานได้ 
3.2.3 กำหนดค่าในหน้าต่างดอคอิวเมนท์ เซตอัพได้ 
3.2.4 สร้างไฟล์งานด้วยโปรแกรมโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 ได้ 
3.2.5 ทำการบันทึก เปิด ปิดและพิมพ์งานทางเครื่องพิมพ์ได้ 
3.2.6 เพิ่มหน้าเอกสาร ลดหน้าเอกสารและย้ายหน้าเอกสารตามการใช้งานได้ 

 

3.1 คุณลักษณะที่พึงประสงค์ 
3.1.2 ความสนใจใฝ่รู้  
3.1.3 มีความซื่อสัตย์ในการปฏิบัติงาน 
3.1.4 มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
3.1.5 ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

5. สาระการเรียนรู้ 
เริ่มต้นใช้งานโปรแกรมผลิตส่ือส่ิงพิมพ์    

6. กิจกรรมการเรียนรู้ 
6.1 การนำเข้าสู่บทเรียน 

1.ผู้สอนกล่าวทักทายผู้เรียน เนื่องจากเป็นการสอนครั้งแรก   
2.ผู้สอนตรวจสอบรายช่ือผู้เรียน 
3.ผู้สอนบอกจุดประสงค์รายวิชา มาตรฐานรายวิชา และคำอธิบายรายวิชา 
4.ผู้สอนแจกแบบทดสอบก่อนเรียนเพื่อทดสอบผู้เรียน 

7. สื่อและแหล่งเรียนรู้ 
7.1 หนังสือการผลิตส่ือสิงพิมพ์. ประภาวรรณ เกษวิริยะการณ์. สำนักพิมพ์เมืองไทย 
7.2 ส่ือประกอบการเรียน เช่น VDO,  PowerPoint,  YouTube และอุปกรณ์จริง 

8. หลักฐานการเรียนรู้ 
8.1 หลักฐานความรู้           

   คะแนนจากการตอบคำถามท้ายบทเรียน และแบบทดสอบ ในหนังสือประกอบการเรียน  
8.2 หลักฐานการปฏิบัติงาน 

   คะแนนการทำกิจกรรมการเรียนรู้  และภาพถ่ายการทำกิจกรรมของผู้เรียน  
     9. การวัดและการประเมินผล 

9.1 วิธีวัดและการประเมินผล 
1) ทดสอบก่อนเรียนและหลังเรียน 
2) ตรวจใบงาน 
3) ประเมินการนำเสนอผลงาน 
4) สังเกตพฤติกรรม 

9.2 เคร่ืองมือวัดและการประเมินผล 
1) แบบทดสอบก่อนเรียนและหลังเรียน 



 

 
 

2) ใบงาน 
3) แบบประเมินการนำเสนอผลงาน 
4) แบบสังเกตพฤติกรรม 

9.3 เกณฑ์วัดและการประเมินผล 
1) เกณฑ์การทดสอบก่อนเรียนและหลังเรียน คะแนนผ่านไม่ต่ำกว่า 80% 
2) เกณฑ์การประเมินใบงาน คะแนนผ่านไม่ต่ำกว่า 80% 
3) เกณฑ์การประเมินผลการนำเสนอผลงาน คะแนนผ่านไม่ต่ำกว่า 80% 
4) เกณฑ์การสังเกตพฤติกรรม คะแนนผ่านไม่ต่ำกว่า 80% 

 
10.  บันทึกผลหลังการจัดการเรียนรู้ 

 
10.1 ผลการจัดการเรียนรู้ท่ีเกิดขึ้นกับผู้เรียน 

               
               
               

10.2 ปัญหา อุปสรรคท่ีพบ 
               
               
               

10.3 การแก้ไขปัญหา 
1) ผลการแก้ไขปัญหาทีส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

 

ใบความรู้ที่ 3 หน่วยที่   3 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 5-6 
 

ชื่อหน่วย   เร่ิมต้นใช้งานโปรแกรมผลิตสื่อสิ่งพิมพ์   
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
1.  ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

เริ่มต้นใช้งานโปรแกรมผลิตส่ือส่ิงพิมพ์    
2. อ้างอิงมาตรฐาน / เชื่อมโยงกลุ่มอาชีพ (ถ้ามี) 

 -  
9. สมรรถนะประจำหน่วย  

1.  แสดงความรู้เกี่ยวกับส่วนประกอบของหน้าจอแรกของโปรแกรม Adobe Indesign CS6 ทุก
ส่วนประกอบ 

2.  เลือกใช้แถบคำส่ังตามลักษณะความต้องการใช้งาน 
 3.  ต้ังค่าในหน้าต่างดอคอิวเมนท์ เซตอัพ ทุกค่าอย่างเหมาะสม 

 4.  สร้างไฟล์งานด้วยโปรแกรมอะโดบี อินดีไซน์  
 5.  บันทึก เปิด ปิดและพิมพ์งานทางเครื่องพิมพ์ ด้วยคำส่ังท่ีถูกต้อง 

6.  เตรียมวัสดุอุปกรณ์เหมาะสมกับการปฏิบัติงาน 
7.  เลือกใช้เครื่องมือต่าง ๆ ตามความเหมาะสมในสร้างช้ินงาน 

                8.  แสดงพฤติกรรมความสนใจใฝ่รู้ ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็นประชาธิปไตยและ
ไกลยาเสพติด 

10. จุดประสงค์เชิงพฤติกรรม 
3.3 ด้านความรู้ 

3.3.1 เพื่อให้ความรู้และความเข้าใจเกี่ยวกับส่วนประกอบของหน้าจอแรกของโปรแกรม  
Adobe Indesign CS6 ทุกส่วนประกอบ 

3.3.2 เพื่อให้มีทักษะในการเลือกใช้แถบคำส่ังตามลักษณะความต้องการใช้งาน 
3.3.3 เพื่อให้มีทักษะในการกำหนดค่าในหน้าต่างดอคอิวเมนท์ เซตอัพ 
3.3.4  เพื่อให้มีทักษะการสร้างไฟล์งานด้วยโปรแกรมอะโดบี อินดีไซน์ 
3.3.5 เพื่อให้มีทักษะในการบันทึก เปิด ปิดและพิมพ์งานทางเครื่องพิมพ์ 

3.4 ด้านทักษะ 
3.4.1 อธิบายเกี่ยวกับส่วนประกอบของหน้าจอแรกของโปรแกรม Adobe Indesign  

CS6 ทุกส่วนประกอบได้ 
3.4.2 เลือกใช้แถบคำส่ังตามลักษณะความต้องการใช้งานได้ 
3.4.3 กำหนดค่าในหน้าต่างดอคอิวเมนท์ เซตอัพได้ 
3.4.4 สร้างไฟล์งานด้วยโปรแกรมโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 ได้ 
3.4.5 ทำการบันทึก เปิด ปิดและพิมพ์งานทางเครื่องพิมพ์ได้ 



 

 
 

3.4.6 เพิ่มหน้าเอกสาร ลดหน้าเอกสารและย้ายหน้าเอกสารตามการใช้งานได้ 
 

3.2 คุณลักษณะที่พึงประสงค์ 
3.2.2 ความสนใจใฝ่รู้  
3.2.3 มีความซื่อสัตย์ในการปฏิบัติงาน 
3.2.4 มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
3.2.5 ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

5. เนือ้หาสาระ 
 โปรแกรมอโดบี อินดีไซน์ เป็นโปรแกรมสำหรับสร้างงานด้านส่ือส่ิงพิมพ์ เพราะเป็น 
โปรแกรมที่มีความละเอียดสูง ใช้สำหรับจัดทำสื่อสิ ่งพิมพ์ประเภทต่าง ๆ เช่น หนังสือ หนังสือพิมพ์นิตยสาร 
วารสาร  โบรชัวร์  เป็นต้น 
         ระบบการทำงานของโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 นั้น ผู้ใช้ไม่สามารถใช้เด่ียว ๆ ได้  
ต้องมีความรู้พื้นฐานของโปรแกรมโฟโทช็อป และโปรแกรมอิลัสเทรเทอร์ เพราะต้องมีการเตรียมรูปภาพจาก
โปรแกรมโฟโทช็อป  และเตรียมคลิปอาร์ท หรือโลโกต่าง ๆ มาจากอิลัสเทรเทอร์ ส่วนข้อความสามารถเตรียมมา
จากโปรแกรมประเภทเวิร ์ดโพรเซสซิ่ง แล้วจึงนำมาประกอบรวมกันเป็นหนังสือ หรือแผ่นพับ  ต่าง ๆ  ใน
โปรแกรมอโดบี อินดีไซน์ 
  

4.1 ส่วนประกอบต่าง ๆ ของโปรแกรมอโดบี อินดีไซน์ ซีเอส6 
 1. แถบคำส่ัง (Menu Bar) เก็บคำส่ังหลักและคำส่ังย่อยของโปรแกรม 
 2. แถบคอนโทรลพาเนล (Control Panel) ใช้สำหรับกำหนดคุณสมบัติของวัตถุและข้อความ  
 3. ปุ่มควบคุมการทำงาน ปิด ย่อ/ขยาย หน้าต่าง 
 4. ปุ่มเรียกใช้งานโปรแกรมอโดบีบริดจ์ (Adobe Bridge) 
 5. กล่องเครื่องมือ (Toolbox) เก็บเครื่องมือท่ีใช้ในการสร้าง ปรับแต่ง แก้ไขภาพและข้อความ 
 6. อาร์ตบอร์ด (Artboard) พื้นท่ีการทำงาน 
 7. ดอคพาเนล (Dock Panel) พาเนลต่าง ๆ ท่ีรวบรวมคุณสมบัติการทำงาน 
 

4.2 การต้ังค่าในหน้าต่างดอคอิวเมนท์ เซตอัพ 
  1. ดอคอ ิ ว เมนท ์  พร ี เซต  (Document Preset) ผ ู ้ ใช ้ สามารถ เล ื อกกำหนด การต ั ้ ง ค ่ า 
หน้าเอกสารได้จากหน้าต่างดอคอิวเมนท์ พรีเซต มีให้เลือก 2 รูปแบบ คือ 
   (1)  การกำหนดค่าดอคอิวเมนท์ พรีเซต แบบที่กำหนดไว้แล้วในโปรแกรม (Default) เช่น การ
กำหนดจำนวนหน้ากระดาษ ขนาดกระดาษ จำนวนคอลัมน์ และระยะขอบกระดาษ เป็นต้น 
   (2) การกำหนดค่าแบบกำหนดเอง (Custom) เป็นการกำหนดค่าหน้าเอกสารใหม่ตามความ
ต้องการของผู้ใช้  
 

 2. นัมเบอร์ ออฟ เพจ (Number of Pages) กำหนดจำนวนหน้าในเอกสาร 
 3. สตาร์ต เพจ นัมเบอร์ (Start Page No.) หมายเลขหน้าเอกสารท่ีต้องการเริ่มต้น 
 4. เฟชช่ิง เพจ (Facing Page) กำหนดการแสดงรูปแบบของหน้ากระดาษหน้าค่ีหรือหน้าคู่ 

 5. มาสเตอร์ เท็กซ์ เฟรม (Master Text Frame) กำหนดกรอบข้อความในหน้ามาสเตอร์เพจ 
(Master Page) 
  6. เพจไซส์ (Page Size) กำหนดขนาดของหน้ากระดาษ 



 

 
 

 7. คอลัมน์ (Columns) การแบ่งพื้นท่ีบนกระดาษออกเป็นส่วน ๆ ตามแนวตั้ง 
  (1)  นัมเบอร์ (Number) จำนวนพื้นท่ีบนกระดาษท่ีแบ่งเป็นส่วน ๆ 
  (2)  กัตเตอร์ (Gutter) ช่องว่างระหว่างการแบ่งแนว หรือช่องว่างระหว่างคอลัมน์ 
   8. มาร์จินส์ (Margins) กำหนดระยะขอบหน้ากระดาษ 

4.3 การสร้างไฟล์งาน 
การสร้างไฟล์งานด้วยโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 สามารถสร้างไฟล์งานได้ ดังนี้ 

การสร้างไฟล์งานจากดอกยะเมินท เซทอัพ ผู้ใช้สามารถกำหนดค่าต่าง ๆ และรูปแบบของช้ินงานตามท่ีผู้ใช้
ต้องการ เช่น การกำหนดค่าระยะขอบกระดาษ แนววางกระดาษ   

การสร้างไฟล์งานจากดอกยะเมินท เซทอัพ ผู้ใช้สามารถกำหนดค่าต่าง ๆ และรูปแบบของ 
ช้ินงานตามท่ีผู้ใช้ต้องการ เช่น การกำหนดค่าระยะขอบกระดาษ แนววางกระดาษ เป็นต้น  
 

4.4  การบันทึกไฟล์งาน 
 เมื่อมีการสร้างไฟล์งาน ผู้ใช้ย่อมมีความจำเป็นท่ีจะต้องบันทึกไฟล์งาน (Save) เพื่อเก็บไว้ใช้ในครั้ง
ต่อไป หรือแจกจ่ายต้นฉบับของไฟล์งานไปยังบุคคลอื่น การบันทึกไฟล์งานจึงมีความสำคัญในการทำงานทุกครั้ง 
ซึ่งในการบันทึกไฟล์งานผู้ใช้สามารถปฏิบัติได้ดังนี้ 
   1. เลือกคำส่ังไฟล์บนแถบเมนู มีคำส่ังการบันทึก 2 คำส่ัง ได้แก่ 
    (1)  บันทึก (Save) ใช้ในการบันทึกไฟล์ งานในชื่อเดิมที่ผู้ใช้เรียกมาแก้ไข แล้วบันทึกในช่ือ
เดิมหรือการบันทึกไฟล์งานเป็นครั้งแรก 
  (2)  บันทึกแฟ้มเป็น (Save as) ใช้ในการบันทึกไฟล์งานเป็นครั้งแรก บันทึกไฟล์งานเดิมเป็นช่ือใหม่
หรือบันทึกในรูปแบบของฟอร์แมตใหม่ 
4.5  การเพิ่มและลดจำนวนหน้า 
 การเพิ่มจำนวนหน้าเอกสารในไฟล์ มีข้ันตอนดังนี้ 

1. เลือกคำส่ังไฟล์ (File) > ดอคอิวเมนท์ เซตอัพ (Document Setup) 
2. ปรากฏหน้าต่างดอคอิวเมนท์ เซตอัพ เพื่อเพิ่มจำนวนหน้าตามท่ีต้องการในตำแหน่ง 

ของ นัมเบอร์ ออฟ เพจ (Number of Pages) 
 3. คลิกปุ่มตกลง 
 

4.6  การลบจำนวนหน้าเอกสาร 
           1. คลิกท่ีแถบเมนูเลือกคำส่ังเลย์เอาต์ > เพจ > ดีลีทเพลจ (Layout > Pages > Delete Pages) 
      2.  ปรากฏหน้าต่างดีลีทเพจ กำหนดเลขหน้าเอกสารท่ีต้องการลบ (Delete Pages) 
 
 
 
 
 
 
 
 
 



 

 
 

6. แบบทดสอบ/แบบฝึกหัด 
จากโจทย์คำถาม จงเลือกคำตอบที่ถูกต้องที่สุด 

แบบฝึกหัดหน่วยที่ 3 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. สัญลักษณ์ในข้อใดเป็นสัญลักษณ์การเข้าสู่โปรแกรมอโดบี อินดีไซน์ ซีเอส 6 

  ก.  ข.  
  ค.  ง.   
2. ข้อใดไม่เกี่ยวข้องกับการออกจากโปรแกรม 
  ก.   
  ข.  คำส่ัง Exit 
  ค.  คอนโทรล+คิว (Ctrl + Q) 
  ง.  คอนโทรล+ดับเบิ้ลยู (Ctrl + W) 
3. ข้อใดอธิบายหน้าท่ีของคอนโทรลพาเนลในโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 ได้ถูกต้อง 
 ก. เป็นการเก็บคำส่ังย่อยไว้เป็นหมวดหมู่ 
 ข. เป็นการกำหนดคุณสมบัติของวัตถุและข้อความ 
 ค. ใช้ในการเก็บคำส่ังหลักเพื่อสะดวกในการเรียกใช้งาน 
 ง. เป็นแหล่งเก็บเครื่องมือท่ีใช้ในการปรับแต่งแก้ไขภาพและข้อความ 
4. อาร์ตบอร์ดมีความสำคัญในการใช้งานโปรแกรมอโดบีอินดีไซน์ ซีเอส 6 อย่างไร 
 ก.  ใช้เป็นพื้นท่ีการทำงานของโปรแกรม 
 ข.  เป็นพื้นท่ีรวบรวมพาเนลท้ังหมด 
 ค.  เป็นพื้นท่ีรวบรวมเครื่องมือทุกชนิด 
 ง.  พื้นท่ีเก็บคำส่ังหลักและคำส่ังย่อย 
5. การกำหนดหน้ากระดาษในการพิมพ์เป็น Sequence : Even Pages Only คือการกำหนดหน้ากระดาษ
 ลักษณะใด 
 ก.  กำหนดหน้ากระดาษท้ังหมด 
 ข. กำหนดหน้ากระดาษหน้าค่ี 
 ค.  กำหนดหน้ากระดาษหน้าคู่ 
 ง.  กำหนดหน้ากระดาษเฉพาะเลขหน้าท่ีกำหนด 

 
 
 
 
 
 
 
 

 
 



 

 
 

 
7.  เอกสารอ้างอิง (ขึ้นหน้าใหม่) 
วิชาการผลิตสื่อดิจิทัล 
8.ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ) 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. สัญลักษณ์ในข้อใดเป็นสัญลักษณ์การเข้าสู่โปรแกรมอโดบี อินดีไซน์ ซีเอส 6 

  ก.  ข.  
  ค.  ง.   
2. ข้อใดไม่เกี่ยวข้องกับการออกจากโปรแกรม 
  ก.   
  ข.  คำส่ัง Exit 
  ค.  คอนโทรล+คิว (Ctrl + Q) 
  ง.  คอนโทรล+ดับเบิ้ลยู (Ctrl + W) 
3. ข้อใดอธิบายหน้าท่ีของคอนโทรลพาเนลในโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 ได้ถูกต้อง 
 ก. เป็นการเก็บคำส่ังย่อยไว้เป็นหมวดหมู่ 
 ข. เป็นการกำหนดคุณสมบัติของวัตถุและข้อความ 
 ค. ใช้ในการเก็บคำส่ังหลักเพื่อสะดวกในการเรียกใช้งาน 
 ง. เป็นแหล่งเก็บเครื่องมือท่ีใช้ในการปรับแต่งแก้ไขภาพและข้อความ 
4. อาร์ตบอร์ดมีความสำคัญในการใช้งานโปรแกรมอโดบีอินดีไซน์ ซีเอส 6 อย่างไร 
 ก.  ใช้เป็นพื้นท่ีการทำงานของโปรแกรม 
 ข.  เป็นพื้นท่ีรวบรวมพาเนลท้ังหมด 
 ค.  เป็นพื้นท่ีรวบรวมเครื่องมือทุกชนิด 
 ง.  พื้นท่ีเก็บคำส่ังหลักและคำส่ังย่อย 
5. การกำหนดหน้ากระดาษในการพิมพ์เป็น Sequence : Even Pages Only คือการกำหนดหน้ากระดาษ
 ลักษณะใด 
 ก.  กำหนดหน้ากระดาษท้ังหมด 
 ข. กำหนดหน้ากระดาษหน้าค่ี 
 ค.  กำหนดหน้ากระดาษหน้าคู่ 
 ง.  กำหนดหน้ากระดาษเฉพาะเลขหน้าท่ีกำหนด 
 
 
 
 
 
 
 
 
 



 

 
 

 
 

 

ใบงานที่ 3 หน่วยที่   3 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 5-6 
 

ชื่อหน่วย   เร่ิมต้นใช้งานโปรแกรมผลิตสื่อสิ่งพิมพ์   
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
ใบงานที่  3 

คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. สัญลักษณ์ในข้อใดเป็นสัญลักษณ์การเข้าสู่โปรแกรมอโดบี อินดีไซน์ ซีเอส 6 

  ก.  ข.  
  ค.  ง.   
2. ข้อใดไม่เกี่ยวข้องกับการออกจากโปรแกรม 
  ก.   
  ข.  คำส่ัง Exit 
  ค.  คอนโทรล+คิว (Ctrl + Q) 
  ง.  คอนโทรล+ดับเบิ้ลยู (Ctrl + W) 
3. ข้อใดอธิบายหน้าท่ีของคอนโทรลพาเนลในโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 ได้ถูกต้อง 
 ก. เป็นการเก็บคำส่ังย่อยไว้เป็นหมวดหมู่ 
 ข. เป็นการกำหนดคุณสมบัติของวัตถุและข้อความ 
 ค. ใช้ในการเก็บคำส่ังหลักเพื่อสะดวกในการเรียกใช้งาน 
 ง. เป็นแหล่งเก็บเครื่องมือท่ีใช้ในการปรับแต่งแก้ไขภาพและข้อความ 
4. อาร์ตบอร์ดมีความสำคัญในการใช้งานโปรแกรมอโดบีอินดีไซน์ ซีเอส 6 อย่างไร 
 ก.  ใช้เป็นพื้นท่ีการทำงานของโปรแกรม 
 ข.  เป็นพื้นท่ีรวบรวมพาเนลท้ังหมด 
 ค.  เป็นพื้นท่ีรวบรวมเครื่องมือทุกชนิด 
 ง.  พื้นท่ีเก็บคำส่ังหลักและคำส่ังย่อย 
5. การกำหนดหน้ากระดาษในการพิมพ์เป็น Sequence : Even Pages Only คือการกำหนดหน้ากระดาษ
 ลักษณะใด 
 ก.  กำหนดหน้ากระดาษท้ังหมด 
 ข. กำหนดหน้ากระดาษหน้าค่ี 
 ค.  กำหนดหน้ากระดาษหน้าคู่ 
 ง.  กำหนดหน้ากระดาษเฉพาะเลขหน้าท่ีกำหนด 

 
 
 
 
 



 

 
 

 
 

บันทึกผลหลังการจัดการเรียนรู้ 
 

 ผลการจัดการเรียนรู้ตามแผนการสอน 
  1) วัน เดือน ปี ...............สอนครั้งท่ี .../.... สาขา/ช้ันปี  .....................จำนวนผู้เรียน..........คน    
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน 

2) หัวข้อเรื่อง/เนื้อหาสาระ :  ........................................................................................................... 
  ❑ สอนครบตามหัวข้อเรื่องในแผนฯ  ❑ สอนไม่ครบเนื่องจาก........................................ 
  3) กิจกรรม/วิธีการสอน 
   ❑ ครูแนะนำและบอกจุดประสงค์     ❑ ครูอธิบาย/ถาม-ตอบ/สาธิต/ 
   ❑ ทำแบบทดสอบก่อนเรียน      ❑ ทำแบบทดสอบหลังเรียน 
   ❑ ทำแบบฝึกหัด/โจทย์ปัญหา      ❑ ทำใบกิจกรรม/ใบงาน 
   ❑ อื่น ๆ (ระบ)ุ................................................................................................................... 
  4) ส่ือการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………………….......... 
  ....................................................................................................................................................... 
 11.2 ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาที่พบ 
  1) การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ………………………………………………..…….. 
       ........................................................................................................................................................ 
  2) สมรรถนะท่ีผู้เรียนได้รับ : .......................................................................................................... 
      .......................................................................................................................................................... 
  3) สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..…………………………………………………………..…..... 
      ……………....................................................................................................................................... 
  4) ผลการสอนของครู : ..……………………………………………………………………………………..…….……. 
      ……………........................................................................................................................................... 
  5) ปัญหาท่ีนำไปสู่การวิจัย : ..………………………………………………………………………………..….……... 
 11.3 แนวทางการพัฒนาคุณภาพการสอน/แก้ปัญหา 
  1) ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : .…………………………………………………………………... 
   
  2) แนวทางพัฒนาคุณภาพวิธีสอน/ส่ือ/การวัดผล/เอกสารช่วยสอน   
       …………….......................................................................................................................................... 
  

                                                      ลงช่ือ 
 

                      (.........................................) 
                                   ครูผู้สอน 
          ………./…………/………… 



 

 
 

 

 
 
 

แผนการจัดการเรียนรู้ หน่วยที่   4 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 7-8 
 

ชื่อหน่วย  การสร้างข้อความเพื่อผลิตสื่อสิ่งพิมพ์   
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
การทำงานกับข้อความ เป็นส่วนที่สำคัญอย่างมากในการสร้างงานพิมพ์  โดยเริ่มเรียนรู้ตั้งแต่การสร้าง

ข้อความ  และการทำงานกับข้อความท่ีสร้างไว้  โดยรูปแบบของข้อความใน Indesign CS6 มีอยู่ 2  ประเภท คือ  
Text  block  และ  Text frame  โดยท่ีข้อความท้ัง 2  รูปแบบมีคุณสมบัติท่ีแตกต่างกัน 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 

- 
3. สมรรถนะประจำหน่วย  

1.  แสดงความรู้เกี่ยวกับรูปแบบของข้อความท่ีใช้ในโปรแกรม Indesign CS6   
  2.  สร้างข้อความในรูปแบบของ Text block และ Text frame ตามวัตถุประสงค์การทำงาน 
  3.  สร้างเส้น  path  จากเครื่องมือใน Toolbox ตามความเหมาะสม 
  4.  สร้างข้อความตามแนวเส้น path และตกแต่งเหมาะสมกับช้ินงาน 

5.  กำหนดการไหลของข้อความตามตำแหน่งท่ีต้องการ 
6.  ปรับแต่งตัวอักษรจากพาเนล Character 
7.  ปรับแต่งตัวอักษรจากคอนโทรลพาเนล 
8.  แสดงพฤติกรรมความสนใจใฝ่รู้  ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็น 

ประชาธิปไตย และห่างไกลยาเสพติด 

4. จุดประสงค์เชิงพฤติกรรม 
3.1 ด้านความรู้ 

3.1.1 เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับรูปแบบของข้อความท่ีใช้ในโปรแกรม       
Indesign CS6   
  3.1.2  เพื่อให้มีทักษะในการสร้างข้อความในรูปแบบของ Text block และ Text frame  
ตามวัตถุประสงค์การทำงาน 
  3.1.3  เพื่อให้มีทักษะในการสร้างเส้น path จากเครื่องมือใน Toolbox ตามความ 
เหมาะสม 

3.1.4 เพื่อให้มีทักษะในการสร้างข้อความตามแนวเส้น path และตกแต่งเหมาะสมกับ 
ช้ินงาน 



 

 
 

  3.1.5  เพื่อให้มีทักษะในการกำหนดการไหลของข้อความตามตำแหน่งท่ีต้องการ 
  3.1.6  เพื่อให้มีทักษะในการปรับแต่งตัวอักษรจากพาเนล Character 
  3.1.7  เพื่อให้มีทักษะในการปรับแต่งตัวอักษรจากคอนโทรลพาเนล 
 

3.2 ด้านทักษะ 
3.2.1 อธิบายเกี่ยวกับรูปแบบของข้อความท่ีใช้ในโปรแกรม  Indesign CS6 ได้ 
3.2.2 สร้างข้อความในรูปแบบของ Text block และ Text frame ตามวัตถุประสงค์การ       

ทำงานได้ 
3.2.3 สร้างเส้น  path  จากเครื่องมือใน Toolbox ตามความเหมาะสมได้ 
3.2.4 สร้างข้อความตามแนวเส้น path และตกแต่งเหมาะสมกับช้ินงานได้ 
3.2.5 กำหนดการไหลของข้อความตามตำแหน่งท่ีต้องการได้ 
3.2.6 ปรับแต่งตัวอักษรจากพาเนล Characterได้ 
3.2.7 ปรับแต่งตัวอักษรจากคอนโทรลพาเนลได้ 

 

3.3 คุณลักษณะที่พึงประสงค์ 
3.3.1 ความสนใจใฝ่รู้  
3.3.2 มีความซื่อสัตย์ในการปฏิบัติงาน 
3.3.3 มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
3.3.4 ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

 

5. สาระการเรียนรู้ 
การสร้างข้อความเพื่อผลิตส่ือส่ิงพิมพ์   

6. กิจกรรมการเรียนรู้ 
6.1 การนำเข้าสู่บทเรียน 

1.ผู้สอนกล่าวทักทายผู้เรียน เนื่องจากเป็นการสอนครั้งแรก   
2.ผู้สอนตรวจสอบรายช่ือผู้เรียน 
3.ผู้สอนบอกจุดประสงค์รายวิชา มาตรฐานรายวิชา และคำอธิบายรายวิชา 
4.ผู้สอนแจกแบบทดสอบก่อนเรียนเพื่อทดสอบผู้เรียน 

7. สื่อและแหล่งเรียนรู้ 
7.1 หนังสือการผลิตส่ือสิงพิมพ์. ประภาวรรณ เกษวิริยะการณ์. สำนักพิมพ์เมืองไทย 
7.2 ส่ือประกอบการเรียน เช่น VDO,  PowerPoint,  YouTube และอุปกรณ์จริง 

8. หลักฐานการเรียนรู้ 
8.1 หลักฐานความรู้           

   คะแนนจากการตอบคำถามท้ายบทเรียน และแบบทดสอบ ในหนังสือประกอบการเรียน  
8.2 หลักฐานการปฏิบัติงาน 



 

 
 

   คะแนนการทำกิจกรรมการเรียนรู้  และภาพถ่ายการทำกิจกรรมของผู้เรียน  
     9. การวัดและการประเมินผล 

9.1 วิธีวัดและการประเมินผล 
1) ทดสอบก่อนเรียนและหลังเรียน 
2) ตรวจใบงาน 
3) ประเมินการนำเสนอผลงาน 
4) สังเกตพฤติกรรม 

9.2 เคร่ืองมือวัดและการประเมินผล 
1) แบบทดสอบก่อนเรียนและหลังเรียน 
2) ใบงาน 
3) แบบประเมินการนำเสนอผลงาน 
4) แบบสังเกตพฤติกรรม 

9.3 เกณฑ์วัดและการประเมินผล 
1) เกณฑ์การทดสอบก่อนเรียนและหลังเรียน คะแนนผ่านไม่ต่ำกว่า 80% 
2) เกณฑ์การประเมินใบงาน คะแนนผ่านไม่ต่ำกว่า 80% 
3) เกณฑ์การประเมินผลการนำเสนอผลงาน คะแนนผ่านไม่ต่ำกว่า 80% 
4) เกณฑ์การสังเกตพฤติกรรม คะแนนผ่านไม่ต่ำกว่า 80% 

 
10.  บันทึกผลหลังการจัดการเรียนรู้ 

 
10.1 ผลการจัดการเรียนรู้ท่ีเกิดขึ้นกับผู้เรียน 

               
               
               

10.2 ปัญหา อุปสรรคท่ีพบ 
               
               
               

10.3 การแก้ไขปัญหา 
1) ผลการแก้ไขปัญหาทีส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
 
 
 
 



 

 
 

 

ใบความรู้ที่ 4 หน่วยที่   4 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 7-8 
 

ชื่อหน่วย  การสร้างข้อความเพื่อผลิตสื่อสิ่งพิมพ์   
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
1.  ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
การสร้างข้อความเพื่อผลิตส่ือส่ิงพิมพ์   
2. อ้างอิงมาตรฐาน / เชื่อมโยงกลุ่มอาชีพ (ถ้ามี) 

 -  
-3.สมรรถนะประจำหน่วย  

1.  แสดงความรู้เกี่ยวกับรูปแบบของข้อความท่ีใช้ในโปรแกรม Indesign CS6   
  2.  สร้างข้อความในรูปแบบของ Text block และ Text frame ตามวัตถุประสงค์การทำงาน 
  3.  สร้างเส้น  path  จากเครื่องมือใน Toolbox ตามความเหมาะสม 
  4.  สร้างข้อความตามแนวเส้น path และตกแต่งเหมาะสมกับช้ินงาน 

5.  กำหนดการไหลของข้อความตามตำแหน่งท่ีต้องการ 
6.  ปรับแต่งตัวอักษรจากพาเนล Character 
7.  ปรับแต่งตัวอักษรจากคอนโทรลพาเนล 
8.  แสดงพฤติกรรมความสนใจใฝ่รู้  ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็น 

ประชาธิปไตย และห่างไกลยาเสพติด 

4.จุดประสงค์เชิงพฤติกรรม 
3.2 ด้านความรู้ 

3.2.1 เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับรูปแบบของข้อความท่ีใช้ในโปรแกรม       
Indesign CS6   
  3.1.2  เพื่อให้มีทักษะในการสร้างข้อความในรูปแบบของ Text block และ Text frame  
ตามวัตถุประสงค์การทำงาน 
  3.1.3  เพื่อให้มีทักษะในการสร้างเส้น path จากเครื่องมือใน Toolbox ตามความ 
เหมาะสม 

3.2.4 เพื่อให้มีทักษะในการสร้างข้อความตามแนวเส้น path และตกแต่งเหมาะสมกับ 
ช้ินงาน 
  3.1.5  เพื่อให้มีทักษะในการกำหนดการไหลของข้อความตามตำแหน่งท่ีต้องการ 
  3.1.6  เพื่อให้มีทักษะในการปรับแต่งตัวอักษรจากพาเนล Character 
  3.1.7  เพื่อให้มีทักษะในการปรับแต่งตัวอักษรจากคอนโทรลพาเนล 
 



 

 
 

3.3 ด้านทักษะ 
3.3.5 อธิบายเกี่ยวกับรูปแบบของข้อความท่ีใช้ในโปรแกรม  Indesign CS6 ได้ 
3.3.6 สร้างข้อความในรูปแบบของ Text block และ Text frame ตามวัตถุประสงค์การ       

ทำงานได้ 
3.3.7 สร้างเส้น  path  จากเครื่องมือใน Toolbox ตามความเหมาะสมได้ 
3.3.8 สร้างข้อความตามแนวเส้น path และตกแต่งเหมาะสมกับช้ินงานได้ 
3.3.9 กำหนดการไหลของข้อความตามตำแหน่งท่ีต้องการได้ 
3.3.10 ปรับแต่งตัวอักษรจากพาเนล Characterได้ 
3.3.11 ปรับแต่งตัวอักษรจากคอนโทรลพาเนลได้ 

 

3.4 คุณลักษณะที่พึงประสงค์ 
3.4.1 ความสนใจใฝ่รู้  
3.4.2 มีความซื่อสัตย์ในการปฏิบัติงาน 
3.4.3 มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
3.4.4 ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

5. เนือ้หาสาระ 
 ตัวอักษรเป็นองค์ประกอบอย่างหนึ่งในส่ือส่ิงพิมพ์ท่ีแตกต่างไปจากองค์ประกอบอื่น ๆ การใช้ 
ตัวอักษรสามารถบอกเล่าเรื่องราวต่าง ๆ ให้ผู้อ่านได้โดยตรงไม่ต้องแปลความหมายเหมือนกับองค์ประกอบอื่น 
ตัวอักษรสามารถตกแต่งได้ด้วยรูปแบบ ขนาดสีสันและการจัดวางในรูปแบบต่าง ๆ กันเพื่อสร้างความน่าสนใจ และ
น่าติดตาม นอกจากนี้ตัวอักษรยังเป็นส่ือกลางในการติดต่อส่ือสารระหว่างกัน โดยผ่านการอ่านหรือบันทึกเรื่องราว 
มีการนำตัวอักษรมาประยุกต์ใช้ร่วมกับคอมพิวเตอร์ด้วยกระบวนการเรียบเรียง ประมวลผลและนำมาใช้ในการ
จัดทำส่ือส่ิงพิมพ์ เช่น รายงาน แบบฟอร์ม หนังสือ เป็นต้น  
1. การสร้างข้อความ 
 การสร้างข้อความในโปรแกรมอะโดบี อินดีไซน์ ซีเอส 6  ผู้ใช้สามารถสร้างข้อความได้ 2 ประเภท คือ 

1.1  ข้อความแบบเท็กซ์บลอค (Text  Block) 
 ข้อความแบบเท็กซ์บลอค เป็นประเภทข้อความท่ีสร้างจากเครื่องมือไทป์ทูล            

(Type Tool)  จากกล่องเครื่องมือสำหรับพิมพ์บนพื้นท่ีการทำงานบนอาร์ตบอร์ด (Art Board)   และเครื่องมือ
ไทป์ออนอะพาธทูล          (Type on a Path Tool) สำหรับสร้างข้อความบนเส้นพาธ (Path) 

1.2  ข้อความแบบเท็กซ์เฟรม (Text frame ) 
 ข้อความแบบเท็กซ์เฟรม  เป็นการสร้างข้อความให้อยู่ภายในเฟรม  ในการสร้าง 

ข้อความประเภทนี้จะสร้างเฟรมก่อน การสร้างข้อความสามารถสร้างได้จากเครื่องมือไทป์ทูลและ ไทป์ออนอะพาธ
ทูล  เช่นเดียวกับเท็กซ์บลอค  
  ในการสร้างข้อความแบบเท็กซ์เฟรม ผู้ใช้ต้องสร้างเฟรมข้ึนก่อนพิมพ์จะพิมพ์ข้อความ รูปแบบ
ของเฟรม ดังนี ้



 

 
 

 1.2.1     เรคแทงเกิล เฟรมทูล (Rectangle Frame Tool) 
        เฟรมรูปส่ีเหล่ียม 
 1.2.2          อิลลิปส์ เฟรมทูล (Ellipse Frame Tool)    
 เฟรมรูปวงกลมหรือวงร ี
 1.2.3          โพลีกอน เฟรมทูล (Polygon Frame Tool) 
        เฟรมรูปหลายเหล่ียม 
2. การไหลของข้อความ 
 การไหลของข้อความ คือ เมื ่อมีการนำไฟล์งานหรือข้อความจากโปรแกรมอื ่นเข้ามาวางใน
โปรแกรมอะโดบี อินดีไซน์ ซีเอส 6  แล้วปรากฏว่าไฟล์งานหรือข้อความนั้นมีความยาวมากกว่าหน้ากระดาษ ทำให้
ไม่สามารถแสดงข้อความทั้งหมดในหน้าเดียวได้ มีข้อความบางส่วนที่ถูกซ่อนไว้ โดยจะสังเกตได้จากเครื่องหมาย       
บนกรอบข้อความ  
 

3.  เคร่ืองมือปรับแต่งตัวอักษรและข้อความ 
 ในการปรับแต่งตัวอักษรและข้อความ เช่น การกำหนดรูปแบบตัวอักษร ลักษณะตัวอักษร  
ขนาดตัวอักษร ระยะห่างระหว่างบรรทัด ตัวอักษรตัวบน ตัวห้อย เป็นต้น ด้วยการใช้เครื่องมือท่ีโปรแกรม     อะ
โดบี อินดีไซน์ ซีเอส 6 มีไว้เพื่ออำนวยความสะดวกให้แก่ผู้ใช้ให้สามารถใช้งานได้ง่ายยิ่งขึ้น 

3.1  พาเนลชาแรคเตอร์  (Panel Character) 
 3.2  คอนโทรลพาเนล  (Control Panel) 

การปรับแต่งตัวอักษรหรือข้อความ นอกจากท่ีผู้ใช้จะสามารถใช้เครื่องมือพาเนล ชาแรคเตอร์แล้ว ใน
โปรแกรมอะโดบี อินดีไซน์ ซีเอส 6 ยังมีเครื่องมือท่ีอำนวยความสะดวกให้แก่ผู้ใช้อีกหนึ่งเครื่องมือ คือคอนโทรล
พาเนล ซึ่งผู้ใช้สามารถเลือกใช้ในการปรับแต่งตัวอักษรหรือข้อความได้ 

 

4.  การจัดตำแหน่งข้อความ 
 การทำงานเกี่ยวกับการสร้างข้อความ นอกจากจะสามารถปรับเปลี่ยนรูปแบบข้อความ ขนาด  หรือ
ลักษณะอื่น ๆ แล้ว  โปรแกรมอะโดบีอินดีไซน์ ซีเอส 6  ยังจะช่วยให้ผู ้ใช้โปรแกรมสามารถจัดตำแหน่งของ
ข้อความให้จัดเรียงตามแนวที่ผู้ใช้ต้องการได้  เช่น การจัดตำแหน่งข้อความชิดซ้าย การจัดตำแหน่งข้อความชิดขวา  
จัดตำแหน่งความเหยียดเต็มทุกบรรทัด เป็นต้น 

เครื่องมือท่ีจะช่วยผู้ใช้ในการจัดตำแหน่งข้อความคือ พาเนลพารากราฟ (Paragraph Panel )  
และ คอนโทรลพาเนล (Control Panel)  โดยการคลิกที่ไอคอนพารากราฟ         เพื่อแสดงเครื่องมือในการ
ควบคุมรูปแบบการจัดตำแหน่งข้อความ (Paragraph Formatting Controls 
 
 
 
 
 



 

 
 

6. แบบทดสอบ/แบบฝึกหัด 
จากโจทย์คำถาม จงเลือกคำตอบที่ถูกต้องที่สุด 

แบบฝึกหัดหน่วยที่ 4 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. ข้อใดเป็นเครื่องมือในการสร้างข้อความ 
 ก. ไทป์ทูล (Type Tool) 
  ข.  เพนเซิลทูล (Pencil Tool) 
  ค.  เพนทูล  (Pen Tool) 
        ง.  เรคแทงเกิลทูล (Rectangle Tool) 
2. ส่วนของเนื้อเรื่องนิยมใช้ตัวพิมพ์ขนาดเท่าใด 
 ก.  30 พอยต์ ขึ้นไป จะง่ายต่อการอ่าน 
 ข.  25–30 พอยต์ และมีความหนา 
 ค.  20 พอยต์ มีขนาดเท่า ๆ กับหัวเรื่อง 
 ง.  14–16 พอยต์ ขนาดไม่เล็กหรือใหญ่เกินไป 
3. ข้อใดเป็นลักษณะการใช้เครื่องมือไทป์ออนอะพาธทูล (Type on a path tool) ท่ีต่างจากไทป์ทูล 
 ก. ชนิดของตัวอักษรท่ีใช้แตกต่างกัน 
 ข.  ไทป์ทูลใช้สร้างข้อความบนเส้นพาธ 
 ค.  ไทป์ออนอะพาธทูลใช้สร้างข้อความบนเส้นพาธ 
 ง.  ไทป์ทูลใช้ร่วมกับเพนทูล และไทป์ออนอะพาธทูลใช้ร่วมกับเพนเซิลทูล   
4. ข้อใดเป็นคำส่ังท่ีใช้ในการนำไฟล์จากโปรแกรมอื่นเข้ามาใช้งานในโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 
 ก.  ไฟล์ > เพลส (File > Place) 
 ข.  ไฟล์ > อิมพอร์ท (File > Import) 
 ค.  เอดิท > เพลส (Edit > Place) 
 ง.  เอดิท > อิมพอร์ท (Edit > Import) 
5.  สัญลักษณ์ข้างต้น มีความหมายตรงกับข้อใด 
 ก.  การเพิ่มหน้าเอกสาร ข.  การคัดลอกงานข้ามไฟล์ 
 ค.  มีข้อความท่ีเป็นตารางถูกซ่อนไว ้ ง.  มีข้อความบางส่วนถูกซ่อนไว ้

 
 
 
 
 
 
 
 

 
 
 
 



 

 
 

7.  เอกสารอ้างอิง (ขึ้นหน้าใหม่) 
วิชาการผลิตสื่อดิจิทัล 
8.ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ) 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. ข้อใดเป็นเครื่องมือในการสร้างข้อความ 
 ก. ไทป์ทูล (Type Tool) 
  ข.  เพนเซิลทูล (Pencil Tool) 
  ค.  เพนทูล  (Pen Tool) 
        ง.  เรคแทงเกิลทูล (Rectangle Tool) 
2. ส่วนของเนื้อเรื่องนิยมใช้ตัวพิมพ์ขนาดเท่าใด 
 ก.  30 พอยต์ ขึ้นไป จะง่ายต่อการอ่าน 
 ข.  25–30 พอยต์ และมีความหนา 
 ค.  20 พอยต์ มีขนาดเท่า ๆ กับหัวเรื่อง 
 ง.  14–16 พอยต์ ขนาดไม่เล็กหรือใหญ่เกินไป 
3. ข้อใดเป็นลักษณะการใช้เครื่องมือไทป์ออนอะพาธทูล (Type on a path tool) ท่ีต่างจากไทป์ทูล 
 ก. ชนิดของตัวอักษรท่ีใช้แตกต่างกัน 
 ข.  ไทป์ทูลใช้สร้างข้อความบนเส้นพาธ 
 ค.  ไทป์ออนอะพาธทูลใช้สร้างข้อความบนเส้นพาธ 
 ง.  ไทป์ทูลใช้ร่วมกับเพนทูล และไทป์ออนอะพาธทูลใช้ร่วมกับเพนเซิลทูล   
4. ข้อใดเป็นคำส่ังท่ีใช้ในการนำไฟล์จากโปรแกรมอื่นเข้ามาใช้งานในโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 
 ก.  ไฟล์ > เพลส (File > Place) 
 ข.  ไฟล์ > อิมพอร์ท (File > Import) 
 ค.  เอดิท > เพลส (Edit > Place) 
 ง.  เอดิท > อิมพอร์ท (Edit > Import) 
5.  สัญลักษณ์ข้างต้น มีความหมายตรงกับข้อใด 
 ก.  การเพิ่มหน้าเอกสาร ข.  การคัดลอกงานข้ามไฟล์ 
 ค.  มีข้อความท่ีเป็นตารางถูกซ่อนไว ้ ง.  มีข้อความบางส่วนถูกซ่อนไว ้
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

ใบงานที่ 4 หน่วยที่   4 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 7-8 
 

ชื่อหน่วย  การสร้างข้อความเพื่อผลิตสื่อสิ่งพิมพ์   
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
ใบงานที่  3 

คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. ข้อใดเป็นเครื่องมือในการสร้างข้อความ 
 ก. ไทป์ทูล (Type Tool) 
  ข.  เพนเซิลทูล (Pencil Tool) 
  ค.  เพนทูล  (Pen Tool) 
        ง.  เรคแทงเกิลทูล (Rectangle Tool) 
2. ส่วนของเนื้อเรื่องนิยมใช้ตัวพิมพ์ขนาดเท่าใด 
 ก.  30 พอยต์ ขึ้นไป จะง่ายต่อการอ่าน 
 ข.  25–30 พอยต์ และมีความหนา 
 ค.  20 พอยต์ มีขนาดเท่า ๆ กับหัวเรื่อง 
 ง.  14–16 พอยต์ ขนาดไม่เล็กหรือใหญ่เกินไป 
3. ข้อใดเป็นลักษณะการใช้เครื่องมือไทป์ออนอะพาธทูล (Type on a path tool) ท่ีต่างจากไทป์ทูล 
 ก. ชนิดของตัวอักษรท่ีใช้แตกต่างกัน 
 ข.  ไทป์ทูลใช้สร้างข้อความบนเส้นพาธ 
 ค.  ไทป์ออนอะพาธทูลใช้สร้างข้อความบนเส้นพาธ 
 ง.  ไทป์ทูลใช้ร่วมกับเพนทูล และไทป์ออนอะพาธทูลใช้ร่วมกับเพนเซิลทูล   
4. ข้อใดเป็นคำส่ังท่ีใช้ในการนำไฟล์จากโปรแกรมอื่นเข้ามาใช้งานในโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 
 ก.  ไฟล์ > เพลส (File > Place) 
 ข.  ไฟล์ > อิมพอร์ท (File > Import) 
 ค.  เอดิท > เพลส (Edit > Place) 
 ง.  เอดิท > อิมพอร์ท (Edit > Import) 
5.  สัญลักษณ์ข้างต้น มีความหมายตรงกับข้อใด 
 ก.  การเพิ่มหน้าเอกสาร ข.  การคัดลอกงานข้ามไฟล์ 
 ค.  มีข้อความท่ีเป็นตารางถูกซ่อนไว ้ ง.  มีข้อความบางส่วนถูกซ่อนไว ้

 
 
 
 
 
 
 
 



 

 
 

 
 

บันทึกผลหลังการจัดการเรียนรู้ 
 

 ผลการจัดการเรียนรู้ตามแผนการสอน 
  1) วัน เดือน ปี ...............สอนครั้งท่ี .../.... สาขา/ช้ันปี  .....................จำนวนผู้เรียน..........คน    
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน 

2) หัวข้อเรื่อง/เนื้อหาสาระ :  ........................................................................................................... 
  ❑ สอนครบตามหัวข้อเรื่องในแผนฯ  ❑ สอนไม่ครบเนื่องจาก........................................ 
  3) กิจกรรม/วิธีการสอน 
   ❑ ครูแนะนำและบอกจุดประสงค์     ❑ ครูอธิบาย/ถาม-ตอบ/สาธิต/ 
   ❑ ทำแบบทดสอบก่อนเรียน      ❑ ทำแบบทดสอบหลังเรียน 
   ❑ ทำแบบฝึกหัด/โจทย์ปัญหา      ❑ ทำใบกิจกรรม/ใบงาน 
   ❑ อื่น ๆ (ระบ)ุ................................................................................................................... 
  4) ส่ือการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………………….......... 
  ....................................................................................................................................................... 
 11.2 ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาที่พบ 
  1) การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ………………………………………………..…….. 
       ........................................................................................................................................................ 
  2) สมรรถนะท่ีผู้เรียนได้รับ : .......................................................................................................... 
      .......................................................................................................................................................... 
  3) สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..…………………………………………………………..…..... 
      ……………....................................................................................................................................... 
  4) ผลการสอนของครู : ..……………………………………………………………………………………..…….……. 
      ……………........................................................................................................................................... 
  5) ปัญหาท่ีนำไปสู่การวิจัย : ..………………………………………………………………………………..….……... 
 11.3 แนวทางการพัฒนาคุณภาพการสอน/แก้ปัญหา 
  1) ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : .…………………………………………………………………... 
   
  2) แนวทางพัฒนาคุณภาพวิธีสอน/ส่ือ/การวัดผล/เอกสารช่วยสอน   
       …………….......................................................................................................................................... 
  

                                                      ลงช่ือ 
 

                      (.........................................) 
                                   ครูผู้สอน 
          ………./…………/………… 



 

 
 

 

 
 
 

แผนการจัดการเรียนรู้ หน่วยที่   5 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 9-10 
 

ชื่อหน่วย  ภาพประกอบสือ่สิ่งพิมพ์   
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
ภาพประกอบในสื่อสิ ่งพิมพ์ ทั ้งที ่เป็นภาพวาดและภาพถ่ายต่างก็ใช้เพื ่อสื ่อความหมายเช่นเดียวกับ

ตัวอักษร แต่มีลักษณะพิเศษคือให้รายละเอียดได้มากกว่าและยังสามารถทำให้เห็นภาพได้ เหมือนจริง การได้
มองเห็นภาพจะทำให้เกิดความเข้าใจได้ทันทีโดยไม่ต้องใช้เวลาตีความหรือทำความ เข้าใจ นอกจากนี้ภาพยังถือ
ว่าเป็นภาษาสากล แม้คนที่ไม่รู้หนังสือก็สามารถดูรู้เรื่องได้ การใช้ภาพประกอบจึงมีความหมายและสำคัญต่อ
ส่ิงพิมพ์ไม่น้อยไปกว่าตัวพิมพ์ 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 

- 
3.สมรรถนะประจำหน่วย  

1. แสดงความรู้เกี่ยวกับการใช้เครื่องมือในการตกแต่งภาพ และการใช้ภาพประกอบอย่าง 
เหมาะสม   
  2.  เลือกประเภทของภาพเพื่อนำไปใช้ประกอบส่ือส่ิงพิมพ์อย่างเหมาะสม 
  3.  เลือกใช้เครื่องมือท่ีนำมาใช้สร้างรูปทรงตายตัวและรูปทรงอิสระในการสร้างช้ินงาน 
  4.  นำรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรมอย่างเหมาะสม 

5.  แสดงพฤติกรรมความสนใจใฝ่รู้  ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็น 
ประชาธิปไตย  และห่างไกลยาเสพติด  

4.จุดประสงค์เชิงพฤติกรรม 
4.1 ด้านความรู้ 

1. อธิบายเกี่ยวกับความหมายของภาพประกอบส่ือส่ิงพิมพ์ได้ 
2.เลือกประเภทของภาพเพื่อนำไปใช้ประกอบส่ือส่ิงพิมพ์ได้ 
3.ใช้เครื่องมือท่ีนำมาใช้สร้างรูปทรงตายตัวและรูปทรงอิสระได้ 
4.วาดภาพเส้นพาธที่มีรูปทรงตายตัวและรูปทรงอิสระได้ 
5.นำรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 ได้ 

4.2 ด้านทักษะ 
1. อธิบายเกี่ยวกับรูปแบบของข้อความท่ีใช้ในโปรแกรม  Indesign CS6 ได้ 
2.สร้างข้อความในรูปแบบของ Text block และ Text frame ตามวัตถุประสงค์การ       

ทำงานได้ 
3. สร้างเส้น  path  จากเครื่องมือใน Toolbox ตามความเหมาะสมได้ 
4. สร้างข้อความตามแนวเส้น path และตกแต่งเหมาะสมกับช้ินงานได้ 
5. กำหนดการไหลของข้อความตามตำแหน่งท่ีต้องการได้ 



 

 
 

6. ปรับแต่งตัวอักษรจากพาเนล Characterได้ 
7. ปรับแต่งตัวอักษรจากคอนโทรลพาเนลได้ 

 

4.3 คุณลักษณะที่พึงประสงค์ 
   1. ความสนใจใฝ่รู้  
   2. มีความซื่อสัตย์ในการปฏิบัติงาน 
   3. มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
   4.ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

3. สาระการเรียนรู้ 
ภาพประกอบส่ือส่ิงพิมพ์  

4. กิจกรรมการเรียนรู้ 
6.1 การนำเข้าสู่บทเรียน 

1.ผู้สอนกล่าวทักทายผู้เรียน เนื่องจากเป็นการสอนครั้งแรก   
2.ผู้สอนตรวจสอบรายช่ือผู้เรียน 
3.ผู้สอนบอกจุดประสงค์รายวิชา มาตรฐานรายวิชา และคำอธิบายรายวิชา 
4.ผู้สอนแจกแบบทดสอบก่อนเรียนเพื่อทดสอบผู้เรียน 

5. สื่อและแหล่งเรียนรู้ 
5.1 หนังสือการผลิตส่ือสิงพิมพ์. ประภาวรรณ เกษวิริยะการณ์. สำนักพิมพ์เมืองไทย 
5.2 ส่ือประกอบการเรียน เช่น VDO,  PowerPoint,  YouTube และอุปกรณ์จริง 

6. หลักฐานการเรียนรู้ 
8.1 หลักฐานความรู้           

   คะแนนจากการตอบคำถามท้ายบทเรียน และแบบทดสอบ ในหนังสือประกอบการเรียน  
8.2 หลักฐานการปฏิบัติงาน 

   คะแนนการทำกิจกรรมการเรียนรู้  และภาพถ่ายการทำกิจกรรมของผู้เรียน  
     9. การวัดและการประเมินผล 

9.1 วิธีวัดและการประเมินผล 
1) ทดสอบก่อนเรียนและหลังเรียน 
2) ตรวจใบงาน 
3) ประเมินการนำเสนอผลงาน 
4) สังเกตพฤติกรรม 

9.2 เคร่ืองมือวัดและการประเมินผล 
1) แบบทดสอบก่อนเรียนและหลังเรียน 
2) ใบงาน 
3) แบบประเมินการนำเสนอผลงาน 
4) แบบสังเกตพฤติกรรม 

9.3 เกณฑ์วัดและการประเมินผล 
1) เกณฑ์การทดสอบก่อนเรียนและหลังเรียน คะแนนผ่านไม่ต่ำกว่า 80% 



 

 
 

2) เกณฑ์การประเมินใบงาน คะแนนผ่านไม่ต่ำกว่า 80% 
3) เกณฑ์การประเมินผลการนำเสนอผลงาน คะแนนผ่านไม่ต่ำกว่า 80% 
4) เกณฑ์การสังเกตพฤติกรรม คะแนนผ่านไม่ต่ำกว่า 80% 

 
10.  บันทึกผลหลังการจัดการเรียนรู้ 

 
10.1 ผลการจัดการเรียนรู้ท่ีเกิดขึ้นกับผู้เรียน 

               
               
               

10.2 ปัญหา อุปสรรคท่ีพบ 
               
               
               

10.3 การแก้ไขปัญหา 
1) ผลการแก้ไขปัญหาทีส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

ใบความรู้ที่ 5 หน่วยที่   5 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 9-10 
 

ชื่อหน่วย  ภาพประกอบสือ่สิ่งพิมพ์   
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
1.  ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
ภาพประกอบส่ือส่ิงพิมพ์ 
2. อ้างอิงมาตรฐาน / เชื่อมโยงกลุ่มอาชีพ (ถ้ามี) 

 -  
3.สมรรถนะประจำหน่วย  

1. แสดงความรู้เกี่ยวกับการใช้เครื่องมือในการตกแต่งภาพ และการใช้ภาพประกอบอย่าง 
เหมาะสม   
  2.  เลือกประเภทของภาพเพื่อนำไปใช้ประกอบส่ือส่ิงพิมพ์อย่างเหมาะสม 
  3.  เลือกใช้เครื่องมือท่ีนำมาใช้สร้างรูปทรงตายตัวและรูปทรงอิสระในการสร้างช้ินงาน 
  4.  นำรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรมอย่างเหมาะสม 

5.  แสดงพฤติกรรมความสนใจใฝ่รู้  ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็น 
ประชาธิปไตย  และห่างไกลยาเสพติด  

4.จุดประสงค์เชิงพฤติกรรม 
4.1 ด้านความรู้ 

1. อธิบายเกี่ยวกับความหมายของภาพประกอบส่ือส่ิงพิมพ์ได้ 
2.เลือกประเภทของภาพเพื่อนำไปใช้ประกอบส่ือส่ิงพิมพ์ได้ 
3.ใช้เครื่องมือท่ีนำมาใช้สร้างรูปทรงตายตัวและรูปทรงอิสระได้ 
4.วาดภาพเส้นพาธที่มีรูปทรงตายตัวและรูปทรงอิสระได้ 
5.นำรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 ได้ 

4.2 ด้านทักษะ 
1. อธิบายเกี่ยวกับรูปแบบของข้อความท่ีใช้ในโปรแกรม  Indesign CS6 ได้ 
2.สร้างข้อความในรูปแบบของ Text block และ Text frame ตามวัตถุประสงค์การ       

ทำงานได้ 
8. สร้างเส้น  path  จากเครื่องมือใน Toolbox ตามความเหมาะสมได้ 
9. สร้างข้อความตามแนวเส้น path และตกแต่งเหมาะสมกับช้ินงานได้ 
10. กำหนดการไหลของข้อความตามตำแหน่งท่ีต้องการได้ 
11. ปรับแต่งตัวอักษรจากพาเนล Characterได้ 
12. ปรับแต่งตัวอักษรจากคอนโทรลพาเนลได้ 

 

4.3 คุณลักษณะที่พึงประสงค์ 
   1. ความสนใจใฝ่รู้  
   2. มีความซื่อสัตย์ในการปฏิบัติงาน 



 

 
 

   3. มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
   4.ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 
5. เนือ้หาสาระ 

 ความหมายของภาพ  
  “ภาพ” ในความหมายตามพจนานุกรมไทย  ฉบับราชบัณฑิตยสถาน พ.ศ. 2542   หมายถึง 
ความมี ความเป็น มักใช้ประกอบเป็นส่วนท้ายของคำสมาส เช่น มรณภาพ เป็นต้น รูปที่ปรากฏเห็นหรือนึกเห็น 
เช่น ภาพทิวทัศน์ ภาพในฝัน เป็นต้น ส่ิงท่ีวาดขึ้นเป็นรูป หรือส่ิงท่ีถ่ายแบบไว้  เช่น ภาพสีน้ำมัน ภาพถ่าย  เป็นต้น 
  ภาพประกอบส่ือส่ิงพิมพ์ หมายถึง เนื้อหาส่วนท่ีเป็นภาพท่ีปรากฏอยู่ในเอกสารส่ือส่ิงพิมพ์ 
ต่าง ๆ นอกจากเนื้อหาที่เป็นข้อความและตัวอักษร ภาพเหล่านี้อาจจะเป็นภาพวาดหรือภาพถ่ายก็ได้ และยังนับ
รวมถึงภาพกราฟิกต่าง ๆ ได้แก่ จุด เส้น สี แถบกราฟิก ภาพลายเส้น และภาพเรขาคณิตอื่น ๆ ท่ีใช้ในการตกแต่ง
ส่ือส่ิงพิมพ์ 
  

ภาพประกอบสือ่สิ่งพิมพ ์
 ภาพประกอบส่ิงพิมพ์ท้ังภาพวาดและภาพถ่ายต่างก็ใช้เพื่อส่ือความหมายเช่นเดียวกับ 
ตัวอักษร  แต่มีลักษณะพิเศษคือให้รายละเอียดได้มากกว่าและสามารถทำให้เห็นภาพได้เหมือนจริง การได้มองเห็น
ภาพจะทำให้เกิดความเข้าใจได้ทันที โดยไม่ต้องใช้เวลาตีความหรือทำความเข้าใจ  นอกจากนี้ภาพยังถือว่าเป็น
ภาษาสากล แม้คนไม่รู้หนังสือก็สามารถดูรู้เรื่องได้ การใช้ภาพประกอบจึงมีความหมายและสำคัญต่อส่ือส่ิงพิมพ์ไม่
น้อยไปกว่าตัวพิมพ์ 
 

ลักษณะของภาพวาดในโปรแกรมอะโดบี อินดีไซน์ ซีเอส 6  
  ลักษณะการวาดภาพในโปรแกรมอะโดบี อินดีไซน์ ซีเอส 6 จะมีลักษณะในรูปของเส้นพาธ  (Path)  
สามารถสร้างเป็นเส้นตรง หรือสร้างเป็นเส้นโค้งให้เกิดรูปร่างต่าง ๆ ได้ตามท่ีผู้ใช้ต้องการ ลักษณะของเส้นพาธแบ่ง
ได้เป็น 2 ประเภท 
 

 เส้นพาธที่มีรูปทรงตายตัว   
 เส้นพาธที่มีรูปทรงตายตัว เป็นเส้นพาธที่สร้างจากเครื่องมือไลน์ทูล (Line Tool)  ใช้เป็น 
เครื่องมือในการวาดภาพในกลุ่มการวาดเส้น  และการสร้างเส้นตรง  นอกจากนี้ยังมีเครื่องมือ เรคแทงเกิล ทูล  
(Rectangle Tool)  เครื ่องมืออิลลิปส์ ทูล (Ellipse Tool) และเครื่องมือโพลีกอน ทูล (Polygon Tool) เป็น
เครื่องมือในกลุ่มวาดรูปทรง เพื่อใช้ในการสร้างรูปส่ีเหล่ียม รูปหลายเหล่ียม  รูปวงกลม รูปวงรี และรูปดาว 
 เส้นพาธที่มีรูปทรงอิสระ   
 เส้นพาธที่มีรูปทรงอิสระ เป็นการวาดภาพวัตถุแบบอิสระ สามารถวาดรูปทรงต่าง ๆ ได้อย่างเป็น
อิสระด้วยเครื่องมือเพนทูล และเพนเซิลทูล 
 ภาพประกอบในสื่อสิ่งพิมพ์ช่วยทำให้ผู ้อ่านสื่อสิ่งพิมพ์สามารถมองเห็นภาพและ  ทำให้เกิดความ
เข้าใจได้ทันทีโดยไม่ต้องใช้เวลาตีความหรือทำความเข้าใจ การผลิตส่ือส่ิงพิมพ์ด้วยโปรแกรมสำเร็จรูปสามารถทำได้
ท้ังการวาดภาพและการแทรกรูปภาพจากภายนอก การวาดภาพ เป็นภาพในลักษณะรูปร่างและรูปทรงต่าง ๆ ใน
รูปแบบของเส้นพาธ ทั้งแบบเส้นตรงและเส้นโค้ง  การใช้เครื ่องมือในการสร้าง ได้แก่ เครื่องมือไลน์ทูล (Line 
Tool) เครื่องมือเรคแทงเกิลทูล (Rectangle Tool) เครื่องมืออิลลิปส์ทูล (Ellipse Tool) โพลีกอนทูล (Polygon 
Tool) เครื่องมือ     เพนทูล (Pen Tool) และเพลซิลทูล (Pencil Tool) นอกจากการวาดภาพแล้วผู้ใช้โปรแกรม
สามารถนำภาพจากภายนอกเข้ามาใช้งานในโปรแกรมได้ ได้แก่ ไฟล์รูปภาพที่สร้างจากโปรแกรมกราฟิกต่าง ๆ 
หรือภาพท่ีนำมาจากระบบอินเตอร์เน็ต  



 

 
 

 การใช้เครื่องมือในการวาดภาพรูปร่าง และรูปทรงต่าง ๆ หรือการนำไฟล์จากภายนอกเข้ามาใช้ใน
โปรแกรมต่างก็ช่วยให้การผลิตส่ือส่ิงพิมพ์ทำได้ง่ายและสะดวกในการทำงานมากขึ้น 
 

 การนำรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรมอโดบี อินดีไซน์ ซีเอส 6 
1. คลิกเลือกคำส่ังไฟล์ > เพลส (File > Place) 

   2.  ปรากฏหน้าต่างเพลสขึ้นมา 
  3.  เลือกโฟลเดอร์ท่ีเก็บไฟล์รูปภาพท่ีต้องการ 
  4.  เลือกไฟล์รูปภาพท่ีต้องการ 
 5. คลิกปุ่มโอเพ่น (Open) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

6. แบบทดสอบ/แบบฝึกหัด 
จากโจทย์คำถาม จงเลือกคำตอบที่ถูกต้องที่สุด 

แบบฝึกหัดหน่วยที่ 5 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. ข้อใดไม่ใช่ความสำคัญของภาพประกอบส่ือส่ิงพิมพ์ 
 ก. ใช้สร้างความเข้าใจ 
 ข. ใช้สร้างความแตกต่าง 
 ค. ใช้เป็นหลักฐานอ้างอิง 
 ง. ใช้ตกแต่งหน้าส่ิงพิมพ์ 
2. ข้อใดไม่ใช่ภาพประกอบส่ือส่ิงพิมพ์ 
 ก. ภาพวาดในหนังสือ 
 ข. ภาพกราฟิกบนโปสเตอร์ 
 ค. ภาพถ่ายท่ีอยู่ในอัลบั้มรูป 
 ง. ภาพตามจินตนาการท่ีรอการจัดพิมพ์ 
3. เมื่อต้องการเลือกไฟล์ประเภทบิตแมปมาประกอบงานพิมพ์ควรเลือกใช้ไฟล์ภาพในข้อใด 
 ก.  บีเอ็มพี (BMP), ทิฟ (TIF) 
 ข.  อีพีเอส (EPS), เอไอ (AI) 
 ค.  เอฟแอลเอ (FLA), ทิฟ (TIF) 
 ง.  เอสดับเบิลยูเอฟ (SWF), อีพีเอส (EPS) 
4.  เมื่อต้องการใช้ภาพประกอบส่ือส่ิงพิมพ์ท่ีให้ความรู้เหมือนจริงและสร้างสรรค์ควรเลือกใช้ภาพชนิดใด 
 ก.  ภาพถ่าย ข.  ภาพวาด 
 ค.  ภาพพิมพ์ ง.  ภาพลายเส้น 
5.  ข้อใดอธิบายคำส่ังท่ีใช้ในการสร้างรูปดาวได้ถูกต้อง 
 ก.  คำส่ังสตาร์เซตทิง (Star Setting) กำหนดมุมรูปดาว 
 ข.  คำส่ังสตาร์เซต (Star Set) กำหนดแฉกของรูปดาว 
 ค.  คำส่ังสตาร์อินเซต (Star Inset) กำหนดรูปแบบรูปดาว 
 ง.  คำส่ังสตาร์ออฟไซด์ (Star of Side) กำหนด้านของรูปดาว 
 

 
 
 
 
 
 
 
 

 
 
 



 

 
 

 
7.  เอกสารอ้างอิง (ขึ้นหน้าใหม่) 
วิชาการผลิตสื่อดิจิทัล 
8.ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ) 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. ข้อใดไม่ใช่ความสำคัญของภาพประกอบส่ือส่ิงพิมพ์ 
 ก. ใช้สร้างความเข้าใจ 
 ข. ใช้สร้างความแตกต่าง 
 ค. ใช้เป็นหลักฐานอ้างอิง 
 ง. ใช้ตกแต่งหน้าส่ิงพิมพ์ 
2. ข้อใดไม่ใช่ภาพประกอบส่ือส่ิงพิมพ์ 
 ก. ภาพวาดในหนังสือ 
 ข. ภาพกราฟิกบนโปสเตอร์ 
 ค. ภาพถ่ายท่ีอยู่ในอัลบั้มรูป 
 ง. ภาพตามจินตนาการท่ีรอการจัดพิมพ์ 
3. เมื่อต้องการเลือกไฟล์ประเภทบิตแมปมาประกอบงานพิมพ์ควรเลือกใช้ไฟล์ภาพในข้อใด 
 ก.  บีเอ็มพี (BMP), ทิฟ (TIF) 
 ข.  อีพีเอส (EPS), เอไอ (AI) 
 ค.  เอฟแอลเอ (FLA), ทิฟ (TIF) 
 ง.  เอสดับเบิลยูเอฟ (SWF), อีพีเอส (EPS) 
4.  เมื่อต้องการใช้ภาพประกอบส่ือส่ิงพิมพ์ท่ีให้ความรู้เหมือนจริงและสร้างสรรค์ควรเลือกใช้ภาพชนิดใด 
 ก.  ภาพถ่าย ข.  ภาพวาด 
 ค.  ภาพพิมพ์ ง.  ภาพลายเส้น 
5.  ข้อใดอธิบายคำส่ังท่ีใช้ในการสร้างรูปดาวได้ถูกต้อง 
 ก.  คำส่ังสตาร์เซตทิง (Star Setting) กำหนดมุมรูปดาว 
 ข.  คำส่ังสตาร์เซต (Star Set) กำหนดแฉกของรูปดาว 
 ค.  คำส่ังสตาร์อินเซต (Star Inset) กำหนดรูปแบบรูปดาว 
 ง.  คำส่ังสตาร์ออฟไซด์ (Star of Side) กำหนด้านของรูปดาว 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

ใบงานที่ 5 หน่วยที่   5 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 9-10 
 

ชื่อหน่วย  ภาพประกอบสือ่สิ่งพิมพ์   
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
ใบงานที่  5 

คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. ข้อใดไม่ใช่ความสำคัญของภาพประกอบส่ือส่ิงพิมพ์ 
 ก. ใช้สร้างความเข้าใจ 
 ข. ใช้สร้างความแตกต่าง 
 ค. ใช้เป็นหลักฐานอ้างอิง 
 ง. ใช้ตกแต่งหน้าส่ิงพิมพ์ 
2. ข้อใดไม่ใช่ภาพประกอบส่ือส่ิงพิมพ์ 
 ก. ภาพวาดในหนังสือ 
 ข. ภาพกราฟิกบนโปสเตอร์ 
 ค. ภาพถ่ายท่ีอยู่ในอัลบั้มรูป 
 ง. ภาพตามจินตนาการท่ีรอการจัดพิมพ์ 
3. เมื่อต้องการเลือกไฟล์ประเภทบิตแมปมาประกอบงานพิมพ์ควรเลือกใช้ไฟล์ภาพในข้อใด 
 ก.  บีเอ็มพี (BMP), ทิฟ (TIF) 
 ข.  อีพีเอส (EPS), เอไอ (AI) 
 ค.  เอฟแอลเอ (FLA), ทิฟ (TIF) 
 ง.  เอสดับเบิลยูเอฟ (SWF), อีพีเอส (EPS) 
4.  เมื่อต้องการใช้ภาพประกอบส่ือส่ิงพิมพ์ท่ีให้ความรู้เหมือนจริงและสร้างสรรค์ควรเลือกใช้ภาพชนิดใด 
 ก.  ภาพถ่าย ข.  ภาพวาด 
 ค.  ภาพพิมพ์ ง.  ภาพลายเส้น 
5.  ข้อใดอธิบายคำส่ังท่ีใช้ในการสร้างรูปดาวได้ถูกต้อง 
 ก.  คำส่ังสตาร์เซตทิง (Star Setting) กำหนดมุมรูปดาว 
 ข.  คำส่ังสตาร์เซต (Star Set) กำหนดแฉกของรูปดาว 
 ค.  คำส่ังสตาร์อินเซต (Star Inset) กำหนดรูปแบบรูปดาว 
 ง.  คำส่ังสตาร์ออฟไซด์ (Star of Side) กำหนด้านของรูปดาว 
 

 
 
 
 
 
 
 



 

 
 

 
 
 

บันทึกผลหลังการจัดการเรียนรู้ 
 

 ผลการจัดการเรียนรู้ตามแผนการสอน 
  1) วัน เดือน ปี ...............สอนครั้งท่ี .../.... สาขา/ช้ันปี  .....................จำนวนผู้เรียน..........คน    
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน 

2) หัวข้อเรื่อง/เนื้อหาสาระ :  ........................................................................................................... 
  ❑ สอนครบตามหัวข้อเรื่องในแผนฯ  ❑ สอนไม่ครบเนื่องจาก........................................ 
  3) กิจกรรม/วิธีการสอน 
   ❑ ครูแนะนำและบอกจุดประสงค์     ❑ ครูอธิบาย/ถาม-ตอบ/สาธิต/ 
   ❑ ทำแบบทดสอบก่อนเรียน      ❑ ทำแบบทดสอบหลังเรียน 
   ❑ ทำแบบฝึกหัด/โจทย์ปัญหา      ❑ ทำใบกิจกรรม/ใบงาน 
   ❑ อื่น ๆ (ระบ)ุ................................................................................................................... 
  4) ส่ือการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………………….......... 
  ....................................................................................................................................................... 
 11.2 ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาที่พบ 
  1) การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ………………………………………………..…….. 
       ........................................................................................................................................................ 
  2) สมรรถนะท่ีผู้เรียนได้รับ : .......................................................................................................... 
      .......................................................................................................................................................... 
  3) สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..…………………………………………………………..…..... 
      ……………....................................................................................................................................... 
  4) ผลการสอนของครู : ..……………………………………………………………………………………..…….……. 
      ……………........................................................................................................................................... 
  5) ปัญหาท่ีนำไปสู่การวิจัย : ..………………………………………………………………………………..….……... 
 11.3 แนวทางการพัฒนาคุณภาพการสอน/แก้ปัญหา 
  1) ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : .…………………………………………………………………... 
   
  2) แนวทางพัฒนาคุณภาพวิธีสอน/ส่ือ/การวัดผล/เอกสารช่วยสอน   
       …………….......................................................................................................................................... 
  

                                                      ลงช่ือ 
 

                      (.........................................) 
                                   ครูผู้สอน 
          ………./…………/………… 



 

 
 

 

 
 
 

แผนการจัดการเรียนรู้ หน่วยที่   6 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 11-13 
 

ชื่อหน่วย  สีในสือ่พิมพ์
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
สีบนจอภาพหรือส่ิงพิมพ์ท่ีเราเห็นนั้นเกิดจากการผสมสีท่ีลอกเลียนแบบธรรมชาติ ซึ่งโปรแกรม Indesign  

ได้นำหลักการแสดงสีของโมเดลสีเข้ามาประยุกต์ให้เกิดเป็นโหมดสำหรับการใช้งานได้หลากหลาย ท้ังการใส่ให้กับ
วัตถุ การเลือกสีจากพาเนล Color และ พาเนล  Swatcheds 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 

- 
3.สมรรถนะประจำหน่วย  

1. แสดงความรู้เกี่ยวกับโหมดสีท่ีใช้ในโปรแกรม Indesign  
  2.  แยกชนิดของโหมดสีท่ีใช้งานใน Indesign  โดยยึดหลักกรมองเห็นสีในโมเดลสีต่าง ๆ 
  3.  ปรับเปล่ียนโหมดสีของวัตถุด้วยพาเนล  Color ตามสีท่ีต้องการ 
  4.  เลือกสีจากพาเนล Swatches ในการเก็บสีท่ีเรียกใช้บ่อย ๆ 

5.  ปรับภาพปกติเป็นภาพโปร่งแสงให้มีความใสเหมือนกับกระจกเงา 

4.จุดประสงค์เชิงพฤติกรรม 
4.1 ด้านความรู้ 

1.เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับโหมดสีท่ีใช้ในโปรแกรม  
2.เพื่อให้มีทักษะในการวาดภาพวัตถุด้วยเครื่องมือสร้างภาพต่าง ๆ 
3เพื่อให้มีทักษะในการปรับเปล่ียนโหมดสีของวัตถุด้วยพาเนล Color ตามสีท่ี 

ต้องการ 
4.เพื่อให้มีทักษะในการเลือกสีจากพาเนล Swatches ในการเก็บสีท่ีเรียกใช้บ่อย ๆ 
5.เพื่อให้มีทักษะในการปรับภาพปกติเป็นภาพโปร่งแสงให้มีความใสเหมือนกับกระจก  

4.2 ด้านทักษะ 
1. อธิบายเกี่ยวกับโหมดสีท่ีใช้ในโปรแกรม Indesign  
2. วาดภาพวัตถุด้วยเครื่องมือสร้างภาพต่าง ๆ  ได้ 
3.ปรับเปล่ียนโหมดสีของวัตถุด้วยพาเนล Color ตามสีท่ีต้องการได้ 
4.เลือกสีจากพาเนล Swatches ในการเก็บสีท่ีเรียกใช้บ่อย ๆ ได้ 
5.ปรับภาพปกติเป็นภาพโปร่งแสงให้มีความใสเหมือนกับกระจกเงาได้ 
6.เลือกใช้เครื่องมือในการใช้สีอย่างเหมาะสม 

 

4.3 คุณลักษณะที่พึงประสงค์ 
   1. ความสนใจใฝ่รู้  
   2. มีความซื่อสัตย์ในการปฏิบัติงาน 



 

 
 

   3. มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
   4.ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

5.สาระการเรียนรู้ 
สีในส่ือพิมพ์ 

6.กิจกรรมการเรียนรู้ 
6.1 การนำเข้าสู่บทเรียน 

1.ผู้สอนกล่าวทักทายผู้เรียน เนื่องจากเป็นการสอนครั้งแรก   
2.ผู้สอนตรวจสอบรายช่ือผู้เรียน 
3.ผู้สอนบอกจุดประสงค์รายวิชา มาตรฐานรายวิชา และคำอธิบายรายวิชา 
4.ผู้สอนแจกแบบทดสอบก่อนเรียนเพื่อทดสอบผู้เรียน 

7.สื่อและแหล่งเรียนรู้ 
2.1 หนังสือการผลิตส่ือสิงพิมพ์. ประภาวรรณ เกษวิริยะการณ์. สำนักพิมพ์เมืองไทย 
2.2 ส่ือประกอบการเรียน เช่น VDO,  PowerPoint,  YouTube และอุปกรณ์จริง 

8.หลักฐานการเรียนรู้ 
8.1 หลักฐานความรู้           

   คะแนนจากการตอบคำถามท้ายบทเรียน และแบบทดสอบ ในหนังสือประกอบการเรียน  
8.2 หลักฐานการปฏิบัติงาน 

   คะแนนการทำกิจกรรมการเรียนรู้  และภาพถ่ายการทำกิจกรรมของผู้เรียน  
     9. การวัดและการประเมินผล 

9.1 วิธีวัดและการประเมินผล 
1) ทดสอบก่อนเรียนและหลังเรียน 
2) ตรวจใบงาน 
3) ประเมินการนำเสนอผลงาน 
4) สังเกตพฤติกรรม 

9.2 เคร่ืองมือวัดและการประเมินผล 
1) แบบทดสอบก่อนเรียนและหลังเรียน 
2) ใบงาน 
3) แบบประเมินการนำเสนอผลงาน 
4) แบบสังเกตพฤติกรรม 

9.3 เกณฑ์วัดและการประเมินผล 
1) เกณฑ์การทดสอบก่อนเรียนและหลังเรียน คะแนนผ่านไม่ต่ำกว่า 80% 
2) เกณฑ์การประเมินใบงาน คะแนนผ่านไม่ต่ำกว่า 80% 
3) เกณฑ์การประเมินผลการนำเสนอผลงาน คะแนนผ่านไม่ต่ำกว่า 80% 
4) เกณฑ์การสังเกตพฤติกรรม คะแนนผ่านไม่ต่ำกว่า 80% 

 
 



 

 
 

10.  บันทึกผลหลังการจัดการเรียนรู้ 
 

10.1 ผลการจัดการเรียนรู้ท่ีเกิดขึ้นกับผู้เรียน 
               
               
               

10.2 ปัญหา อุปสรรคท่ีพบ 
               
               
               

10.3 การแก้ไขปัญหา 
1) ผลการแก้ไขปัญหาทีส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

ใบความรู้ที่ 6 หน่วยที่   6 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 11-13 
 

ชื่อหน่วย  สีในสือ่พิมพ์
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
1.  ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

สีในส่ือพิมพ์ 
2. อ้างอิงมาตรฐาน / เชื่อมโยงกลุ่มอาชีพ (ถ้ามี) 

 -  
3.สมรรถนะประจำหน่วย  

1. แสดงความรู้เกี่ยวกับโหมดสีท่ีใช้ในโปรแกรม Indesign  
  2.  แยกชนิดของโหมดสีท่ีใช้งานใน Indesign  โดยยึดหลักกรมองเห็นสีในโมเดลสีต่าง ๆ 
  3.  ปรับเปล่ียนโหมดสีของวัตถุด้วยพาเนล  Color ตามสีท่ีต้องการ 
  4.  เลือกสีจากพาเนล Swatches ในการเก็บสีท่ีเรียกใช้บ่อย ๆ 

5.  ปรับภาพปกติเป็นภาพโปร่งแสงให้มีความใสเหมือนกับกระจกเงา 

4.จุดประสงค์เชิงพฤติกรรม 
4.1 ด้านความรู้ 

1.เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับโหมดสีท่ีใช้ในโปรแกรม  
2.เพื่อให้มีทักษะในการวาดภาพวัตถุด้วยเครื่องมือสร้างภาพต่าง ๆ 
3เพื่อให้มีทักษะในการปรับเปล่ียนโหมดสีของวัตถุด้วยพาเนล Color ตามสีท่ี 

ต้องการ 
4.เพื่อให้มีทักษะในการเลือกสีจากพาเนล Swatches ในการเก็บสีท่ีเรียกใช้บ่อย ๆ 
5.เพื่อให้มีทักษะในการปรับภาพปกติเป็นภาพโปร่งแสงให้มีความใสเหมือนกับกระจก  

4.2 ด้านทักษะ 
1. อธิบายเกี่ยวกับโหมดสีท่ีใช้ในโปรแกรม Indesign  
2. วาดภาพวัตถุด้วยเครื่องมือสร้างภาพต่าง ๆ  ได้ 
3.ปรับเปล่ียนโหมดสีของวัตถุด้วยพาเนล Color ตามสีท่ีต้องการได้ 
4.เลือกสีจากพาเนล Swatches ในการเก็บสีท่ีเรียกใช้บ่อย ๆ ได้ 
5.ปรับภาพปกติเป็นภาพโปร่งแสงให้มีความใสเหมือนกับกระจกเงาได้ 
6.เลือกใช้เครื่องมือในการใช้สีอย่างเหมาะสม 

 

4.3 คุณลักษณะที่พึงประสงค์ 
   1. ความสนใจใฝ่รู้  
   2. มีความซื่อสัตย์ในการปฏิบัติงาน 
   3. มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
   4.ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 
 



 

 
 

5. เนือ้หาสาระ 
4.1  ความหมายของสี 
 สีเป็นปรากฏการณ์ธรรมชาติ ที่น่ามหัศจรรย์ สีมีอยู่ในแสงแดด เป็นคลื่นแสงชนิดหนึ่งจะปรากฏให้
เห็น เมื่อแสงแดดส่องผ่านละอองน้ำในอากาศและเกิดการหักเหเกิดเป็นแถบสี ต่าง ๆ 7 สีเรียงติดกัน เรียกแถบสีท่ี
เรียงติดกันนี้ว่า สเปกตรัม ลักษณะเป็นสีรุ้งท่ีเห็นในท้องฟ้า คือ สีม่วง สีม่วงน้ำเงิน สีน้ำเงิน สีเขียว สีเหลือง สีส้ม 
และสีแดง แต่ละสีมีความถี่ของคลื่นแสง ไม่เท่ากัน สีแดงมีความถี่ต่ำที่สุด และมีช่วงคลื่นยาวที่สุด คลื่นแสงจะมี
ความถี่สูงขึ้นเรื่อย ๆ  จากสีแดงไปสีส้ม จนถึงสีม่วงที่มีความถี่สูงสุด คลื่นแสงที่มีความต่ำกว่าสีแดงหรือสูงกวา่สี
ม่วงยังมีอยู่อีก มากมาย เช่น แสงอินฟราเรดที่มีความถี่ต่ำกว่าแดง หรือแสงอัลตราไวโอเลตที่มีความถี่สูงกว่าม่วง 
แต่ตาของมนุษย์ไม่อาจรับความถ่ีขนาดนั้น  เป็นต้น 

 

4.2  ระบบสี (Color Model) 
 การใช้สีกับงานกราฟิกในคอมพิวเตอร์ มีรายละเอียดหลายอย่างที่เป็นลักษณะเฉพาะ ระบบสีของ
คอมพิวเตอร์ จะเกี่ยวข้องกับการแสดงผลแสงที่แสดงบนจอคอมพิวเตอร์ โดยมีลักษณะการแสดงผล คือถ้าไม่มี
แสดงผลสีใดเลย บนจอภาพจะแสดงเป็นสีดำ หากสีทุกสีแสดงผลพร้อมกัน 
จะเห็นสีบนจอภาพเป็นสีขาว ส่วนสีอื่น ๆ เกิดจากการแสดงสีหลาย ๆ สี แต่มีค่าแตกต่างกัน  
  สีท่ีใช้ในงานด้านกราฟิกท่ัวไป มี 4 ระบบ คือ 
  4.1  ระบบสีอาร์จีบี  (RGB  =  Read, Green, Blue) 

4.2  ระบบสีซีเอ็มวายเค  (CMYK = Cyan, Magenta, Yellow, Black) 
  4.3  ระบบสีเอชเอสบี  (HSB  = Hue Saturation  Brightness) 

4.4   ระบบสีแอลเอบี (LAB) 
 

4.3  การใส่สีวัตถุ 
 เมื่อผู้ใช้สร้างวัตถุได้ตามต้องการแล้ว การเพิ่มสีสันให้วัตถุมีความสวยงาม สามารถใส่สีพื้น  
(Fill) และสีเส้น (Stroke) ด้วยคัลเลอะพิคเกอะ (Color Picker) จากกล่องเครื่องมือ แพนเนิล คัลเลอะ  
(Panel Color) และแพนเนิลสวอตเชส  (Panel Swatches) 
 

4.4  การใส่สีด้วยเคร่ืองมืออายดร็อปเพอร์ทูล 

  เครื่องมือท่ีใช้ในการระบายสีวัตถุ โดยใช้วิธีการดึงสีของวัตถุอื่นมาใส่ในวัตถุท่ีเลือก ด้วยเครื่องมือ
อายดร็อปเพอร์ทูล (Eyedropper Tool) สามารถทำได้ดังนี้ 
  4. คลิกวัตถุเพื่อระบายสี วัตถุจะมีสีเดียวกับสีต้นฉบับ 

 

4.5  การสร้างภาพโปร่งแสง 
  การสร้างภาพโปร่งแสง (Opacity) เป็นการทำให้ภาพหรือวัตถุท่ีซ้อนกันอยู่มีความโปร่งแสง ใสเหมือน
กระจก สามารถมองผ่านเห็นทะลุถึงภาพหรือวัตถุท่ีอยู่ด้านหลัง สามารถทำได้ดังนี้ 
 1. คลิกเลือกวัตถ ุ
     2.  คลิกเลือกพาเนลเอฟเฟ็กต์ (Panel Effects) 
 3. กำหนดค่าความโปร่งแสงของวัตถุ 
     4.  ผลลัพธ์จะได้ภาพโปร่งแสงท่ีสามารถมองเห็นภาพด้านหลัง 
 
 



 

 
 

6. แบบทดสอบ/แบบฝึกหัด 
จากโจทย์คำถาม จงเลือกคำตอบที่ถูกต้องที่สุด 

แบบฝึกหัดหน่วยที่ 6 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว  
1. ข้อใดให้คำจำกัดความของสีได้ชัดเจนท่ีสุด 
 ก. สีมีความไวกว่าแสง 
 ข. สีคือลักษณะหนึ่งของแสง 
 ค. สีคือลักษณะของส่ิงท่ีอยู่ในอากาศ 
 ง. สีเกิดขึ้นจากการรวมตัวของฝุ่นละอองในอากาศ 
2. ระบบสีใดเป็นระบบสีแบบการมองเห็นของสายตามนุษย์      
 ก. ระบบอาร์จีบี (RGB) 
 ข. ระบบสีแอลเอบี (LAB) 
 ค. ระบบสีเอชเอสบี (HSB) 
 ง. ระบบสีซีเอ็มวายเค (CMYK) 
3. การเปล่ียนโหมดสีของวัตถุ ผู้ใช้โปรแกรมควรเลือกใช้พาเนลใด     
 ก. คัลเลอร์ (Color) 
 ข. พิกเกอร์ (Picker) 
 ค.  สวอตเชส (Swatches) 
 ง. เกรเดียนต์ (Gradient) 

4.  ภาพเครื่องมือชนิดนี้ เป็นเครื่องมือท่ีใช้ในการทำงานอย่างไร    
 ก.  กำหนดไม่ให้มีสีพื้น 
 ข.  กำหนดให้มีสีพื้นเพียงสีเดียว 
 ค.  กำหนดการไล่โทนสีให้กับสีพื้น 
 ง.  กำหนดการใส่สีให้กับตัวอักษรและวัตถุ 
5.  จากภาพเป็นเครื่องมือท่ีใช้ในการทำงานในลักษณะใด 
 ก.  ใช้ในการไล่ระดับสี ข. เป็นการลดสีในพาเนล 
 ค. ปรับพื้นวัตถุให้เป็นสีขาว ง.  เป็นการเพิ่มสีในพาเนล 
 

 
 
 
 
 
 
 
 

 
 



 

 
 

7.  เอกสารอ้างอิง (ขึ้นหน้าใหม่) 
วิชาการผลิตสื่อดิจิทัล 
8.ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ) 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว  
1. ข้อใดให้คำจำกัดความของสีได้ชัดเจนท่ีสุด 
 ก. สีมีความไวกว่าแสง 
 ข. สีคือลักษณะหนึ่งของแสง 
 ค. สีคือลักษณะของส่ิงท่ีอยู่ในอากาศ 
 ง. สีเกิดขึ้นจากการรวมตัวของฝุ่นละอองในอากาศ 
2. ระบบสีใดเป็นระบบสีแบบการมองเห็นของสายตามนุษย์      
 ก. ระบบอาร์จีบี (RGB) 
 ข. ระบบสีแอลเอบี (LAB) 
 ค. ระบบสีเอชเอสบี (HSB) 
 ง. ระบบสีซีเอ็มวายเค (CMYK) 
3. การเปล่ียนโหมดสีของวัตถุ ผู้ใช้โปรแกรมควรเลือกใช้พาเนลใด     
 ก. คัลเลอร์ (Color) 
 ข. พิกเกอร์ (Picker) 
 ค.  สวอตเชส (Swatches) 
 ง. เกรเดียนต์ (Gradient) 

4.  ภาพเครื่องมือชนิดนี้ เป็นเครื่องมือท่ีใช้ในการทำงานอย่างไร    
 ก.  กำหนดไม่ให้มีสีพื้น 
 ข.  กำหนดให้มีสีพื้นเพียงสีเดียว 
 ค.  กำหนดการไล่โทนสีให้กับสีพื้น 
 ง.  กำหนดการใส่สีให้กับตัวอักษรและวัตถุ 
5.  จากภาพเป็นเครื่องมือท่ีใช้ในการทำงานในลักษณะใด 
 ก.  ใช้ในการไล่ระดับสี ข. เป็นการลดสีในพาเนล 
 ค. ปรับพื้นวัตถุให้เป็นสีขาว ง.  เป็นการเพิ่มสีในพาเนล 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

ใบงานที่ 6 หน่วยที่   6 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 11-13 
 

ชื่อหน่วย  สีในสือ่พิมพ์
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
ใบงานที่  6 

คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว  
1. ข้อใดให้คำจำกัดความของสีได้ชัดเจนท่ีสุด 
 ก. สีมีความไวกว่าแสง 
 ข. สีคือลักษณะหนึ่งของแสง 
 ค. สีคือลักษณะของส่ิงท่ีอยู่ในอากาศ 
 ง. สีเกิดขึ้นจากการรวมตัวของฝุ่นละอองในอากาศ 
2. ระบบสีใดเป็นระบบสีแบบการมองเห็นของสายตามนุษย์      
 ก. ระบบอาร์จีบี (RGB) 
 ข. ระบบสีแอลเอบี (LAB) 
 ค. ระบบสีเอชเอสบี (HSB) 
 ง. ระบบสีซีเอ็มวายเค (CMYK) 
3. การเปล่ียนโหมดสีของวัตถุ ผู้ใช้โปรแกรมควรเลือกใช้พาเนลใด     
 ก. คัลเลอร์ (Color) 
 ข. พิกเกอร์ (Picker) 
 ค.  สวอตเชส (Swatches) 
 ง. เกรเดียนต์ (Gradient) 

4.  ภาพเครื่องมือชนิดนี้ เป็นเครื่องมือท่ีใช้ในการทำงานอย่างไร    
 ก.  กำหนดไม่ให้มีสีพื้น 
 ข.  กำหนดให้มีสีพื้นเพียงสีเดียว 
 ค.  กำหนดการไล่โทนสีให้กับสีพื้น 
 ง.  กำหนดการใส่สีให้กับตัวอักษรและวัตถุ 
5.  จากภาพเป็นเครื่องมือท่ีใช้ในการทำงานในลักษณะใด 
 ก.  ใช้ในการไล่ระดับสี ข. เป็นการลดสีในพาเนล 
 ค. ปรับพื้นวัตถุให้เป็นสีขาว ง.  เป็นการเพิ่มสีในพาเนล 
 

 
 
 
 
 
 
 



 

 
 

บันทึกผลหลังการจัดการเรียนรู้ 
 

 ผลการจัดการเรียนรู้ตามแผนการสอน 
  1) วัน เดือน ปี ...............สอนครั้งท่ี .../.... สาขา/ช้ันปี  .....................จำนวนผู้เรียน..........คน    
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน 

2) หัวข้อเรื่อง/เนื้อหาสาระ :  ........................................................................................................... 
  ❑ สอนครบตามหัวข้อเรื่องในแผนฯ  ❑ สอนไม่ครบเนื่องจาก........................................ 
  3) กิจกรรม/วิธีการสอน 
   ❑ ครูแนะนำและบอกจุดประสงค์     ❑ ครูอธิบาย/ถาม-ตอบ/สาธิต/ 
   ❑ ทำแบบทดสอบก่อนเรียน      ❑ ทำแบบทดสอบหลังเรียน 
   ❑ ทำแบบฝึกหัด/โจทย์ปัญหา      ❑ ทำใบกิจกรรม/ใบงาน 
   ❑ อื่น ๆ (ระบ)ุ................................................................................................................... 
  4) ส่ือการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………………….......... 
  ....................................................................................................................................................... 
 11.2 ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาที่พบ 
  1) การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ………………………………………………..…….. 
       ........................................................................................................................................................ 
  2) สมรรถนะท่ีผู้เรียนได้รับ : .......................................................................................................... 
      .......................................................................................................................................................... 
  3) สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..…………………………………………………………..…..... 
      ……………....................................................................................................................................... 
  4) ผลการสอนของครู : ..……………………………………………………………………………………..…….……. 
      ……………........................................................................................................................................... 
  5) ปัญหาท่ีนำไปสู่การวิจัย : ..………………………………………………………………………………..….……... 
 11.3 แนวทางการพัฒนาคุณภาพการสอน/แก้ปัญหา 
  1) ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : .…………………………………………………………………... 
   
  2) แนวทางพัฒนาคุณภาพวิธีสอน/ส่ือ/การวัดผล/เอกสารช่วยสอน   
       …………….......................................................................................................................................... 
  

                                                      ลงช่ือ 
 

                      (.........................................) 
                                   ครูผู้สอน 
          ………./…………/………… 



 

 
 

 

 
 
 

แผนการจัดการเรียนรู้ หน่วยที่   7 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 13-15 
 

ชื่อหน่วย  การทำงานกับวัตถุ
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
การทำงานกับวัตถุสามารถใช้งานวัตถุได้หลายอย่าง ได้แก่  การเลือกวัตถุ การเคลื่อนย้ายวัตถุ การปรับ

ขนาด  การคัดลอง  การหมุน  การกลับภาพ  การบิด  การคร็อป  และการล็อค เป็นต้น การใช้งานวัตถุขั้นพื้นฐาน
เป็นเรื่องท่ีจำเป็นอย่างมาก ในการจัดวางช้ินงานบนหน้ากระดาษ เพราะองค์ประกอบท่ีแสดงอยู่บนหน้ากระดาษ
นั้นเป็นวัตถุท้ังหมด 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 

- 
3.สมรรถนะประจำหน่วย  

1. แสดงความรู้เกี่ยวกับการใช้งานวัตถุด้วยวิธีการต่าง ๆ อย่างเหมาะสม   
  2.  เลือกวัตถุในลักษณะของวัตถุหลาย ๆ รูปแบบ ท้ังวัตถุเดียว หลายวัตถุ เลือกหลายวัตถุพร้อมกัน
ครั้งเดียว  เลือกวัตถุท้ังหมดท่ีอยู่บนหน้ากระดาษ 
  3.  เลือกวิธีการในการปรับขนาดของวัตถุให้เล็กลง หรือใหญ่ขึ้นได้ท้ัง 2 รูปแบบ คือลากเมาส์ และ
ใช้คอนโทรลพาเนล 
  4.  มาก์สรูปภาพให้อยู่ในรูปทรงของเฟรม ท้ัง 3 รูปได้อย่างสวยงาม 

5.  เลือกใช้คำส่ังในการแทรกรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรม 
6.  เลือกใช้เครื่องมือในการควบคุมวัตถุและรูปภาพอย่างเหมาะสม 
7. แสดงพฤติกรรมความสนใจใฝ่รู้  ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็น 

ประชาธิปไตย  และห่างไกลยาเสพติด  

4.จุดประสงค์เชิงพฤติกรรม 
4.1 ด้านความรู้ 

1.เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับการใช้งานวัตถุด้วยวิธีการต่าง ๆ 
2. เพื่อให้มีทักษะในการเลือกวัตถุในลักษณะของวัตถุหลาย ๆ รูปแบบ ท้ังวัตถุเดียว   

หลายวัตถุ เลือกหลายวัตถุพร้อมกันครั้งเดียว  เลือกวัตถุท้ังหมดท่ีอยู่บนหน้ากระดาษ 
3.เพื่อให้มีทักษะในการเลือกวิธีการในการปรับขนาดของวัตถุให้เล็กลง หรือใหญ่ขึ้น 

ได้ท้ัง 2 รูปแบบ คือลากเมาส์ และใช้คอนโทรลพาเนล 
4.เพื่อให้มีทักษะในการมาก์สรูปภาพให้อยู่ในรูปทรงของเฟรม ท้ัง 3 รูปได้อย่าง 

สวยงาม 
5.เพื่อให้มีทักษะในการแทรกรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรม 

เพื่อให้มีทักษะในการเลือกใช้เครื่องมือในการควบคุมวัตถุและรูปภาพอย่างเหมาะสม 
 



 

 
 

4.2 ด้านทักษะ 
1.อธิบายเกี่ยวกับการใช้งานวัตถุด้วยวิธีการต่าง ๆ ได้ 
2.เลือกวัตถุในลักษณะของวัตถุหลาย ๆ รูปแบบ ท้ังวัตถุเดียว  หลายวัตถุ เลือกหลาย 

วัตถุพร้อมกันครั้งเดียว  เลือกวัตถุท้ังหมดท่ีอยู่บนหน้ากระดาษได้ 
3.เลือกวิธีการในการปรับขนาดของวัตถุให้เล็กลง หรือใหญ่ขึ้นได้ท้ัง 2 รูปแบบ คือ 

ลากเมาส์ และใช้คอนโทรลพาเนลได้ 
4.มาก์สรูปภาพให้อยู่ในรูปทรงของเฟรม ท้ัง 3 รูปได้อย่างสวยงามได้ 
5.แทรกรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรมได้ 
6.เลือกใช้เครื่องมือในการควบคุมวัตถุและรูปภาพอย่างเหมาะสมได้ 

 

4.3 คุณลักษณะที่พึงประสงค์ 
   1. ความสนใจใฝ่รู้  
   2. มีความซื่อสัตย์ในการปฏิบัติงาน 
   3. มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
   4.ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

5.สาระการเรียนรู้ 
การทำงานกับวัตถุ 

6.กิจกรรมการเรียนรู้ 
6.1 การนำเข้าสู่บทเรียน 

1.ผู้สอนกล่าวทักทายผู้เรียน เนื่องจากเป็นการสอนครั้งแรก   
2.ผู้สอนตรวจสอบรายช่ือผู้เรียน 
3.ผู้สอนบอกจุดประสงค์รายวิชา มาตรฐานรายวิชา และคำอธิบายรายวิชา 
4.ผู้สอนแจกแบบทดสอบก่อนเรียนเพื่อทดสอบผู้เรียน 

7.สื่อและแหล่งเรียนรู้ 
2.1 หนังสือการผลิตส่ือสิงพิมพ์. ประภาวรรณ เกษวิริยะการณ์. สำนักพิมพ์เมืองไทย 
2.2 ส่ือประกอบการเรียน เช่น VDO,  PowerPoint,  YouTube และอุปกรณ์จริง 

8.หลักฐานการเรียนรู้ 
8.1 หลักฐานความรู้           

   คะแนนจากการตอบคำถามท้ายบทเรียน และแบบทดสอบ ในหนังสือประกอบการเรียน  
8.2 หลักฐานการปฏิบัติงาน 

   คะแนนการทำกิจกรรมการเรียนรู้  และภาพถ่ายการทำกิจกรรมของผู้เรียน  
     9. การวัดและการประเมินผล 

9.1 วิธีวัดและการประเมินผล 
1) ทดสอบก่อนเรียนและหลังเรียน 
2) ตรวจใบงาน 
3) ประเมินการนำเสนอผลงาน 
4) สังเกตพฤติกรรม 



 

 
 

9.2 เคร่ืองมือวัดและการประเมินผล 
1) แบบทดสอบก่อนเรียนและหลังเรียน 
2) ใบงาน 
3) แบบประเมินการนำเสนอผลงาน 
4) แบบสังเกตพฤติกรรม 

9.3 เกณฑ์วัดและการประเมินผล 
1) เกณฑ์การทดสอบก่อนเรียนและหลังเรียน คะแนนผ่านไม่ต่ำกว่า 80% 
2) เกณฑ์การประเมินใบงาน คะแนนผ่านไม่ต่ำกว่า 80% 
3) เกณฑ์การประเมินผลการนำเสนอผลงาน คะแนนผ่านไม่ต่ำกว่า 80% 
4) เกณฑ์การสังเกตพฤติกรรม คะแนนผ่านไม่ต่ำกว่า 80% 

 
10.  บันทึกผลหลังการจัดการเรียนรู้ 

 
10.1 ผลการจัดการเรียนรู้ท่ีเกิดขึ้นกับผู้เรียน 

               
               
               

10.2 ปัญหา อุปสรรคท่ีพบ 
               
               
               

10.3 การแก้ไขปัญหา 
1) ผลการแก้ไขปัญหาทีส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 
 

 

ใบความรู้ที่ 7 หน่วยที่   7 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 13-15 
 

ชื่อหน่วย  การทำงานกับวัตถุ
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
1.  ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

การทำงานกับวัตถุ 
2. อ้างอิงมาตรฐาน / เชื่อมโยงกลุ่มอาชีพ (ถ้ามี) 

 -  
3.สมรรถนะประจำหน่วย  

1. แสดงความรู้เกี่ยวกับการใช้งานวัตถุด้วยวิธีการต่าง ๆ อย่างเหมาะสม   
  2.  เลือกวัตถุในลักษณะของวัตถุหลาย ๆ รูปแบบ ท้ังวัตถุเดียว หลายวัตถุ เลือกหลายวัตถุพร้อมกัน
ครั้งเดียว  เลือกวัตถุท้ังหมดท่ีอยู่บนหน้ากระดาษ 
  3.  เลือกวิธีการในการปรับขนาดของวัตถุให้เล็กลง หรือใหญ่ขึ้นได้ท้ัง 2 รูปแบบ คือลากเมาส์ และ
ใช้คอนโทรลพาเนล 
  4.  มาก์สรูปภาพให้อยู่ในรูปทรงของเฟรม ท้ัง 3 รูปได้อย่างสวยงาม 

5.  เลือกใช้คำส่ังในการแทรกรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรม 
6.  เลือกใช้เครื่องมือในการควบคุมวัตถุและรูปภาพอย่างเหมาะสม 
7. แสดงพฤติกรรมความสนใจใฝ่รู้  ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็น 

ประชาธิปไตย  และห่างไกลยาเสพติด  

4.จุดประสงค์เชิงพฤติกรรม 
4.1 ด้านความรู้ 

1.เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับการใช้งานวัตถุด้วยวิธีการต่าง ๆ 
2. เพื่อให้มีทักษะในการเลือกวัตถุในลักษณะของวัตถุหลาย ๆ รูปแบบ ท้ังวัตถุเดียว   

หลายวัตถุ เลือกหลายวัตถุพร้อมกันครั้งเดียว  เลือกวัตถุท้ังหมดท่ีอยู่บนหน้ากระดาษ 
3.เพื่อให้มีทักษะในการเลือกวิธีการในการปรับขนาดของวัตถุให้เล็กลง หรือใหญ่ขึ้น 

ได้ท้ัง 2 รูปแบบ คือลากเมาส์ และใช้คอนโทรลพาเนล 
4.เพื่อให้มีทักษะในการมาก์สรูปภาพให้อยู่ในรูปทรงของเฟรม ท้ัง 3 รูปได้อย่าง 

สวยงาม 
5.เพื่อให้มีทักษะในการแทรกรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรม 

เพื่อให้มีทักษะในการเลือกใช้เครื่องมือในการควบคุมวัตถุและรูปภาพอย่างเหมาะสม 
 
4.2 ด้านทักษะ 

1.อธิบายเกี่ยวกับการใช้งานวัตถุด้วยวิธีการต่าง ๆ ได้ 



 

 
 

2.เลือกวัตถุในลักษณะของวัตถุหลาย ๆ รูปแบบ ท้ังวัตถุเดียว  หลายวัตถุ เลือกหลาย 
วัตถุพร้อมกันครั้งเดียว  เลือกวัตถุท้ังหมดท่ีอยู่บนหน้ากระดาษได้ 

3.เลือกวิธีการในการปรับขนาดของวัตถุให้เล็กลง หรือใหญ่ขึ้นได้ท้ัง 2 รูปแบบ คือ 
ลากเมาส์ และใช้คอนโทรลพาเนลได้ 

4.มาก์สรูปภาพให้อยู่ในรูปทรงของเฟรม ท้ัง 3 รูปได้อย่างสวยงามได้ 
5.แทรกรูปภาพจากภายนอกเข้ามาใช้งานในโปรแกรมได้ 
6.เลือกใช้เครื่องมือในการควบคุมวัตถุและรูปภาพอย่างเหมาะสมได้ 

 

4.3 คุณลักษณะที่พึงประสงค์ 
   1. ความสนใจใฝ่รู้  
   2. มีความซื่อสัตย์ในการปฏิบัติงาน 
   3. มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
   4.ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 
 
5. เนือ้หาสาระ 

 4.1 การเลือกวัตถุ 
  4.1.1  การเลือกวัตถุเดียว 
  1. คลิกเลือกเครื่องมือซีเล็กชันทูล (Selection Tool) 

  2. คลิกเมาส์เลือกวัตถุท่ีต้องการ 
   3. ปรากฏแฮนเดิล (Handle) บริเวณวัตถุท่ีเลือก 
 

   4.1.2  การเลือกวัตถุหลายวัตถุ 
   1. คลิกเลือกเครื่องมือซีเล็กชันทูล 
  2. คลิกเลือกวัตถุช้ินแรก 

 3.  กดปุ่มชิฟต์ (Shift) แล้วคลิกเลือกวัตถุช้ินต่อไปท่ีต้องการเลือกจะปรากฏแฮนเดิล 
บริเวณวัตถุท้ังหมดท่ีถูกเลือก 
 

 4.2  การปรับขนาดวัตถุ 
  การใช้เมาส์ปรับขนาดวัตถุ 

1. คลิกเมาส์ท่ีซีเล็กชันทูล จะปรากฏแฮนเดิล รอบวัตถุท่ีจะเคล่ือนย้าย 
2. คลิกท่ีสัญลักษณ์  ตัวชี้เมาส์จะเปล่ียนเป็น เพื่อปรับขนาดวัตถุ 
3. เมื่อปล่อยเมาส์จะได้วัตถุท่ีมีขนาดตามท่ีต้องการ 

 

 ปรับขนาดวัตถุจากคอนโทรลพาเนล 
1. คลิกเลือกเครื่องมือซีเล็กชันทูล 

 2. คลิกเลือกวัตถ ุ
 3. คลิกเมาส์เลือกจุดอ้างอิง (Proxy) บนคอนโทรลพาเนล 
 4.  ระบุค่าความกว้างและความสูงของวัตถุ 
 5. วัตถุท่ีได้จะมีขนาดความกว้างและความสูงตามท่ีกำหนดค่าไว้ 
 

 4.3  การมาสก์วัตถุ 



 

 
 

   1. เลือกรูปภาพท่ีต้องการมาสก์ 
   2.  คลิกเลือกเครื่องมือสร้างเฟรมตามรูปแบบท่ีต้องการ ในท่ีนี้ให้เลือกเฟรมเป็นแบบวงกลม 
 3. วาดวงกลมในบริเวณภาพเฉพาะท่ีต้องการมาสก์ 
4. คลิกเลือกภาพ และคลิกเลือกคำส่ังเอดิท > ก๊อปป้ี (Edit > Copy) 
 5. คลิกเลือกวงกลมท่ีอยู่บนภาพ แล้วเลือกคำส่ังเอดิท > เพสต์ อินทู (Edit > Paste Into) 
   6.  ภาพในบริเวณท่ีมาสก์จะปรากฏในวงกลม และคลิกลากวงกลมออกจากพื้นท่ีรูปภาพเดิม   
 4.4 การจัดลำดับการซ้อนวัตถุ 
 การจัดลำดับการซ้อนวัตถุขึ้นมา 1 ระดับ 

1. เลือกวัตถุท่ีอยู่ล่างสุด 
2. คลิกเลือกคำส่ังออบเจ็กต์ > อาร์เรนจ์ > ฟอร์เวิร์ด (Object > Arrange > Forward)  
 
การจัดลำดับการซ้อนวัตถุขึ้นมาอยู่บนสุด 
1. เลือกวัตถุท่ีอยู่ล่างสุด 
2. คลิกคำส่ังออบเจ็กต์ > อาร์เรนจ์ > บริงทูฟรอนท์ (Object > Arrange > Bring to Front) 
3. วัตถุจะเล่ือนขึ้นมาบนสุด 
 

การจัดลำดับการซ้อนวัตถุลงไป 1 ระดับ 
  1. เลือกวัตถุท่ีอยู่บนสุด 
 2.  คลิกเลือกคำส่ังออบเจ็กต์ > อาร์เรนจ์ > เซนด์ แบ็กเวิร์ด (Object > Arrange > Send  
Backward) 
 3. วัตถุจะเล่ือนลงไป 1 ระดับ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 
 
 
6. แบบทดสอบ/แบบฝึกหัด 
จากโจทย์คำถาม จงเลือกคำตอบที่ถูกต้องที่สุด 

แบบฝึกหัดหน่วยที่ 7 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. เครื่องมือชนิดใดใช้คลิกเลือกวัตถุ   
 ก.  แฮนด์ทูล (Hand Tool) 
 ข.  ซีเล็กชันทูล (Selection Tool)  
 ค.  เฟรมทูล (Frame Tool) 
 ง.  ไดเร็ก ซีเล็กชันทูล (Direc Selection Tool) 
2. ข้อใดอธิบายการใช้เครื่องมือกับวัตถุได้ถูกต้อง     
 ก.  การใช้เครื่องมือฟลิพเวอทิเคิล (Flip Vertical) เพื่อกลับด้านวัตถุแนวนอน 
 ข.  การใช้เครื่องมือซีเล็กชันทูล (Selection Tool) เพื่อเลือกวัตถุ 
 ค.  การใช้เครื่องมือเชียร์ทูล (Shear Tool) เพื่อหมุนวัตถุ 
 ง.  การใช้เครื่องมือโรเทตทูล (Rotate Tool) เพื่อบิดวัตถุ 
3. เครื่องมือชนิดใดในกล่องเครื่องมือท่ีใช้สำหรับบิดรูปทรงวัตถุ 
 ก.  แฮนด์ทูล (Hand Tool) 
 ข. สเกลทูล (Scale Tool) 
 ค.  เชียร์ทูล (Shear Tool) 
 ง.  โรเทตทูล (Rotate Tool) 
4. เมื่อมีการเปล่ียนแปลงจุดอ้างอิงบนคอนโทรลพาเนลจะมีผลกับวัตถุอย่างไร 
 ก.  วัตถุจะมีการขยายขนาดให้ใหญ่ขึ้นหรือเล็กลง  
 ข.  วัตถุจะถูกคัดลอกให้มีจำนวนเพิ่มมากขึ้น 
 ค.  วัตถุจะสามารถเคล่ือนย้ายไปยังตำแหน่งต่าง ๆ 
 ง.  เป็นการบิดรูปร่างของวัตถุตามจุดอ้างอิง 
5.   สัญลักษณ์          เป็นสัญลักษณ์ท่ีเหมาะกับการใช้งานในลักษณะใด 
 ก.  การขยายวัตถุให้มีขนาดใหญ่ขึ้น ข.  การพลิกกลับด้านวัตถุในแนวตั้ง 
 ค. การพลิกกลับด้านวัตถุในแนวนอน ง.  การหมุนวัตถุในองศาท่ีต้องการ 
 

 
 
 
 
 
 
 
 



 

 
 

 
 
 
 
7.  เอกสารอ้างอิง (ขึ้นหน้าใหม่) 
วิชาการผลิตสื่อดิจิทัล 
8.ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ) 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. เครื่องมือชนิดใดใช้คลิกเลือกวัตถุ   
 ก.  แฮนด์ทูล (Hand Tool) 
 ข.  ซีเล็กชันทูล (Selection Tool)  
 ค.  เฟรมทูล (Frame Tool) 
 ง.  ไดเร็ก ซีเล็กชันทูล (Direc Selection Tool) 
2. ข้อใดอธิบายการใช้เครื่องมือกับวัตถุได้ถูกต้อง     
 ก.  การใช้เครื่องมือฟลิพเวอทิเคิล (Flip Vertical) เพื่อกลับด้านวัตถุแนวนอน 
 ข.  การใช้เครื่องมือซีเล็กชันทูล (Selection Tool) เพื่อเลือกวัตถุ 
 ค.  การใช้เครื่องมือเชียร์ทูล (Shear Tool) เพื่อหมุนวัตถุ 
 ง.  การใช้เครื่องมือโรเทตทูล (Rotate Tool) เพื่อบิดวัตถุ 
3. เครื่องมือชนิดใดในกล่องเครื่องมือท่ีใช้สำหรับบิดรูปทรงวัตถุ 
 ก.  แฮนด์ทูล (Hand Tool) 
 ข. สเกลทูล (Scale Tool) 
 ค.  เชียร์ทูล (Shear Tool) 
 ง.  โรเทตทูล (Rotate Tool) 
4. เมื่อมีการเปล่ียนแปลงจุดอ้างอิงบนคอนโทรลพาเนลจะมีผลกับวัตถุอย่างไร 
 ก.  วัตถุจะมีการขยายขนาดให้ใหญ่ขึ้นหรือเล็กลง  
 ข.  วัตถุจะถูกคัดลอกให้มีจำนวนเพิ่มมากขึ้น 
 ค.  วัตถุจะสามารถเคล่ือนย้ายไปยังตำแหน่งต่าง ๆ 
 ง.  เป็นการบิดรูปร่างของวัตถุตามจุดอ้างอิง 
5.   สัญลักษณ์          เป็นสัญลักษณ์ท่ีเหมาะกับการใช้งานในลักษณะใด 
 ก.  การขยายวัตถุให้มีขนาดใหญ่ขึ้น ข.  การพลิกกลับด้านวัตถุในแนวตั้ง 
 ค. การพลิกกลับด้านวัตถุในแนวนอน ง.  การหมุนวัตถุในองศาท่ีต้องการ 
 
 
 
 
 
 
 
 



 

 
 

 
 
 

 

ใบงานที่ 7 หน่วยที่   7 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 13-15 
 

ชื่อหน่วย  การทำงานกับวัตถุ
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
ใบงานที่  7 

คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. เครื่องมือชนิดใดใช้คลิกเลือกวัตถุ   
 ก.  แฮนด์ทูล (Hand Tool) 
 ข.  ซีเล็กชันทูล (Selection Tool)  
 ค.  เฟรมทูล (Frame Tool) 
 ง.  ไดเร็ก ซีเล็กชันทูล (Direc Selection Tool) 
2. ข้อใดอธิบายการใช้เครื่องมือกับวัตถุได้ถูกต้อง     
 ก.  การใช้เครื่องมือฟลิพเวอทิเคิล (Flip Vertical) เพื่อกลับด้านวัตถุแนวนอน 
 ข.  การใช้เครื่องมือซีเล็กชันทูล (Selection Tool) เพื่อเลือกวัตถุ 
 ค.  การใช้เครื่องมือเชียร์ทูล (Shear Tool) เพื่อหมุนวัตถุ 
 ง.  การใช้เครื่องมือโรเทตทูล (Rotate Tool) เพื่อบิดวัตถุ 
3. เครื่องมือชนิดใดในกล่องเครื่องมือท่ีใช้สำหรับบิดรูปทรงวัตถุ 
 ก.  แฮนด์ทูล (Hand Tool) 
 ข. สเกลทูล (Scale Tool) 
 ค.  เชียร์ทูล (Shear Tool) 
 ง.  โรเทตทูล (Rotate Tool) 
4. เมื่อมีการเปล่ียนแปลงจุดอ้างอิงบนคอนโทรลพาเนลจะมีผลกับวัตถุอย่างไร 
 ก.  วัตถุจะมีการขยายขนาดให้ใหญ่ขึ้นหรือเล็กลง  
 ข.  วัตถุจะถูกคัดลอกให้มีจำนวนเพิ่มมากขึ้น 
 ค.  วัตถุจะสามารถเคล่ือนย้ายไปยังตำแหน่งต่าง ๆ 
 ง.  เป็นการบิดรูปร่างของวัตถุตามจุดอ้างอิง 
5.   สัญลักษณ์          เป็นสัญลักษณ์ท่ีเหมาะกับการใช้งานในลักษณะใด 
 ก.  การขยายวัตถุให้มีขนาดใหญ่ขึ้น ข.  การพลิกกลับด้านวัตถุในแนวตั้ง 
 ค. การพลิกกลับด้านวัตถุในแนวนอน ง.  การหมุนวัตถุในองศาท่ีต้องการ 
 

 
 
 
 



 

 
 

 
 
 
 

บันทึกผลหลังการจัดการเรียนรู้ 
 

 ผลการจัดการเรียนรู้ตามแผนการสอน 
  1) วัน เดือน ปี ...............สอนครั้งท่ี .../.... สาขา/ช้ันปี  .....................จำนวนผู้เรียน..........คน    
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน 

2) หัวข้อเรื่อง/เนื้อหาสาระ :  ........................................................................................................... 
  ❑ สอนครบตามหัวข้อเรื่องในแผนฯ  ❑ สอนไม่ครบเนื่องจาก........................................ 
  3) กิจกรรม/วิธีการสอน 
   ❑ ครูแนะนำและบอกจุดประสงค์     ❑ ครูอธิบาย/ถาม-ตอบ/สาธิต/ 
   ❑ ทำแบบทดสอบก่อนเรียน      ❑ ทำแบบทดสอบหลังเรียน 
   ❑ ทำแบบฝึกหัด/โจทย์ปัญหา      ❑ ทำใบกิจกรรม/ใบงาน 
   ❑ อื่น ๆ (ระบ)ุ................................................................................................................... 
  4) ส่ือการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………………….......... 
  ....................................................................................................................................................... 
 11.2 ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาที่พบ 
  1) การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ………………………………………………..…….. 
       ........................................................................................................................................................ 
  2) สมรรถนะท่ีผู้เรียนได้รับ : .......................................................................................................... 
      .......................................................................................................................................................... 
  3) สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..…………………………………………………………..…..... 
      ……………....................................................................................................................................... 
  4) ผลการสอนของครู : ..……………………………………………………………………………………..…….……. 
      ……………........................................................................................................................................... 
  5) ปัญหาท่ีนำไปสู่การวิจัย : ..………………………………………………………………………………..….……... 
 11.3 แนวทางการพัฒนาคุณภาพการสอน/แก้ปัญหา 
  1) ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : .…………………………………………………………………... 
   
  2) แนวทางพัฒนาคุณภาพวิธีสอน/ส่ือ/การวัดผล/เอกสารช่วยสอน   
       …………….......................................................................................................................................... 
  

                                                      ลงช่ือ 
 

                      (.........................................) 
                                   ครูผู้สอน 
          ………./…………/………… 



 

 
 

 

 
 
 

แผนการจัดการเรียนรู้ หน่วยที่   8 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 16-17 
 

ชื่อหน่วย  การทำงานกับวัตถุ
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
การจัดวางภาพ ข้อความและวัตถุเป็นส่วนประกอบอื่น ๆ ท่ีซ้อนกันอยู่ให้ลงตัวมากยิ่งขึ้น เรียกการทำงาน

นี้ว่า “เลเยอร์ ซึ่งช่วยอำนวยความสะดวกในการจัดวางภาพและวัตถุแต่ละส่วนที่วางซ้อนกันอยู่เป็นชั้น ๆ ทำให้
สามารถทำงานกับวัตถุเฉพาะส่วนได้โดยไม่มีผลกระทบกับส่วนอื่น ๆ ท่ีไม่เกี่ยวข้อง 
 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 

- 
3.สมรรถนะประจำหน่วย  

1. แสดงความรู้เกี่ยวกับความหมายของเลเยอร์ ในโปรแกรม Adobe Indesign 
2.  เลือกใช้คำส่ังและเครื่องมือในการทำงานกับเลเยอร์อย่างเหมาะสม 
3.  ลำดับข้ันตอนการสร้างลเยอร์และสร้างช้ินงานด้วยเลเยอร์  
4.  ลบเลเยอร์ท่ีต้องการด้วยคำส่ังและเครื่องมือของโปรแกรม  

4.จุดประสงค์เชิงพฤติกรรม 
4.1 ด้านความรู้ 

1.เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับความหมายของเลเยอร์ ในโปรแกรม Adobe Indesign 
2.เพื่อให้มีความรู้ความเข้าใจเกี่ยวกับประโยชน์ของเลเยอร์ 
3.เพื่อให้มีทักษะในการใช้คำส่ังและเครื่องมือท่ีใช้งานเกี่ยวกับเลเยอร์ 
4.เพื่อให้มีทักษะในการสร้าง ลบ และใช้งานเลเยอร์ 

 
4.2 ด้านทักษะ 

1.อธิบายเกี่ยวกับความหมายของเลเยอร์ในโปรแกรม Indesign ได้ 
2.อธิบายเกี่ยวกับประโยชน์ของเลเยอร์ได้ 
3.ใช้คำส่ังและเครื่องมือท่ีใช้งานเกี่ยวกับเลเยอร์ได้ 
4เรียงลำดับข้ันตอนการสร้างลเยอร์และสร้างช้ินงานด้วยเลเยอร์เพื่อสร้างเป็นแผ่นโฆษณาได้ 
5.สร้าง ลบ และใช้งานเลเยอร์ได้ 

 

4.3 คุณลักษณะที่พึงประสงค์ 
   1. ความสนใจใฝ่รู้  
   2. มีความซื่อสัตย์ในการปฏิบัติงาน 
   3. มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
   4.ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 



 

 
 

5.สาระการเรียนรู้ 
การใช้งานเลเยอร์ 

6.กิจกรรมการเรียนรู้ 
6.1 การนำเข้าสู่บทเรียน 

1.ผู้สอนกล่าวทักทายผู้เรียน เนื่องจากเป็นการสอนครั้งแรก   
2.ผู้สอนตรวจสอบรายช่ือผู้เรียน 
3.ผู้สอนบอกจุดประสงค์รายวิชา มาตรฐานรายวิชา และคำอธิบายรายวิชา 
4.ผู้สอนแจกแบบทดสอบก่อนเรียนเพื่อทดสอบผู้เรียน 

7.สื่อและแหล่งเรียนรู้ 
2.1 หนังสือการผลิตส่ือสิงพิมพ์. ประภาวรรณ เกษวิริยะการณ์. สำนักพิมพ์เมืองไทย 
2.2 ส่ือประกอบการเรียน เช่น VDO,  PowerPoint,  YouTube และอุปกรณ์จริง 

8.หลักฐานการเรียนรู้ 
8.1 หลักฐานความรู้           

   คะแนนจากการตอบคำถามท้ายบทเรียน และแบบทดสอบ ในหนังสือประกอบการเรียน  
8.2 หลักฐานการปฏิบัติงาน 

   คะแนนการทำกิจกรรมการเรียนรู้  และภาพถ่ายการทำกิจกรรมของผู้เรียน  
     9. การวัดและการประเมินผล 

9.1 วิธีวัดและการประเมินผล 
1) ทดสอบก่อนเรียนและหลังเรียน 
2) ตรวจใบงาน 
3) ประเมินการนำเสนอผลงาน 
4) สังเกตพฤติกรรม 

9.2 เคร่ืองมือวัดและการประเมินผล 
1) แบบทดสอบก่อนเรียนและหลังเรียน 
2) ใบงาน 
3) แบบประเมินการนำเสนอผลงาน 
4) แบบสังเกตพฤติกรรม 

9.3 เกณฑ์วัดและการประเมินผล 
1) เกณฑ์การทดสอบก่อนเรียนและหลังเรียน คะแนนผ่านไม่ต่ำกว่า 80% 
2) เกณฑ์การประเมินใบงาน คะแนนผ่านไม่ต่ำกว่า 80% 
3) เกณฑ์การประเมินผลการนำเสนอผลงาน คะแนนผ่านไม่ต่ำกว่า 80% 
4) เกณฑ์การสังเกตพฤติกรรม คะแนนผ่านไม่ต่ำกว่า 80% 

 
10.  บันทึกผลหลังการจัดการเรียนรู้ 

 
10.1 ผลการจัดการเรียนรู้ท่ีเกิดขึ้นกับผู้เรียน 

               



 

 
 

               
               

10.2 ปัญหา อุปสรรคท่ีพบ 
               
               
               

10.3 การแก้ไขปัญหา 
1) ผลการแก้ไขปัญหาทีส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

ใบความรู้ที่ 8 หน่วยที่   8 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 16-17 
 

ชื่อหน่วย  การทำงานกับวัตถุ
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
1.  ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

 การใช้งานเลเยอร์ 
2. อ้างอิงมาตรฐาน / เชื่อมโยงกลุ่มอาชีพ (ถ้ามี) 

 -  
3.สมรรถนะประจำหน่วย  

1. แสดงความรู้เกี่ยวกับความหมายของเลเยอร์ ในโปรแกรม Adobe Indesign 
2.  เลือกใช้คำส่ังและเครื่องมือในการทำงานกับเลเยอร์อย่างเหมาะสม 
3.  ลำดับข้ันตอนการสร้างลเยอร์และสร้างช้ินงานด้วยเลเยอร์  
4.  ลบเลเยอร์ท่ีต้องการด้วยคำส่ังและเครื่องมือของโปรแกรม  

4.จุดประสงค์เชิงพฤติกรรม 
4.1 ด้านความรู้ 

1.เพื่อให้มีความรู้และความเข้าใจเกี่ยวกับความหมายของเลเยอร์ ในโปรแกรม Adobe Indesign 
2.เพื่อให้มีความรู้ความเข้าใจเกี่ยวกับประโยชน์ของเลเยอร์ 
3.เพื่อให้มีทักษะในการใช้คำส่ังและเครื่องมือท่ีใช้งานเกี่ยวกับเลเยอร์ 
4.เพื่อให้มีทักษะในการสร้าง ลบ และใช้งานเลเยอร์ 

 
4.2 ด้านทักษะ 

1.อธิบายเกี่ยวกับความหมายของเลเยอร์ในโปรแกรม Indesign ได้ 
2.อธิบายเกี่ยวกับประโยชน์ของเลเยอร์ได้ 
3.ใช้คำส่ังและเครื่องมือท่ีใช้งานเกี่ยวกับเลเยอร์ได้ 
4เรียงลำดับข้ันตอนการสร้างลเยอร์และสร้างช้ินงานด้วยเลเยอร์เพื่อสร้างเป็นแผ่นโฆษณาได้ 
5.สร้าง ลบ และใช้งานเลเยอร์ได้ 

 

4.3 คุณลักษณะที่พึงประสงค์ 
   1. ความสนใจใฝ่รู้  
   2. มีความซื่อสัตย์ในการปฏิบัติงาน 
   3. มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
   4.ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 
 
 
 
 



 

 
 

5. เนือ้หาสาระ 
 ความหมายของเลเยอร์ 
   เลเยอร์ (Layer) เป็นการนำภาพหรือวัตถุมาจัดวางเป็นส่วนประกอบท่ีเรียงซ้อนกันอย่างลงตัว  
เลเยอร์ช่วยอำนวยความสะดวกในการจัดวางภาพและวัตถุแต่ละช้ินท่ีวางซ้อนกัน ให้สามารถทำงานกับวัตถุเฉพาะ
ส่วนได้โดยท่ีไม่กระทบกับส่วนอื่นท่ีไม่เกี่ยวข้อง 
   ลักษณะการทำงานแบบเลเยอร์ เป็นเหมือนการวางแผ่นใสซ้อนทับกันเป็นลำดับช้ันขึ้นมาเรื่อย ๆ โดยแต่
ละแผ่นใสเปรียบเสมือนเป็นแต่ละเลเยอร์ บริเวณของเลเยอร์ที่ไม่มีรูป จะเห็นทะลุถึง เลเยอร์ที่อยู่ด้านล่าง โดย
กระบวนการเช่นนี้ จะทำให้เกิดเป็นรูปภาพสมบูรณ์ และทำให้สามารถจัดวางงานได้ง่าย 
 เลเยอร์เป็นตัวช่วยในการแก้ไขภาพเฉพาะส่วนใดส่วนหนึ่งได้ง่ายขึ้น การย้ายตำแหน่ง การปรับขนาด 
การปรับสี/แสงเงา จะทำได้อย่างอิสระจากกัน นอกจากนี้ ยังสามารถสลับลำดับ และซ่อน/แสดง     เลเยอร์แต่ละ
ช้ัน ทำให้ทดลองจัดองค์ประกอบภาพแบบต่าง ๆ ได้หลากหลายก่อนท่ีจะเลือกภาพชุดสุดท้ายท่ีจะนำไปใช้จริง 
 
 ประโยชน์ของเลเยอร์ 
 ในการผลิตส่ือส่ิงพิมพ์ ผู้ผลิตมีความจำเป็นจะต้องแก้ไขรายละเอียดเฉพาะในบางส่วนของช้ินงาน  ไม่
จำเป็นต้องสร้างช้ินงานนั้นใหม่ท้ังหมด แต่สามารถสร้างเฉพาะเลเยอร์ของวัตถุท่ีต้องการแก้ไขหรือเพิ่มเติมเท่านั้น 
เช่น แผ่นพับ ใบปลิวโฆษณาท่ีต้องมีการเปล่ียนแปลงโปรโมช่ันรูปแบบใหม่ ๆ เป็นประจำ ซึ่งรายเอียดของช้ินงาน
ส่วนใหญ่นั้นยังคงเหมือนเดิม เพียงแต่เปล่ียนเฉพาะส่วนของภาพหรือข้อความใหม่ในโปรโมช่ันเท่านั้น ผู้ใช้สามารถ
สร้างเลเยอร์ใหม่มาทดแทนได้ และซ่อนเลเยอร์เดิมไว้เพื่ออาจจะนำมาใช้ได้อีกในภายหน้า โดยไม่ต้องเสียเวลาทำ
ใหมท้ั่งหมด 
  การสร้างชิ้นงานด้วยเลเยอร์ 

1.   การเริ่มต้นใช้งานพาเนลเลเยอร์ ด้วยการคลิกท่ีเมนูคำส่ังวินโดว์ > เลเยอร์ (Window >  
Layers) 

2. คลิกท่ีพาเนลเลเยอร์ ดับเบิลคลิกท่ีเลเยอร์ 1  
3. ปรากฏหน้าต่างเลเยอร์ ออปชัน (Layer Options) 
4. ต้ังช่ือเลเยอร์ และเลือกสีประจำเลเยอร์ 
5. นำรูปภาพวางบนพื้นท่ีอาร์ตบอร์ด ในเลเยอร์ 1 
6. คลิกท่ี  เพื่อสร้างเลเยอร์ 2 
7. ดับเบิลคลิกท่ีเลเยอร์ 2 จะปรากฏหน้าต่างเลเยอร์ ออปชัน เพื่อตั้งช่ือเลเยอร์และเลือก 

สีประจำเลเยอร์ 
8. นำรูปภาพมาวางบนพื้นท่ีอาร์ตบอร์ด ในเลเยอร์ 2 
9. คลิกท่ี  เพื่อสร้างเลเยอร์ 3 
10. ดับเบิลคลิกท่ีเลเยอร์ 3 จะปรากฏหน้าต่างเลเยอร์ ออปชัน ต้ังช่ือเลเยอร์และเลือกสี 

ประจำเลเยอร์ 
 

11. .  สร้างตัวอักษรด้วยการคลิกไทป์ทูล พิมพ์ข้อความลงบนพื้นท่ีออปชัน ในเลเยอร์ 3 
 

12. คลิกเครื่องมือพรีวิว (Preview) จากกล่องเครื่องมือเพื่อดูผลลัพธ์จากการสร้างเลเยอร์ 
 
   



 

 
 

การลบเลเยอร์ 
  ลบเลเยอร์และลบวัตถุทั้งหมดในเลเยอร์ 
       การลบเลเยอร์และวัตถุท้ังหมดในเลเยอร์ สามารถทำได้ดังนี้ 
    1. คลิกเลือกเลเยอร์ท่ีต้องการลบ เพื่อลบเลเยอร์และวัตถุท้ังหมดในเลเยอร์ 
        2.  คลิกท่ีสัญลักษณ์  เพื่อลบเลเยอร์ท่ีเลือกไว้ 
      3.  คลิกยืนยันการลบ 
  4. เลเยอร์ท่ีเลือกไว้จะถูกลบหายไป 
  5. วัตถุในเลเยอร์จะหายไปพร้อมกับเลเยอร์ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

6. แบบทดสอบ/แบบฝึกหัด 
จากโจทย์คำถาม จงเลือกคำตอบที่ถูกต้องที่สุด 

แบบฝึกหัดหน่วยที่ 8 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. เลเยอร์คืออะไร 
 ก. การจัดวางรูปภาพหรือวัตถุซ้อนกันอย่างลงตัว 
 ข. การตกแต่งรูปภาพหรือวัตถุให้มีลักษณะใกล้เคียงกัน 
 ค. การจัดวางรูปภาพหรือวัตถุท่ีอยู่คนละหน้าให้ซ้อนกัน 
 ง. การจัดวางรูปภาพหรือวัตถุท่ีมีขนาดพอดีกับพื้นท่ีการทำงาน 
2. ข้อใดอธิบายถึงประโยชน์ของเลเยอร์ได้ถูกต้อง 
 ก. รูปภาพหรือวัตถุมีความสมบูรณ์ 
 ข. แสดงตำแหน่งของวัตถุได้ชัดเจน 
 ค. ช่วยทำให้รูปภาพแสดงได้เสมือนจริง 
 ง. แก้ไขภาพเฉพาะส่วนใดส่วนหนึ่งได้ง่ายข้ึน 
3.  จากภาพเป็นสัญลักษณ์ท่ีใช้ในการทำงานอย่างไร           
 ก. เป็นการสร้างเลเยอร์ใหม่ 
 ข. เป็นการซ่อนและแสดงเลเยอร์ 
 ค. เป็นการแทรกภาพจากเลเยอร์อื่น ๆ 
 ง. เป็นการแสดงการล็อกป้องกันการเคล่ือนย้ายและแก้ไขวัตถุ 
4. ข้อใดอธิบายการใช้คำส่ังซีเล็กชัน ไอเท็ม ออน เลเยอร์ (Selection Item on Layer) ได้ถูกต้อง 
 ก. เป็นคำส่ังในการเลือกวัตถุ 
 ข. เป็นคำส่ังในการเลือกเลเยอร์ 
 ค. เป็นคำส่ังท่ีใช้เลือกเลเยอร์ท้ังหมด 
 ง. เป็นคำส่ังท่ีใช้เลือกวัตถุท้ังหมดบนเลเยอร์ 

5.  จากภาพในส่วนท่ีวงกลมไว้ ข้อใดอธิบายวิธีการใช้งานได้ถูกต้อง     
 ก. การเติมสีกับวัตถุบนเลเยอร์ ข. การปรับขนาดของเลเยอร์ 
 ค. การวางตำแหน่งวัตถุบนเลเยอร์ ง. การแสดงตำแหน่งเลเยอร์ปัจจุบัน 

 
 
 
 
 
 
 

 
 
 
 



 

 
 

7.  เอกสารอ้างอิง (ขึ้นหน้าใหม่) 
วิชาการผลิตสื่อดิจิทัล 
8.ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ) 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. เลเยอร์คืออะไร 
 ก. การจัดวางรูปภาพหรือวัตถุซ้อนกันอย่างลงตัว 
 ข. การตกแต่งรูปภาพหรือวัตถุให้มีลักษณะใกล้เคียงกัน 
 ค. การจัดวางรูปภาพหรือวัตถุท่ีอยู่คนละหน้าให้ซ้อนกัน 
 ง. การจัดวางรูปภาพหรือวัตถุท่ีมีขนาดพอดีกับพื้นท่ีการทำงาน 
2. ข้อใดอธิบายถึงประโยชน์ของเลเยอร์ได้ถูกต้อง 
 ก. รูปภาพหรือวัตถุมีความสมบูรณ์ 
 ข. แสดงตำแหน่งของวัตถุได้ชัดเจน 
 ค. ช่วยทำให้รูปภาพแสดงได้เสมือนจริง 
 ง. แก้ไขภาพเฉพาะส่วนใดส่วนหนึ่งได้ง่ายข้ึน 
3.  จากภาพเป็นสัญลักษณ์ท่ีใช้ในการทำงานอย่างไร           
 ก. เป็นการสร้างเลเยอร์ใหม่ 
 ข. เป็นการซ่อนและแสดงเลเยอร์ 
 ค. เป็นการแทรกภาพจากเลเยอร์อื่น ๆ 
 ง. เป็นการแสดงการล็อกป้องกันการเคล่ือนย้ายและแก้ไขวัตถุ 
4. ข้อใดอธิบายการใช้คำส่ังซีเล็กชัน ไอเท็ม ออน เลเยอร์ (Selection Item on Layer) ได้ถูกต้อง 
 ก. เป็นคำส่ังในการเลือกวัตถุ 
 ข. เป็นคำส่ังในการเลือกเลเยอร์ 
 ค. เป็นคำส่ังท่ีใช้เลือกเลเยอร์ท้ังหมด 
 ง. เป็นคำส่ังท่ีใช้เลือกวัตถุท้ังหมดบนเลเยอร์ 

5.  จากภาพในส่วนท่ีวงกลมไว้ ข้อใดอธิบายวิธีการใช้งานได้ถูกต้อง     
 ก. การเติมสีกับวัตถุบนเลเยอร์ ข. การปรับขนาดของเลเยอร์ 
 ค. การวางตำแหน่งวัตถุบนเลเยอร์ ง. การแสดงตำแหน่งเลเยอร์ปัจจุบัน 

 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

ใบงานที่ 8 หน่วยที่   8 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 16-17 
 

ชื่อหน่วย  การทำงานกับวัตถุ
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
ใบงานที่  8 

คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว 
1. เลเยอร์คืออะไร 
 ก. การจัดวางรูปภาพหรือวัตถุซ้อนกันอย่างลงตัว 
 ข. การตกแต่งรูปภาพหรือวัตถุให้มีลักษณะใกล้เคียงกัน 
 ค. การจัดวางรูปภาพหรือวัตถุท่ีอยู่คนละหน้าให้ซ้อนกัน 
 ง. การจัดวางรูปภาพหรือวัตถุท่ีมีขนาดพอดีกับพื้นท่ีการทำงาน 
2. ข้อใดอธิบายถึงประโยชน์ของเลเยอร์ได้ถูกต้อง 
 ก. รูปภาพหรือวัตถุมีความสมบูรณ์ 
 ข. แสดงตำแหน่งของวัตถุได้ชัดเจน 
 ค. ช่วยทำให้รูปภาพแสดงได้เสมือนจริง 
 ง. แก้ไขภาพเฉพาะส่วนใดส่วนหนึ่งได้ง่ายข้ึน 
3.  จากภาพเป็นสัญลักษณ์ท่ีใช้ในการทำงานอย่างไร           
 ก. เป็นการสร้างเลเยอร์ใหม่ 
 ข. เป็นการซ่อนและแสดงเลเยอร์ 
 ค. เป็นการแทรกภาพจากเลเยอร์อื่น ๆ 
 ง. เป็นการแสดงการล็อกป้องกันการเคล่ือนย้ายและแก้ไขวัตถุ 
4. ข้อใดอธิบายการใช้คำส่ังซีเล็กชัน ไอเท็ม ออน เลเยอร์ (Selection Item on Layer) ได้ถูกต้อง 
 ก. เป็นคำส่ังในการเลือกวัตถุ 
 ข. เป็นคำส่ังในการเลือกเลเยอร์ 
 ค. เป็นคำส่ังท่ีใช้เลือกเลเยอร์ท้ังหมด 
 ง. เป็นคำส่ังท่ีใช้เลือกวัตถุท้ังหมดบนเลเยอร์ 

5.  จากภาพในส่วนท่ีวงกลมไว้ ข้อใดอธิบายวิธีการใช้งานได้ถูกต้อง     
 ก. การเติมสีกับวัตถุบนเลเยอร์ ข. การปรับขนาดของเลเยอร์ 
 ค. การวางตำแหน่งวัตถุบนเลเยอร์ ง. การแสดงตำแหน่งเลเยอร์ปัจจุบัน 

 
 
 
 
 
 
 
 



 

 
 

บันทึกผลหลังการจัดการเรียนรู้ 
 

 ผลการจัดการเรียนรู้ตามแผนการสอน 
  1) วัน เดือน ปี ...............สอนครั้งท่ี .../.... สาขา/ช้ันปี  .....................จำนวนผู้เรียน..........คน    
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน 

2) หัวข้อเรื่อง/เนื้อหาสาระ :  ........................................................................................................... 
  ❑ สอนครบตามหัวข้อเรื่องในแผนฯ  ❑ สอนไม่ครบเนื่องจาก........................................ 
  3) กิจกรรม/วิธีการสอน 
   ❑ ครูแนะนำและบอกจุดประสงค์     ❑ ครูอธิบาย/ถาม-ตอบ/สาธิต/ 
   ❑ ทำแบบทดสอบก่อนเรียน      ❑ ทำแบบทดสอบหลังเรียน 
   ❑ ทำแบบฝึกหัด/โจทย์ปัญหา      ❑ ทำใบกิจกรรม/ใบงาน 
   ❑ อื่น ๆ (ระบ)ุ................................................................................................................... 
  4) ส่ือการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………………….......... 
  ....................................................................................................................................................... 
 11.2 ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาที่พบ 
  1) การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ………………………………………………..…….. 
       ........................................................................................................................................................ 
  2) สมรรถนะท่ีผู้เรียนได้รับ : .......................................................................................................... 
      .......................................................................................................................................................... 
  3) สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..…………………………………………………………..…..... 
      ……………....................................................................................................................................... 
  4) ผลการสอนของครู : ..……………………………………………………………………………………..…….……. 
      ……………........................................................................................................................................... 
  5) ปัญหาท่ีนำไปสู่การวิจัย : ..………………………………………………………………………………..….……... 
 11.3 แนวทางการพัฒนาคุณภาพการสอน/แก้ปัญหา 
  1) ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : .…………………………………………………………………... 
   
  2) แนวทางพัฒนาคุณภาพวิธีสอน/ส่ือ/การวัดผล/เอกสารช่วยสอน   
       …………….......................................................................................................................................... 
  

                                                      ลงช่ือ 
 

                      (.........................................) 
                                   ครูผู้สอน 
          ………./…………/………… 



 

 
 

 

 
 
 

แผนการจัดการเรียนรู้ หน่วยที่   9 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 18 
 

ชื่อหน่วย  หน้ามาสเตอร์
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 

1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
การจัดหน้าท่ีมีหลาย ๆหน้า จะมีรูปแบบกราฟิกดีไซน์  การใส่หัวกระดาษ ท้ายกระดาษ เลขหน้า และการ

วางเนื้อหา หรือท่ีเรียกว่าเลย์เอาต์ในลักษณะเดียวกัน ดังนั้นการท่ีเราจะต้องวางเลย์เอาต์การจัดหน้าเนื้อหาทีละ
หน้าจะเป็นอะไรท่ีเสียเวลา และอาจจะคลาดเคล่ือนไม่เป็นไปในแนวทางเดียวกันได้ ด้วยเหตุนี้จึงมีการสร้างหน้า
ต้นแบบท่ีเป็นเลย์เอาต์ของเนื้อหาขึ้นมาก่อน จากนั้นเราจึงเรียกหน้าต้นแบบนี้ไปใช้เป็นเลย์เอาต์ให้กับการจัดหน้า
ในหน้าอื่น ๆ ด้วย ซึ่งเราเรียกหน้าต้นแบบนี้ว่า  หน้ามาสเตอร์ 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 

- 
3.สมรรถนะประจำหน่วย  

1. แสดงความรู้เกี่ยวกับส่วนประกอบท่ีใช้เป็นเลย์เอาต์บนหน้ามาสเตอร์ในหน้าเอกสารใหม่ท่ีสร้างขึ้น 
2.  เลือกใช้พาเนลเพจ สำหรับการจัดการหน้ามาสเตอร์ 
3.  วางแผนการสร้างหน้ามาสเตอร์ด้วยวิธีการท่ีทำงานได้สะดวกท่ีสุดและประหยัดเวลา 
4.  เรียงลำดับขั้นตอนการใช้งานหน้ามาสเตอร์จากไฟล์เอกสารอื่น 
5.  เลือกใช้เครื่องมือในการสร้างและใช้งานหน้ามาสเตอร์อย่างเหมาะสม 
6.  แสดงพฤติกรรมความสนใจใฝ่รู้  ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็นประชาธิปไตยและ

ห่างไกลยาเสพติด 

4.จุดประสงค์เชิงพฤติกรรม 
4.1 ด้านความรู้ 

1.เพื่อใหม้ีความรู้และความเข้าใจเกี่ยวกับส่วนประกอบท่ีใช้เป็นเลย์เอาต์บนหน้ามาสเตอร์ในหน้าเอกสาร
ใหม่ท่ีสร้างขึ้น 

2.เพื่อให้มีทักษะในการเลือกใช้พาเนลเพจ สำหรับการจัดการหน้ามาสเตอร์ 
3.เพื่อให้มีทักษะในการวางแผนการสร้างหน้ามาสเตอร์ด้วยวิธีการท่ีทำงานได้สะดวกท่ีสุดและประหยัดเวลา 
4.เพื่อให้มีทักษะในการเรียงลำดับขั้นตอนการใช้งานหน้ามาสเตอร์จากไฟล์เอกสารอื่น 
5.เพื่อให้มีทักษะในการเลือกใช้เครื่องมือในการสร้างและใช้งานหน้ามาสเตอร์อย่างเหมาะสม 

4.2 ด้านทักษะ 
1.อธิบายเกี่ยวกับส่วนประกอบท่ีใช้เป็นเลย์เอาต์บนหน้ามาสเตอร์ในหน้าเอกสารใหม่ท่ีสร้างขึ้นได้ 
2.เลือกใช้พาเนลเพจ สำหรับการจัดการหน้ามาสเตอร์ได้ 



 

 
 

3.วางแผนการสร้างหน้ามาสเตอร์ด้วยวิธีการท่ีทำงานได้สะดวกท่ีสุดและประหยัดเวลาได้ 
4.เรียงลำดับข้ันตอนการใช้งานหน้ามาสเตอร์จากไฟล์เอกสารอื่นได้ 
5.เลือกใช้เครื่องมือในการสร้างและใช้งานหน้ามาสเตอร์อย่างเหมาะสมได้ 
 

4.3 คุณลักษณะที่พึงประสงค์ 
   1. ความสนใจใฝ่รู้  
   2. มีความซื่อสัตย์ในการปฏิบัติงาน 
   3. มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
   4.ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 

5.สาระการเรียนรู้ 
  หน้ามาสเตอร์ 

6.กิจกรรมการเรียนรู้ 
6.1 การนำเข้าสู่บทเรียน 

1.ผู้สอนกล่าวทักทายผู้เรียน เนื่องจากเป็นการสอนครั้งแรก   
2.ผู้สอนตรวจสอบรายช่ือผู้เรียน 
3.ผู้สอนบอกจุดประสงค์รายวิชา มาตรฐานรายวิชา และคำอธิบายรายวิชา 
4.ผู้สอนแจกแบบทดสอบก่อนเรียนเพื่อทดสอบผู้เรียน 

7.สื่อและแหล่งเรียนรู้ 
2.1 หนังสือการผลิตส่ือสิงพิมพ์. ประภาวรรณ เกษวิริยะการณ์. สำนักพิมพ์เมืองไทย 
2.2 ส่ือประกอบการเรียน เช่น VDO,  PowerPoint,  YouTube และอุปกรณ์จริง 

8.หลักฐานการเรียนรู้ 
8.1 หลักฐานความรู้           

   คะแนนจากการตอบคำถามท้ายบทเรียน และแบบทดสอบ ในหนังสือประกอบการเรียน  
8.2 หลักฐานการปฏิบัติงาน 

   คะแนนการทำกิจกรรมการเรียนรู้  และภาพถ่ายการทำกิจกรรมของผู้เรียน  
     9. การวัดและการประเมินผล 

9.1 วิธีวัดและการประเมินผล 
1) ทดสอบก่อนเรียนและหลังเรียน 
2) ตรวจใบงาน 
3) ประเมินการนำเสนอผลงาน 
4) สังเกตพฤติกรรม 

9.2 เคร่ืองมือวัดและการประเมินผล 
1) แบบทดสอบก่อนเรียนและหลังเรียน 
2) ใบงาน 
3) แบบประเมินการนำเสนอผลงาน 
4) แบบสังเกตพฤติกรรม 



 

 
 

9.3 เกณฑ์วัดและการประเมินผล 
1) เกณฑ์การทดสอบก่อนเรียนและหลังเรียน คะแนนผ่านไม่ต่ำกว่า 80% 
2) เกณฑ์การประเมินใบงาน คะแนนผ่านไม่ต่ำกว่า 80% 
3) เกณฑ์การประเมินผลการนำเสนอผลงาน คะแนนผ่านไม่ต่ำกว่า 80% 
4) เกณฑ์การสังเกตพฤติกรรม คะแนนผ่านไม่ต่ำกว่า 80% 

 
10.  บันทึกผลหลังการจัดการเรียนรู้ 

 
10.1 ผลการจัดการเรียนรู้ท่ีเกิดขึ้นกับผู้เรียน 

               
               
               

10.2 ปัญหา อุปสรรคท่ีพบ 
               
               
               

10.3 การแก้ไขปัญหา 
1) ผลการแก้ไขปัญหาทีส่งผลลัพธ์ที่ดีต่อผู้เรียน 

               
               

2) แนวทางแก้ปัญหาในครั้งต่อไป 
               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

ใบความรู้ที่ 9 หน่วยที่   9 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 18 
 

ชื่อหน่วย  หน้ามาสเตอร์
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
1.  ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

 การใช้งานเลเยอร์ 
2. อ้างอิงมาตรฐาน / เชื่อมโยงกลุ่มอาชีพ (ถ้ามี) 

 -  
3.สมรรถนะประจำหน่วย  

1. แสดงความรู้เกี่ยวกับส่วนประกอบท่ีใช้เป็นเลย์เอาต์บนหน้ามาสเตอร์ในหน้าเอกสารใหม่ท่ีสร้างขึ้น 
2.  เลือกใช้พาเนลเพจ สำหรับการจัดการหน้ามาสเตอร์ 
3.  วางแผนการสร้างหน้ามาสเตอร์ด้วยวิธีการท่ีทำงานได้สะดวกท่ีสุดและประหยัดเวลา 
4.  เรียงลำดับขั้นตอนการใช้งานหน้ามาสเตอร์จากไฟล์เอกสารอื่น 
5.  เลือกใช้เครื่องมือในการสร้างและใช้งานหน้ามาสเตอร์อย่างเหมาะสม 
6.  แสดงพฤติกรรมความสนใจใฝ่รู้  ความรับผิดชอบ ความซื่อสัตย์สุจริต ความเป็นประชาธิปไตยและ

ห่างไกลยาเสพติด 

4.จุดประสงค์เชิงพฤติกรรม 
4.1 ด้านความรู้ 

1.เพื่อใหม้ีความรู้และความเข้าใจเกี่ยวกับส่วนประกอบท่ีใช้เป็นเลย์เอาต์บนหน้ามาสเตอร์ในหน้าเอกสาร
ใหม่ท่ีสร้างขึ้น 

2.เพื่อให้มีทักษะในการเลือกใช้พาเนลเพจ สำหรับการจัดการหน้ามาสเตอร์ 
3.เพื่อให้มีทักษะในการวางแผนการสร้างหน้ามาสเตอร์ด้วยวิธีการท่ีทำงานได้สะดวกท่ีสุดและประหยัดเวลา 
4.เพื่อให้มีทักษะในการเรียงลำดับขั้นตอนการใช้งานหน้ามาสเตอร์จากไฟล์เอกสารอื่น 
5.เพื่อให้มีทักษะในการเลือกใช้เครื่องมือในการสร้างและใช้งานหน้ามาสเตอร์อย่างเหมาะสม 

4.2 ด้านทักษะ 
1.อธิบายเกี่ยวกับส่วนประกอบท่ีใช้เป็นเลย์เอาต์บนหน้ามาสเตอร์ในหน้าเอกสารใหม่ท่ีสร้างขึ้นได้ 
2.เลือกใช้พาเนลเพจ สำหรับการจัดการหน้ามาสเตอร์ได้ 
3.วางแผนการสร้างหน้ามาสเตอร์ด้วยวิธีการท่ีทำงานได้สะดวกท่ีสุดและประหยัดเวลาได้ 
4.เรียงลำดับข้ันตอนการใช้งานหน้ามาสเตอร์จากไฟล์เอกสารอื่นได้ 
5.เลือกใช้เครื่องมือในการสร้างและใช้งานหน้ามาสเตอร์อย่างเหมาะสมได้ 
 

4.3 คุณลักษณะที่พึงประสงค์ 
   1. ความสนใจใฝ่รู้  



 

 
 

   2. มีความซื่อสัตย์ในการปฏิบัติงาน 
   3. มีความรับผิดชอบต่องานท่ีได้รับมอบหมาย 
   4.ใช้เวลาว่างในการทำงานท่ีได้รับมอบหมาย 
 
5. เนือ้หาสาระ 
 1.  การใช้พาเนลเพจในการจัดการหน้ามาสเตอร์  
 การจัดการหน้ามาสเตอร์สามารถทำได้ด้วยพาเนลเพจ (Panel Page) เพื่อใช้ในการสร้างหน้ากระดาษ 
การคัดลอกหน้ากระดาษ การลบ และการกำหนดค่าเลย์เอาท์  การใช้งานพาเนลเพจประกอบด้วยส่วนต่าง ๆ ดังนี้ 

1.1  ช่ือพาเนล   
1.2  พื้นท่ีจัดการกับหน้ามาสเตอร์ 
1.3  พื้นท่ีจัดการกับหน้ากระดาษ 
1.4  การลบหน้ากระดาษ 
1.5  การเพิ่มหน้ากระดาษ 
1.6 การแสดงจำนวนหน้ากระดาษ  

 

2.  การสร้างหน้ามาสเตอร์ 
 การสร้างหน้ามาสเตอร์ ผู้ใช้สามารถสร้างได้มากกว่า 1 มาสเตอร์ใน 1 ไฟล์ เพื่อรองรับการจัดหน้าใน
งานนั้น ๆ  และผู้ใช้จำเป็นต้องมีการวางแผนท่ีจะสร้างหน้ามาสเตอร์ให้เหมาะสมช่วยให้สามารถทำงานได้สะดวก 
และรวดเร็ว การสร้างหน้ามาสเตอร์ทำได้ 2 แบบ คือ 
  2.1  การสร้างหน้ามาสเตอร์ใหม่ 
  เป็นการสร้างหน้ามาสเตอร์ใหม่ สร้างข้อความและวัตถุต่าง ๆ เพื่อใช้เป็นหน้าต้นแบบของ
หน้ากระดาษอื่น ๆ ในการทำงาน 
  2.2  การสร้างหน้ามาสเตอร์โดยคัดลอกจากหน้าเดิมมาแก้ไข 
  เป็นการนำหน้ามาสเตอร์ท่ีสร้างไว้แล้วมาทำการปรับปรุงให้เป็นหน้ามาสเตอร์ใหม่ สำหรับเป็น
ต้นแบบในหน้ากระดาษอื่น ๆ 
 

3.  การใช้งานหน้ามาสเตอร์ 
  3.1  การใช้งานหน้ามาสเตอร์ในหน้ากระดาษ 
  3.2  การเพิ่มหน้ากระดาษโดยใช้หน้ามาสเตอร์ 
  3.3  การยกเลิกหน้ามาสเตอร์ในหน้ากระดาษ 
 

4.  การนำหน้ามาสเตอร์จากไฟล์เอกสารอืน่เข้ามาใช้งาน  
 การนำหน้ามาสเตอร์จากไฟล์เอกสารอื่น ๆ เข้ามากำหนดเป็นหน้ามาสเตอร์ในช้ินงาน                 
ท่ีต้องการ โดยช้ินงานจะมีรูปแบบเหมือนกับหน้ามาสเตอร์ต้นแบบทุกประการ 
 



 

 
 

5.  การลบหน้ามาสเตอร์ 
  เมื่อมีหน้ามาสเตอร์ใดท่ีไม่จำเป็นต้องใช้งาน ผู้ใช้สามารถลบหน้ามาสเตอร์ท่ีไม่ต้องการดังนี้ 
 5.1  คลิกเลือกหน้ามาสเตอร์ท่ีต้องการลบ ในกรณีลบพร้อมกันหลายหน้าให้กดปุ่มชิฟท์ (Shift) ใน
การเลือก 
 5.2  คลิกเมาส์ขวาในส่วนของมาสเตอร์เพจ เลือกคำส่ังดีลีท มาสเตอร์ สเปรด ดี-มาสเตอร์ ดีศูนย์
หนึ่ง  (Delete Master Spread D-Master D-01) 
 
6. แบบทดสอบ/แบบฝึกหัด 
จากโจทย์คำถาม จงเลือกคำตอบที่ถูกต้องที่สุด 

แบบฝึกหัดหน่วยที่ 9 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว  
1. การกำหนดค่าพรีฟิกซ์ (Prefix) เป็นการกำหนดค่าใดให้กับหน้ามาสเตอร์                   
  ก. แสดงลำดับการสร้างหน้ามาสเตอร์ 
  ข. กำหนดช่ือหน้ามาสเตอร์ 
  ค. การนำหน้ามาสเตอร์อื่นมาใช้เป็นต้นแบบ 
  ง. การกำหนดจำนวนหน้ามาสเตอร์ 
2. การใช้งานหน้ามาสเตอร์ ต้องเลือกใช้คำส่ังใด 
  ก. มาสเตอร์ ทู เพจ 
  ข. มาสเตอร์เพจ 
  ค. แอปพลาย มาสเตอร์ ทู เพจ 
  ง. แอปพลาย มาสเตอร์ 
3. ข้อใดให้คำจำกัดความของหน้ามาสเตอร์ได้ถูกต้องท่ีสุด 
  ก. การกำหนดหน้าต้นแบบเพื่อใช้เป็นเลย์เอาต์ 
  ข. การกำหนดรูปแบบหน้าเอกสารท่ีเหมือนกันทุกหน้าทุกประการ 
  ค. การสร้างงานเอกสารโดยนำไฟล์จากงานอื่นเข้ามาเป็นต้นแบบ 
  ง. การกำหนดจำนวนเอกสารท่ีแน่นอนและชัดเจน 
4. การยกเลิกหน้ามาสเตอร์ควรใช้คำส่ังใด 
  ก. บี–มาสเตอร์ (B–Master) 
  ข. เอ–มาสเตอร์ (A–Master) 
  ค. นัน (None) 
  ง. เคลียร์ (Clear) 
5. การจัดการหน้ามาสเตอร์ ผู้ใช้สามารถทำได้โดยใช้พาเนลใด 
  ก. พาเนลเลเยอร์ ข. พาเนลเพจ 
  ค. พาเนลมาสเตอร์ ง. พาเนลเอฟเฟ็กต์  
 
 
 
 



 

 
 

7.  เอกสารอ้างอิง (ขึ้นหน้าใหม่) 
วิชาการผลิตสื่อดิจิทัล 
8.ภาคผนวก (เฉลยแบบฝึกหัด เฉลยแบบทดสอบ ฯ) 
คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว  
1. การกำหนดค่าพรีฟิกซ์ (Prefix) เป็นการกำหนดค่าใดให้กับหน้ามาสเตอร์                   
  ก. แสดงลำดับการสร้างหน้ามาสเตอร์ 
  ข. กำหนดช่ือหน้ามาสเตอร์ 
  ค. การนำหน้ามาสเตอร์อื่นมาใช้เป็นต้นแบบ 
  ง. การกำหนดจำนวนหน้ามาสเตอร์ 
2. การใช้งานหน้ามาสเตอร์ ต้องเลือกใช้คำส่ังใด 
  ก. มาสเตอร์ ทู เพจ 
  ข. มาสเตอร์เพจ 
  ค. แอปพลาย มาสเตอร์ ทู เพจ 
  ง. แอปพลาย มาสเตอร์ 
3. ข้อใดให้คำจำกัดความของหน้ามาสเตอร์ได้ถูกต้องท่ีสุด 
  ก. การกำหนดหน้าต้นแบบเพื่อใช้เป็นเลย์เอาต์ 
  ข. การกำหนดรูปแบบหน้าเอกสารท่ีเหมือนกันทุกหน้าทุกประการ 
  ค. การสร้างงานเอกสารโดยนำไฟล์จากงานอื่นเข้ามาเป็นต้นแบบ 
  ง. การกำหนดจำนวนเอกสารท่ีแน่นอนและชัดเจน 
4. การยกเลิกหน้ามาสเตอร์ควรใช้คำส่ังใด 
  ก. บี–มาสเตอร์ (B–Master) 
  ข. เอ–มาสเตอร์ (A–Master) 
  ค. นัน (None) 
  ง. เคลียร์ (Clear) 
5. การจัดการหน้ามาสเตอร์ ผู้ใช้สามารถทำได้โดยใช้พาเนลใด 
  ก. พาเนลเลเยอร์ ข. พาเนลเพจ 
  ค. พาเนลมาสเตอร์ ง. พาเนลเอฟเฟ็กต์  

 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

ใบงานที่ 9 หน่วยที่   9 
รหัสวิชา  21910-2008  วิชา  การผลิตสื่อดิจิทัล
  

สอนคร้ังที่ 18 
 

ชื่อหน่วย  หน้ามาสเตอร์
  

ทฤษฎี  2  ชม.  
ปฏิบัติ  2 ชม. 

 
ใบงานที่  9 

คำสั่ง ให้นักเรียนเลือกคำตอบท่ีถูกต้องท่ีสุดเพียงคำตอบเดียว  
1. การกำหนดค่าพรีฟิกซ์ (Prefix) เป็นการกำหนดค่าใดให้กับหน้ามาสเตอร์                   
  ก. แสดงลำดับการสร้างหน้ามาสเตอร์ 
  ข. กำหนดช่ือหน้ามาสเตอร์ 
  ค. การนำหน้ามาสเตอร์อื่นมาใช้เป็นต้นแบบ 
  ง. การกำหนดจำนวนหน้ามาสเตอร์ 
2. การใช้งานหน้ามาสเตอร์ ต้องเลือกใช้คำส่ังใด 
  ก. มาสเตอร์ ทู เพจ 
  ข. มาสเตอร์เพจ 
  ค. แอปพลาย มาสเตอร์ ทู เพจ 
  ง. แอปพลาย มาสเตอร์ 
3. ข้อใดให้คำจำกัดความของหน้ามาสเตอร์ได้ถูกต้องท่ีสุด 
  ก. การกำหนดหน้าต้นแบบเพื่อใช้เป็นเลย์เอาต์ 
  ข. การกำหนดรูปแบบหน้าเอกสารท่ีเหมือนกันทุกหน้าทุกประการ 
  ค. การสร้างงานเอกสารโดยนำไฟล์จากงานอื่นเข้ามาเป็นต้นแบบ 
  ง. การกำหนดจำนวนเอกสารท่ีแน่นอนและชัดเจน 
4. การยกเลิกหน้ามาสเตอร์ควรใช้คำส่ังใด 
  ก. บี–มาสเตอร์ (B–Master) 
  ข. เอ–มาสเตอร์ (A–Master) 
  ค. นัน (None) 
  ง. เคลียร์ (Clear) 
5. การจัดการหน้ามาสเตอร์ ผู้ใช้สามารถทำได้โดยใช้พาเนลใด 
  ก. พาเนลเลเยอร์ ข. พาเนลเพจ 
  ค. พาเนลมาสเตอร์ ง. พาเนลเอฟเฟ็กต์  

 
 
 
 
 
 
 
 
 



 

 
 

บันทึกผลหลังการจัดการเรียนรู้ 
 

 ผลการจัดการเรียนรู้ตามแผนการสอน 
  1) วัน เดือน ปี ...............สอนครั้งท่ี .../.... สาขา/ช้ันปี  .....................จำนวนผู้เรียน..........คน    
มาเรียนปกติ...........คน ขาดเรียน............คน ลาป่วย............คน ลากิจ...........คน มาสาย...........คน 

2) หัวข้อเรื่อง/เนื้อหาสาระ :  ........................................................................................................... 
  ❑ สอนครบตามหัวข้อเรื่องในแผนฯ  ❑ สอนไม่ครบเนื่องจาก........................................ 
  3) กิจกรรม/วิธีการสอน 
   ❑ ครูแนะนำและบอกจุดประสงค์     ❑ ครูอธิบาย/ถาม-ตอบ/สาธิต/ 
   ❑ ทำแบบทดสอบก่อนเรียน      ❑ ทำแบบทดสอบหลังเรียน 
   ❑ ทำแบบฝึกหัด/โจทย์ปัญหา      ❑ ทำใบกิจกรรม/ใบงาน 
   ❑ อื่น ๆ (ระบ)ุ................................................................................................................... 
  4) ส่ือการเรียนรู้/แหล่งการเรียนรู้ : …..……………………………………………………………………….......... 
  ....................................................................................................................................................... 
 11.2 ผลการเรียนรู้ของผู้เรียน/ผลการสอนของครู/ปัญหาที่พบ 
  1) การวัดผลและประเมินผล/ผลการเรียนรู้ของผู้เรียน : ………………………………………………..…….. 
       ........................................................................................................................................................ 
  2) สมรรถนะท่ีผู้เรียนได้รับ : .......................................................................................................... 
      .......................................................................................................................................................... 
  3) สอดแทรกคุณธรรม จริยธรรม และค่านิยม : ..…………………………………………………………..…..... 
      ……………....................................................................................................................................... 
  4) ผลการสอนของครู : ..……………………………………………………………………………………..…….……. 
      ……………........................................................................................................................................... 
  5) ปัญหาท่ีนำไปสู่การวิจัย : ..………………………………………………………………………………..….……... 
 11.3 แนวทางการพัฒนาคุณภาพการสอน/แก้ปัญหา 
  1) ผลการใช้และปรับปรุงแผนการสอนครั้งนี้ : .…………………………………………………………………... 
   
  2) แนวทางพัฒนาคุณภาพวิธีสอน/ส่ือ/การวัดผล/เอกสารช่วยสอน   
       …………….......................................................................................................................................... 
  

                                                      ลงช่ือ 
 

                      (.........................................) 
                                   ครูผู้สอน 
          ………./…………/………… 


